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DGC-2020ES Preface 

Preface 
This instruction manual provides information about the configuration of the DGC-2020ES. To accomplish 
this, the following information is provided: 

• Device information and security settings 
• Configuration via BESTCOMSPlus® and the front panel 
• Communication settings 
• Timekeeping 
• Inputs and outputs 
• Breaker management, synchronizer, bias control, and multiple generator management 
• Alarm configuration 
• Protection settings 
• BESTlogic™Plus programmable logic 
• Troubleshooting 

Conventions Used in this Manual 

Important safety and procedural information is emphasized and presented in this manual through 
warning, caution, and note boxes. Each type is illustrated and defined as follows. 

Warning! 

Warning boxes call attention to conditions or actions that may cause 
personal injury or death. 

 
 

Caution 
Caution boxes call attention to operating conditions that may lead to 
equipment or property damage. 

 
 

Note 
Note boxes emphasize important information pertaining to installation 
or operation. 

DGC-2020ES Instruction Manual Catalog 

Available instruction manuals for the DGC-2020ES are listed in Table 1. 
Table 1. Instruction Manuals 

Part Number Description 
9469200993 Quick Start 
9469200994 Installation 
9469200995 Configuration (this manual) 
9469200996 Operation 
9469200997 Accessories 
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Warning! 

READ THIS MANUAL. Read this manual before installing, operating, or maintaining 
this equipment. Note all warnings, cautions, and notes in this manual as well as on the 
product. Keep this manual with the product for reference. Only qualified personnel 
should install, operate, or service this system. Failure to follow warning and cautionary 
labels may result in personal injury or property damage. Exercise caution at all times. 

 

Caution 
Installing previous versions of firmware may result in compatibility issues causing the 
inability to operate properly and may not have the enhancements and resolutions to 
issues that more recent versions provide. Basler Electric highly recommends using the 
latest version of firmware at all times. Using previous versions of firmware is at the 
user’s risk and may void the warranty of the unit.  

 
Basler Electric does not assume any responsibility to compliance or noncompliance with national 
code, local code, or any other applicable code. This manual serves as reference material that 
must be well understood prior to installation, operation, or maintenance. 
For terms of service relating to this product and software, see the Commercial Terms of 
Products and Services document available at www.basler.com/terms.  
This publication contains confidential information of Basler Electric Company, an Illinois 
corporation. It is loaned for confidential use, subject to return on request, and with the mutual 
understanding that it will not be used in any manner detrimental to the interests of Basler Electric 
Company and used strictly for the purpose intended.  
It is not the intention of this manual to cover all details and variations in equipment, nor does this 
manual provide data for every possible contingency regarding installation or operation. The 
availability and design of all features and options are subject to modification without notice. Over 
time, improvements and revisions may be made to this publication. Before performing any of the 
following procedures, contact Basler Electric for the latest revision of this manual. 
The English-language version of this manual serves as the only approved manual version.  

http://www.basler.com/
mailto:info@basler.com
http://www.basler.com/terms
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DGC-2020ES Revision History 

Revision History 
A historical summary of the changes made to this instruction manual is provided below. Revisions are 
listed in reverse chronological order. 

Visit https://www.basler.com to download the latest hardware, firmware, and BESTCOMSPlus® revision 
histories. 

Instruction Manual Revision History 
Manual Revision 

and Date Change 

D, Nov 2022 • Added settings and metering for Deutz ECU type. 
• Updated instructions on installing and updating BESTCOMSPlus® 
• Other text edits throughout manual. 

C, Dec 2021 • Added support for firmware version 1.05.00 and BESTCOMSPlus version 
5.02.00. 

• Added “Firmware Downgrade” caution boxes. 
• Clarified SPN 3701 in 04 Communication and 14 Exhaust Treatment. 
• Expanded description of Pre-Start resting state in 05 Device Configuration. 
• Expanded Battle Override description in 08 Contact Inputs. 

B, Dec 2019 • Removed Rev Letter from all pages. 
• Changed sequential numbering to sectional numbering. 
• Moved Instruction Manual Revision History into Preface. 
• Removed standalone Revision History chapter. (Revision histories for 

hardware, firmware, and software are now in separate documents on 
www.basler.com.) 

• Added support for firmware version 1.04.00 and BESTCOMSPlus version 
4.01.00. 

A1, Apr 2019 • Updated Proposition 65 statement 
A, Sep 2018 • Added description of voltage sensing fail function in the Engine Sender 

Inputs chapter 
• Updated Revision History chapter 

—, Apr 2017 • Initial release 

 
  

https://www.basler.com/
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DGC-2020ES Security 

1 • Security 
Password protection guards against unauthorized changing of DGC-2020ES settings. Three levels of 
password protection are available. Each level is described in the following paragraphs. 
• OEM Access. This password level allows access to all settings. The default, OEM-access password 

is OEM. 
• Settings Access. This password level allows all except uploading of firmware and clearing of device 

event log. The default, settings-access password is SET. 
• Operator Access. The default, operator-access password is OP. This password level allows all 

settings to be read and allows changes to be made to the following: 
o LCD Contrast 
o Sleep Mode 
o Date/Time 
o All Sender Fail Time Delays 
o Metric Conversion 
o Low Fuel Pre-Alarm Level 
o Low Fuel Alarm Level 
o Pre-Start Contact after Cranking 
o Cooldown Time 
o Pre-Crank Time Delay 
o Reset of Maintenance Interval 
o All controls on the Control screen available via the Metering Explorer in BESTCOMSPlus® 

Changing Passwords 

Passwords can be changed only after communication between the PC and DGC-2020ES is established. 
Changes to passwords are made through the Device Security Setup screen. Use the Settings Explorer in 
BESTCOMSPlus to open the General Settings, Device Security Setup screen. 

The content of the Device Security Setup screen depends on the password level used when accessing 
the screen. For example, someone logged in with a settings-access password will be able to change only 
the settings-access and operator-access passwords - not the OEM-access password. 

The BESTCOMSPlus Device Security Setup screen is illustrated in Figure 1-1. All three access levels are 
shown. 

A password is changed by clicking on the access level, entering the new password, and then clicking on 
the Save Password button. DGC-2020ES passwords are case sensitive. 

Saving Passwords in a DGC-2020ES Settings File 

The passwords can be modified while BESTCOMSPlus is connected to a DGC-2020ES. The settings 
from the BESTCOMSPlus session can then be saved into a settings file. The settings file will contain the 
new passwords. Also, the passwords in a settings file can be modified off line, saved with the file, and 
then later loaded into a DGC-2020ES. 

Saving Passwords to a Settings File when On Line 
The following procedure describes how to save passwords to a settings file when BESTCOMSPlus is 
connected to a DGC-2020ES (on line): 

1. When connected to a DGC-2020ES with BESTCOMSPlus, click on SETTINGS EXPLORER > 
GENERAL SETTINGS > DEVICE SECURITY. 

2. You will be prompted to enter a password. 
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3. Enter a password that is of a level as high as or higher than the password you wish to modify. 
BESTCOMSPlus will display all passwords of a level equal to and below the level of the password 
that was entered. 

4. Click on the password you wish to modify. Type in the new password under the “Password” setting 
that became active when the password to modify was clicked. 

5. Click the “Save” button to save the new password into BESTCOMSPlus memory (it’s not in the DGC-
2020ES yet). 

6. Repeat steps 4 and 5 for all password levels you with to modify. 

7. Once all password modifications are complete, in the main menu of BESTCOMSPlus, select Upload 
Security from the Communications pull-down menu. This is the step where passwords are sent to the 
DGC-2020ES. Failure to perform this step might cause all password modifications to be lost. 

8. Close the Device Security tab in BESTCOMSPlus. 

9. Re-open the Device Security tab in BESTCOMSPlus. This will read the passwords back out of the 
DGC-2020ES. 

10. Verify the passwords obtained from the DGC-2020ES are correct. 

11. Once all desired settings have been loaded into the DGC-2020ES, save the settings file. The 
resulting settings file has the passwords saved as part of the saved settings. 

12. At this point, the password information has been successfully saved in the settings file. The process 
of saving the passwords into the settings file is complete. 

Saving Passwords to a Settings File when Off Line 
The following procedure describes how to save passwords to a settings file when working off line: 

1. When the settings file is open in BESTCOMSPlus, click on SETTINGS EXPLORER > GENERAL 
SETTINGS > DEVICE SECURITY. 

2. You will be prompted to enter a password. 

3. Enter a password that is of a level as high as or higher than the password you wish to modify. 
BESTCOMSPlus will display all passwords of a level equal to and below the level of the password 
that was entered. 

4. Click on the password you wish to modify. Type in the new password under the “Password” setting 
that became active when the password to modify was clicked. 

5. Click the “Save” button to save the new password into BESTCOMSPlus memory. 

6. Repeat steps 4 and 5 for all password levels you wish to modify. 

7. Close the Device Security tab in BESTCOMSPlus. 

8. Save the settings file. 

9. Close the settings file by clicking on the X in the upper right-hand corner of the settings file, or close 
BESTCOMSPlus. 

10. Restart BESTCOMSPlus if you have shut it down. 

11. Re-open the settings file that you have saved with the password information. 

12. When the settings file is open in BESTCOMSPlus, click on SETTINGS EXPLORER > GENERAL 
SETTINGS > DEVICE SECURITY. 

13. You will be prompted to enter a password. 

14. Enter the password for the highest level of password modified; it should be the new modified 
password. 

15. When passwords are shown, verify they are correct. 
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16. At this point the password information has been successfully saved in the settings file. The process of 
saving the passwords into the settings file is complete. 

Loading Passwords from a Settings File into the DGC-2020ES 

1. Connect to the DGC-2020ES with BESTCOMSPlus. 

2. Once connected, click the “Open File” button that is used to load a settings file into the DGC-2020ES. 

3. You will be prompted asking if you wish to load settings and logic into the DGC-2020ES. Select Yes if 
you need to upload settings logic. Select No if all you need to do is update security. If you select No, 
the settings file opens into BESTCOMSPlus memory. 

4. Whether you have loaded settings and logic to the DGC-2020ES or not, the next step is to select 
Upload Security from the Communications pull-down menu. 

5. DO NOT try to view the passwords before performing step 4. This would download the existing 
passwords from the DGC-2020ES and they will overwrite the new passwords that were loaded into 
BESTCOMSPlus memory from opening the settings file. 

6. If you are prompted for a password, enter a password of a level equal to that of the highest-level 
password you wish to modify. 

7. The passwords are uploaded to the DGC-2020ES. 

8. After you have uploaded the new passwords, select GENERAL SETTINGS > DEVICE SECURITY 
SETUP in the settings explorer of BESTCOMSPlus. Verify the passwords are correct. 

9. This concludes loading passwords from a settings file into the DGC-2020ES. 

 
Figure 1-1. Settings Explorer, General Settings, Device Security Setup Screen   



1-4  9469200995 

Security  DGC-2020ES 

 



9469200995 2-1 

DGC-2020ES Configuration through the Front Panel 

2 • Configuration through the Front Panel 
This chapter provides information on configuring DGC-2020ES settings through the front panel. 

Display Setup 

The DGC-2020ES LCD can be customized to fit the needs of your specific application. The options can 
be adjusted using the front panel controls and through BESTCOMSPlus®. The display options are 
described below. 

The Front Panel HMI screen is found in the BESTCOMSPlus® Settings Explorer under the General 
Settings category. If using the front panel, navigate to Settings > General Settings > Front Panel HMI. 

Figure 2-1 shows the BESTCOMSPlus® Front Panel HMI settings screen. 

1. LCD Contrast - Adjust this setting to reach the desired level of LCD contrast. 

2. Front Panel Sleep Mode - Select Enable to send the DGC-2020ES into sleep mode. In sleep 
mode, the LEDs and LCD backlight turn off after 15 minutes of inactivity on the front panel to 
minimize battery drain. 

3. One Line Diagram Display Enable - Select Enable to display one-line diagram. 

4. Engine Hours Display – When Engine Hours Display is enabled, engine run-time hours are 
displayed on the front-panel Overview screen. 

5. Overview Screen Type – The Overview Screen Type can be set for Text or Symbolic. When set 
to Symbolic, the parameters names are displayed as symbols. 

6. Exhaust Display – When Exhaust Display is set to Inverted, the LCD background, where exhaust 
status is displayed, is dark with light text. When set to Normal, the LCD background is light with 
dark text. 

7. Exhaust Status Display Screen – The Exhaust Status Display Screen setting defines where DEF 
level and exhaust status display are shown. Select Overview Screen to show the DEF level and 
exhaust status display on the Overview screen or select All Operating Screens to show the DEF 
level and exhaust status display on all screens that automatically appear during normal operation. 

8. Battery Charger Display – When Battery Charger Display is enabled, battery charger output 
voltage and current are displayed on the front-panel Overview screen. 

9. Display Fuel Level Below – Adjust this setting to display fuel level on the front-panel Overview 
screen only when the fuel level is below the desired value. When fuel level is not displayed, 
engine RPM is displayed in its place. 

10. DEF Display Enable – This setting enables or disables the display of DEF levels on the front 
panel overview screen. Some engines that do not employ DEF-based exhaust treatment still 
broadcast a DEF level. In these cases, since the level is meaningless, the user can disable 
display of the DEF level on the front panel. 

11. Battery and RPM Display – This setting selects whether battery voltage and/or rpm is displayed 
on the front panel overview screen. If the Alternate option is selected, the display will alternate 
between battery voltage and rpm. 

12. Language Selection - Select from Chinese, English, French, German, or Spanish. 

13. Scrolling Screens - Specify the parameters which are to appear on the front-panel LCD display. 

a. Configure the Configurable HMI Summary Settings. 

b. Set the Scrolling Screen Enable to Enable. 

c. Set the Scrolling Screen Scroll Delay parameter to the desired value. 

14. Phase Toggle Delay - Set the phase toggle delay to a nonzero value if automatic scrolling 
through the phase information in the standard overview screen on the front panel is desired. If it is 
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left at zero, scrolling through phase information is accomplished using the up and down arrow 
buttons. 

15. Initializing Message 1 - This parameter defines the first line of text that appears on the front panel 
of the DGC-2020ES as it is going through its power up and initializing sequence. 

16. Initializing Message 2 - This parameter defines the second line of text that appears on the front 
panel of the DGC-2020ES as it is going through its power up and initializing sequence. 

 
Figure 2-1. Settings Explorer, General Settings, Front Panel HMI Screen 

Settings Menu 

The display structure of the Settings menu on the front panel is provided below. Refer to the Controls and 
Indicators chapter in the Operation manual for a full description of DGC-2020ES controls and indicators. 
 

GENERAL SETTINGS 

● FRONT PANEL HMI 
○ SUMMARY VIEW 
○ SCROLL DELAY 
○ PH TOG DELAY 
○ LCD CONTRAST 
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○ SLEEP MODE 
○ LANGUAGE 
○ CONFIGURABLE METERING 

■ ITEM X (X = 1 to 20) 
○ ONE LINE DIAGRAM 
○ ENG HRS DISPLAY 
○ OVERVIEW 
○ EXH DISPLAY 
○ EXH DISPL SCRN 
○ BATT CHG DISPLAY 
○ DISPLAY FL LEVEL BELOW 
○ DEF DISPLAY 
○ BATTERY/RPM DISPLAY 

● CONFIGURE DATE/TIME 
○ YEAR 
○ MONTH 
○ DAY 
○ HOURS 
○ MINUTES 
○ SECONDS 
○ UTC OFFSET 
○ DST ENABLED 
○ CLK NOT SET WRN 

● VIEW DATE/TIME 
● VERSION INFO 

○ DGC-2020ES 
■ FIRMWARE VERSION 
■ BOOT CODE VERSION 
■ SERIAL NUMBER 
■ PART NUMBER 
■ MODEL NUMBER 
■ LANGUAGE VERSION 
■ LANGUAGE PART NUM 
■ FONT VERSION 
■ FONT PART NUM 
■ STYLE CODE 

○ CEM-2020 (Visible when CEM-2020 is enabled.) 
■ FIRMWARE VERSION 
■ BOOT CODE VERSION 
■ SERIAL NUMBER 
■ PART NUMBER 
■ MODEL NUMBER 
■ BUILD DATE 

 

COMMUNICATIONS∗ 

∗(Visible when the optional J1939 CAN bus is enabled, style code xCx.) 

● CAN BUS SETUP 
○ CAN BUS SETUP 

■ CAN BUS ENABLE 
■ DTC ENABLE (Visible when CAN BUS is enabled.) 
■ SPN CONV METHOD (Visible when CAN BUS is enabled.) 
■ CAN BUS ADDR (Visible when CAN BUS is enabled.) 
■ ENGINE ECU ADDRESS (Visible when CAN BUS is enabled.) 
■ ECU OPT SLCT (Visible when CAN BUS is enabled.) 
■ ECU PULSING (Visible when CAN BUS is enabled.) 
■ ENG SHTDN TM (Visible when CAN BUS is enabled.) 
■ PLS CYCL TM (Visible when CAN BUS is enabled.) 
■ ECU SET TM (Visible when CAN BUS is enabled.) 
■ RESP TIMEOUT (Visible when CAN BUS is enabled.) 
■ COOL TEMP SRC (Visible when CAN BUS is enabled.) 
■ OIL PRESS SRC (Visible when CAN BUS is enabled.) 
■ ENGINE RUN TM SRC (Visible when CAN BUS is enabled.) 
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○ ECU SETUP (Visible when CAN BUS is enabled.) 
■ ECU CONF 
■ CUMMINS ECU SETUP 

□ CUMMINS GEN CONTROL 
■ ISUZU ECU SETUP 

□ CLEAR ECU MEMORY 
□ ESCAPE MODE 

■ YANMAR ECU SETUP 
□ NUMBER OF CYLINDERS 

■ GEN DATA TRANSMIT 
■ ENGINE PARAM XMT 
■ TRIP RESET (Visible when ECU is configured for Standard, Volvo Penta, mtu ADEC, 

GM/Doosan, Cummins, or mtu Smart Connect.) 
■ START MODE 
■ DPF REGENRATE SETUP (Visible when ECU is configured for Standard, Volvo Penta, mtu 

ADEC, GM/Doosan, Cummins, or mtu Smart Connect.) 
□ DPF MANUAL REGEN 
□ DPF REGEN DISABLE 

■ BATT CHARGER SETUP 
□ CHARGER 1 TYPE 
□ CHARGER 2 TYPE 

■ BATT CHARGR PREALARMS 
□ CH1 COMMS FAIL 
□ CH1 BATTERY FAIL 
□ CH1 CHARGER FAIL 
□ CH1 AC OFF 
□ CH2 COMMS FAIL 
□ CH2 BATTERY FAIL 
□ CH2 CHARGER FAIL 
□ CH2 AC OFF 

■ SENS CHARGR PREALARMS 
□ CH1 THERMAL LIMIT (Visible when CHARGER 1 TYPE is set to SENS) 
□ CH1 HI DC VOLTS (Visible when CHARGER 1 TYPE is set to SENS) 
□ CH1 LOW DC VOLTS (Visible when CHARGER 1 TYPE is set to SENS) 
□ CH1 LO CRANK V (Visible when CHARGER 1 TYPE is set to SENS) 
□ CH1 INVLD SETTINGS (Visible when CHARGER 1 TYPE is set to SENS) 
□ CH1 SNGL UNIT FL (Visible when CHARGER 1 TYPE is set to SENS) 
□ CH2 THERMAL LIMIT (Visible when CHARGER 2 TYPE is set to SENS) 
□ CH2 HI DC VOLTS (Visible when CHARGER 2 TYPE is set to SENS) 
□ CH2 LOW DC VOLTS (Visible when CHARGER 2 TYPE is set to SENS) 
□ CH2 LO CRANK V (Visible when CHARGER 2 TYPE is set to SENS) 
□ CH2 INVLD SETTINGS (Visible when CHARGER 2 TYPE is set to SENS) 
□ CH2 SNGL UNIT FL (Visible when CHARGER 2 TYPE is set to SENS) 

■ SPEED SELECT (Visible when ECU is configured for Volvo Penta.) 
■ ACCEL POSITION (Visible when ECU is configured for Volvo Penta.) 
■ MODULE TYPE (Visible when ECU is configured for mtu MDEC or mtu ECU7/ECU8.) 
■ ALIVE MSG (Visible when ECU is configured for mtu MDEC or mtu ECU7/ECU8.) 
■ SPEED SETUP 

□ J1939 RPM ENABLE (Visible when ECU is configured for Standard, Volvo Penta, mtu 
ADEC, GM/Doosan, Cummins, or mtu Smart Connect.) 

□ ENGINE RPM 
□ SAVE RPM ADJUSTS 
□ RPM BAND WIDTH 
□ IDLE RPM 
□ RPM CHECKSUM 
□ SPEED UP (Visible when ECU is configured for mtu ADEC, mtu MDEC 304, mtu 

ECU7/ECU8, or mtu Smart Connect.) 
□ SPEED DN (Visible when ECU is configured for mtu ADEC, mtu MDEC 304, mtu 

ECU7/ECU8, or mtu Smart Connect.) 
□ TEST OVRSPEED (Visible when ECU is configured for mtu ADEC, mtu MDEC 304, 

mtu ECU7/ECU8, or mtu Smart Connect.) 
□ SPD DMAND SRC (Visible when ECU is configured for mtu ADEC, mtu MDEC 304, 

mtu ECU7/ECU8, or mtu Smart Connect.) 
□ IDLE REQUEST (Visible when ECU is configured for mtu MDEC 304, mtu 

ECU7/ECU8, or mtu Smart Connect.) 
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□ INCREASE IDLE (Visible when ECU is configured for mtu MDEC 304, or mtu 
ECU7/ECU8.) 

■ ECU SETUP (Visible when ECU is configured for mtu ADEC, mtu MDEC 304, mtu 
ECU7/ECU8, or mtu Smart Connect.) 

□ TRIP RESET (Visible when ECU is configured for mtu MDEC 304, or mtu 
ECU7/ECU8.) 

□ INT OIL PRIME 
□ GOV PRM SW (Visible when ECU is configured for mtu ADEC or mtu Smart 

Connect.) 
□ ENG STRT PRIME (Visible when ECU is configured for mtu MDEC 304, or mtu 

ECU7/ECU8.) 
□ FAN OVERRIDE (Visible when ECU is configured for mtu MDEC 304, or mtu 

ECU7/ECU8.) 
□ MODE SWITCH (Visible when ECU is configured for mtu MDEC 304, or mtu 

ECU7/ECU8.) 
□ GOV PARAM SET (Visible when ECU is configured for mtu ECU7/ECU8.) 
□ CAN RATING SW 1 (Visible when ECU is configured for mtu ECU7/ECU8.) 
□ CAN RATING SW 2 (Visible when ECU is configured for mtu ECU7/ECU8.) 
□ DIS CYL CUT 1 (Visible when ECU is configured for mtu MDEC 304, or mtu 

ECU7/ECU8.) 
□ DIS CYL CUT 2 (Visible when ECU is configured for mtu MDEC 304, mtu 

ECU7/ECU8 or mtu Smart Connect.) 
□ OPERATING MODE (Visible when ECU is configured for mtu Smart Connect.) 
□ CAN START/STOP (Visible when ECU is configured for mtu ECU7/ECU8 or mtu 

ADEC or mtu Smart Connect.) 

SYSTEM PARAMS 

● SYSTEM SETTINGS 
○ GEN CONNECT 
○ BUS CONNECT 
○ RATED kW 
○ RATED VOLTS 
○ RATED FREQ 
○ ALTRNATE FRQ 
○ RATED RPM 
○ RATED PF 
○ ROTATION 
○ EPS 

■ EPS THRESHLD 
■ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable 

function.) 
○ FUEL LVL TYP 
○ SYSTEM UNITS 
○ PRESSURE UNITS (Visible when Metric is selected for System Units.) 
○ BATTERY VOLT 
○ FLYWHL TEETH 
○ SPEED SOURCE 
○ MAINT RESET 
○ NFPA LEVEL 
○ POWER UP DELAY 

● REMOTE MODULE SETUP 
○ CEM SETUP 

■ ENABLE 
■ OUTPUTS (Visible when CEM-2020 is enabled.) 
■ CAN BUS ADDR (Visible when CEM-2020 is enabled.) 
■ VERSION INFO (Visible when CEM-2020 is enabled.) 

□ FIRMWARE VERSION 
□ BOOT CODE VERSION 
□ SERIAL NUMBER 
□ PART NUMBER 
□ MODEL NUMBER 
□ BUILD DATE 
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■ CEM DEBUG MENU (Visible when CEM-2020 is enabled.) 
□ DGC TO CEM BP 
□ CEM TO DGC BP 

● CRANK SETTINGS 
○ DISCNCT LMIT 
○ PRECRNK DELY 
○ PRESTRT CNTCT 
○ STYLE 
○ # CYCLES (Visible when Cycle is selected for Cranking Style.) 
○ CONT TIME (Visible when Continuous is selected for Cranking Style.) 
○ CYCLE TIME 
○ REST TIME 
○ MIN CRANK TIME 
○ COOLDWN TIME 
○ COOLDOWN CONFIG 
○ RESTART DELAY 
○ OFF MODE COOLDN 
○ PRESTART REST CONFIG 

■ CONF 
○ OIL PRS CRANK DISC 

■ ENABLE 
■ CRANK DISC PRS 

● AUTOMATIC RESTART 
○ ENABLE 
○ ATTEMPTS 
○ INTERVAL 

● EXERCISE TIMER 
○ MODE 
○ WEEK INTERVAL (Visible when Mode is set to N Week Intervals.) 
○ START DAY OF MONTH (Visible when Mode is set to Monthly.) 
○ WEEK OF MONTH (Visible when Mode is set to Weekday of Month.) 
○ DAY OF WEEK (Visible when Mode is set to Weekly or Weekday of Month.) 
○ START HOUR 
○ START MINUTE 
○ RUN HOURS 
○ RUN MINUTES 
○ RUN WITH LOAD 
○ BEGIN DATE MONTH (Visible when Mode is set to N Week Intervals.) 
○ BEGIN DATE DAY (Visible when Mode is set to N Week Intervals.) 
○ BEGIN DATE YR (Visible when Mode is set to N Week Intervals.) 

● SENSING TRANS 
○ GEN PT PRI V 
○ GEN PT SEC V 
○ GEN CT PRI A 
○ CT LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.)  
○ BUS PT PRI V 
○ BUS PT SEC V 

● RELAY CONTROL 
○ START 
○ RUN 
○ PRESTART 

● AUTO CONFIG DETECT 
○ ENABLE 
○ LOW LINE THRESH 
○ 1-PH THRESH 
○ 1-PH GEN CONN 

● ENGINE STATISTICS 
○ START YEAR 
○ START MONTH 
○ START DAY 
○ # STARTS 
○ HRS TO MAINT 
○ kW-HRS 
○ TOTAL HRS 
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○ LOADED HRS 
○ UNLOADED HRS 

PROGRAMMABLE INPUTS 

● CONFIGURABLE INPUTS 
○ INPUT X (X = 1 to 7) 

■ ALARM CONFIG 
■ ACTIVATN DLY 
■ RECOGNITION 

● PROG FUNCTIONS 
○ EMERGENCY STOP 

■ INPUT 
○ AUTO XFER SWITCH 

■ INPUT MODE 
■ N.O. INPUT 
■ N.C. INPUT (Visible when INPUT MODE is complementary.) 
■ CIRCUIT ERROR DELAY (Visible when INPUT MODE is complementary.) 
■ CIRCUIT ERROR ACTION (Visible when INPUT MODE is complementary.) 

○ GRND DELTA O-RIDE 
■ INPUT 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ BATTLE OVERRIDE 
■ INPUT 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ LOW LINE OVERRIDE 
■ INPUT 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ 1 PHASE O-RIDE 
■ INPUT 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ BATT CHRG FAIL 
■ INPUT 
■ ALARM CONFIG (Visible when an INPUT is selected.) 
■ ACTIVATN DLY (Visible when an INPUT is selected.) 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ LOW COOL LEVEL 
■ INPUT 
■ ALARM CONFIG (Visible when an INPUT is selected.) 
■ ACTIVATN DLY (Visible when an INPUT is selected.) 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ LOW FUEL LEVEL 
■ INPUT 
■ ALARM CONFIG (Visible when an INPUT is selected.) 
■ ACTIVATN DLY (Visible when an INPUT is selected.) 
■ RECOGNITION (Visible when an INPUT is selected.) 

○ FUEL LEAK DETECT 
■ INPUT 
■ ALARM CONFIG (Visible when an INPUT is selected.) 
■ ACTIVATN DLY (Visible when an INPUT is selected.) 
■ RECOGNITION (Visible when an INPUT is selected.) 

PROGRAMMABLE OUTPUTS 

● CONFIG ELEMENTS 
○ CONFIG ELEMENT X (X = 1 to 8) 

■ ALARM CONFIG 
■ ACTIVATN DLY 
■ RECOGNITION 

ALARM CONFIGURATION 

● HORN CONFIGURATION 
○ HORN 
○ NOT IN AUTO HORN 
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● PRE-ALARMS 
○ HIGH COOLANT TEMP 

■ ENABLE 
■ THRESHOLD 

○ LOW COOLANT TEMP 
■ ENABLE 
■ THRESHOLD 

○ LOW OIL PRESSURE 
■ ENABLE 
■ THRESHOLD 

○ LOW FUEL LEVEL 
■ ENABLE 
■ THRESHOLD 
■ HYSTERESIS 

○ ENGINE OVERLOAD 
■ ENG KW OVRLD-1 
■ ENG KW OVRLD-2 
■ ENG KW OVRLD-3 

○ MAINTENANCE INTERVAL 
■ ENABLE 
■ THRESHOLD 

○ BATTERY OVERVOLTAGE 
■ ENABLE 
■ THRESHOLD 

○ LOW BATTERY VOLTAGE 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 

○ WEAK BATTERY VOLTAGE 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 

○ HIGH FUEL LEVEL 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 
■ HYSTERESIS 

○ ACTIVE DTC (Visible when DTC is enabled.) 
■ ENABLE 

○ ECU COMMS FAIL (Visible when CAN BUS is enabled.) 
■ ENABLE 

○ COOLANT LEVEL (Visible when CAN BUS is enabled.) 
■ ENABLE 
■ THRESHOLD 

○ CEM COMM FAIL (Visible when CEM-2020 is enabled.) 
■ ENABLE 

○ CHECKSUM FAIL 
■ ENABLE 

○ BRK CLOSE FAIL PALM 
■ ENABLE 

○ BRK OPEN FAIL PALM 
■ ENABLE 

○ REVERSE ROTATION 
■ ENABLE 

○ DEF PREALARMS 
■ ENABLE 

• ALARMS 
○ HIGH COOLANT TEMP 

■ ENABLE 
■ THRESHOLD 
■ ARMING DELAY 

○ LOW OIL PRESSURE 
■ ENABLE 
■ THRESHOLD 
■ ARMING DELAY 
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○ LOW FUEL LEVEL 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 

○ OVERSPEED 
■ ENABLE 
■ THRESHOLD 
■ ACTIVATN DLY 

○ COOLANT LEVEL (Visible when CAN bus is enabled.) 
■ ENABLE 
■ THRESHOLD 

○ CAN LOW COOL LEVEL 

Note 
The HIGH COOLANT TEMP and LOW OIL PRESSURE alarms have 
an ARMING DLY setting that disables the alarm for the specified time 
after engine startup. 

 
● SENDER FAIL 

○ COOL TEMP SENDR FAIL 
■ CONFIG TYPE 
■ RECOGNITION 
■ ACTIVATN DLY 
■ MIN OHMS 
■ MAX OHMS 
■ SF DISPLAY 

○ OIL PRESS SENDR FAIL 
■ CONFIG TYPE 
■ RECOGNITION 
■ ACTIVATN DLY 
■ MIN OHMS 
■ MAX OHMS 
■ SF DISPLAY 

○ FUEL LEVL SENDR FAIL 
■ CONFIG TYPE 
■ RECOGNITION 
■ ACTIVATN DLY 
■ MIN OHMS 
■ MAX OHMS 
■ SF DISPLAY 

○ VOLTAGE SENSE FAIL 
■ CONFIG TYPE 
■ ACTIVATN DLY 

○ SPEED SENDR FAIL 
■ TIME DELAY 

 

GENERATOR PROTECTION 

● 27 UNDERVOLTAGE 
○ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.) 
○ 3 / 1 PHASE SETTINGS 

■ PICKUP 
■ HYSTERESIS 
■ TIME DELAY 
■ FREQ INHIBIT 
■ ALARM CONFIG 

● 59 OVERVOLTAGE 
○ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.) 
○ 3 / 1 PHASE SETTINGS 

■ PICKUP 
■ HYSTERESIS 
■ TIME DELAY 
■ ALARM CONFIG 
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● 47 PHASE IMBALANCE 
○ PICKUP 
○ HYSTERESIS 
○ TIME DELAY 
○ ALARM CONFIG 
○ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.) 

● 81 O/U FREQUENCY 
○ UNDERFREQUENCY 

■ INHIBIT VOLTS 
■ PICKUP 
■ HYSTERESIS 
■ TIME DELAY 
■ ALARM CONFIG 

○ OVERFREQUENCY 
■ PICKUP 
■ HYSTERESIS 
■ TIME DELAY 
■ ALARM CONFIG 

○ ALTRNT FRQ SCALE FCTR 
■ ALT FREQ SF 

● 50 OVERCURRENT 
○ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable function.) 
○ 3 / 1 PHASE SETTINGS 

■ PICKUP 
■ TIME DELAY 
■ ALARM CONFIG 

 

BREAKER MANAGEMENT 

● BREAKER HARDWARE 
○ MAINS FAIL TRANSFER 

■ ENABLE 
■ RETURN DELAY 
■ TRANSFER DELAY 
■ MAX TRANSFER TIME 

○ CLOSE WAIT TIME 
■ TIME 

○ GEN BREAKER 
■ CONTINUOUS 
■ CLOSING TIME 
■ OPEN CMD 
■ CLOSE CMD 

○ MAINS BREAKER 
■ CONFIGURED 
■ CONTINUOUS (Visible when configured.) 
■ CLOSING TIME (Visible when configured.) 
■ OPEN CMD (Visible when configured.) 
■ CLOSE CMD (Visible when configured.) 

○ BRK CLOSE FAIL PALM 
○ BRK OPEN FAIL PALM 

● BUS CONDITION DETECT 
○ GEN DEAD 

■ THRESHOLD 
■ TIME DELAY 

○ GEN STABLE 
■ OV PICKUP 
■ OV DROPOUT 
■ UV PICKUP 
■ UV DROPOUT 
■ OF PICKUP 
■ OF DROPOUT 
■ UF PICKUP 
■ UF DROPOUT 
■ TIME DELAY 
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■ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable 
function.) 

■ ALT FREQ SF 
○ GEN FAILED 

■ TIME DELAY 
○ BUS DEAD 

■ THRESHOLD 
■ TIME DELAY 

○ BUS STABLE 
■ OV PICKUP 
■ OV DROPOUT 
■ UV PICKUP 
■ UV DROPOUT 
■ OF PICKUP 
■ OF DROPOUT 
■ UF PICKUP 
■ UF DROPOUT 
■ TIME DELAY 
■ LOW LINE SF (Visible when an input is selected for the Low Line Override programmable 

function.) 
■ ALT FREQ SF 

○ BUS FAILED 
■ TIME DELAY 

 

LOGIC TIMERS 

● TIMER X (X = 1 to 10) 
○ HOURS 
○ MINUTES 
○ SECONDS 

ENTER PASSWORD 

 

LOGOUT (Visible when logged in through the front panel.)   
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3 • BESTCOMSPlus® 
BESTCOMSPlus® is a Windows®-based, PC application that provides a user-friendly, graphical user 
interface (GUI) for use with Basler Electric communicating products. The name BESTCOMSPlus is an 
acronym that stands for Basler Electric Software Tool for Communications, Operations, Maintenance, and 
Settings. 

BESTCOMSPlus provides the user with a point-and-click means to set and monitor the DGC-2020ES. 
The capabilities of BESTCOMSPlus make the configuration of one or several DGC-2020ES controllers 
fast and efficient. A primary advantage of BESTCOMSPlus is that a settings scheme can be created, 
saved as a file, and then uploaded to the DGC-2020ES at the user’s convenience. 

BESTCOMSPlus uses plugins, allowing the user to manage several different Basler Electric products. 
The DGC-2020ES plugin must be activated before use. The plugin can be activated automatically by 
connecting to a DGC-2020ES, or manually by requesting an activation key from Basler Electric. 

The DGC-2020ES plugin opens inside the BESTCOMSPlus main shell. The same default logic scheme 
that is shipped with the DGC-2020ES is brought into BESTCOMSPlus by downloading settings and logic 
from the DGC-2020ES. This gives the user the option of developing a custom setting file by modifying the 
default logic scheme or by building a unique scheme from scratch. 

BESTlogic™Plus Programmable Logic is used to program DGC-2020ES logic for protection elements, 
inputs, outputs, alarms, etc. This is accomplished by drag-and-drop method. The user can drag elements, 
components, inputs, and outputs onto the program grid and make connections between them to create 
the desired logic scheme. 

Figure 3-1 illustrates the typical user interface components of the DGC-2020ES plugin with 
BESTCOMSPlus. 

 
Figure 3-1. Typical User Interface Components 
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System Recommendations 

BESTCOMSPlus software is built on the Microsoft® .NET Framework. The setup utility that installs 
BESTCOMSPlus on your PC also installs the DGC-2020ES plugin and the required version of .NET 
Framework (if not already installed). BESTCOMSPlus operates with systems using Windows® 7 SP1, 
Windows 8.1, and Windows 10 version 1607 (Anniversary Update). System recommendations for the 
.NET Framework and BESTCOMSPlus are listed in Table 3-1. 

Table 3-1. System Recommendations for BESTCOMSPlus and the .NET Framework 

System Type Component Recommendation 
32/64 bit Processor 2.0 GHz 
32/64 bit RAM 1 GB (minimum), 2 GB (recommended) 

32 bit Hard Drive 200 MB (if .NET Framework is already installed on PC) 
4.5 GB (if .NET Framework is not already installed on PC) 

64 bit Hard Drive 200 MB (if .NET Framework is already installed on PC) 
4.5 GB (if .NET Framework is not already installed on PC) 

To install and run BESTCOMSPlus, a Windows user must have Administrator rights. A Windows user with 
limited rights may not be permitted to save files in certain folders. 

Installation 

 

Note 

Do not connect a USB cable until setup completes successfully. 
Connecting a USB cable before setup is complete may result in errors. 

Download BESTCOMSPlus 
Use the following procedure to download BESTCOMSPlus from the Basler Electric website. 

1. Navigate to https://www.basler.com/Downloads. 

2. Select DGC-2020ES from the model drop down menu. 

3. Under the Software heading, click the download link for BESTCOMSPlus. 

4. Sign in or create an account to continue with the download. 

Install BESTCOMSPlus 
Run the setup file for the BESTCOMSPlus application. The setup utility installs BESTCOMSPlus, the 
.NET Framework (if not already installed), the USB driver, and the DGC-2020 plugin for BESTCOMSPlus 
on your PC. 

When BESTCOMSPlus installation is complete, a Basler Electric folder is added to the Windows 
programs menu. This folder is accessed by clicking the Windows Start button and then accessing the 
Basler Electric folder in the Programs menu. The Basler Electric folder contains an icon that starts 
BESTCOMSPlus when clicked. 

Activation of the DGC-2020ES Plugin 

The DGC-2020ES plugin is a module that runs inside the BESTCOMSPlus shell. The DGC-2020ES 
plugin contains specific operational and logic settings for only the DGC-2020ES. Uploading settings to the 
DGC-2020ES is possible only after activating the DGC-2020ES plugin. 

https://www.basler.com/Downloads
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The DGC-2020ES plugin can be activated automatically or manually. Automatic activation is achieved by 
using a USB cable to establish communication between the DGC-2020ES and BESTCOMSPlus. Manual 
activation is initiated by contacting Basler Electric for an activation key and entering the key into 
BESTCOMSPlus. Manual activation is useful if you want to create a settings file prior to receiving your 
DGC-2020ES. Refer to Manual Activation of DGC-2020ES Plugin. 

Connect a USB Cable 
The USB driver was copied to your PC during BESTCOMSPlus installation and is installed automatically 
after powering the DGC-2020ES. USB driver installation progress is shown in the Windows taskbar area. 
Windows will notify you when installation is complete. 

Connect a USB cable between the PC and your DGC-2020ES. Apply operating power to the DGC-
2020ES. Wait until the boot sequence is complete. 

Start BESTCOMSPlus® and Activate the DGC-2020ES Plugin Automatically 
To start BESTCOMSPlus, click the Windows Start button, point to Programs, Basler Electric, and then 
click the BESTCOMSPlus icon. During initial startup, the BESTCOMSPlus Select Language screen is 
displayed (Figure 3-2). You can choose to have this screen displayed each time BESTCOMSPlus is 
started, or you can select a preferred language and this screen will be bypassed in the future. Click OK to 
continue. This screen can be accessed later by selecting Tools and Select Language from the menu bar. 

 
Figure 3-2. BESTCOMSPlus Language Selection Dialog 

The BESTCOMSPlus platform window opens. Select New Connection from the Communication pull-down 
menu and select DGC-2020ES. See Figure 3-3. The DGC-2020ES plugin is activated automatically after 
connecting to a DGC-2020ES. 
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Figure 3-3. Communication Pull-Down Menu 

The DGC-2020ES Connection screen, shown in Figure 3-4, appears. 

 
Figure 3-4. DGC-2020ES Connection Dialog 

Select COM Port. The USB drivers are installed automatically during the BESTCOMSPlus installation 
process. To select the correct COM Port, open the Windows Device Manager and expand the Ports 
(COM & LPT) branch. Locate the device named CP2101 USB to UART Bridge Controller (COMx). The 
COM Port number will be displayed in parenthesis (COMx). Be sure operating power is applied to the 
DGC-2020ES and the USB cable is connected before opening the Device Manager. See Figure 3-5. 

 
Figure 3-5. Device Manager 

The DGC-2020ES plugin opens indicating that activation was successful. You can now configure the 
DGC-2020ES communication ports and other settings. 

Installing the USB Driver if Automatic Installation Fails 
To install the USB driver for the DGC-2020ES: 

1. Apply operating power to the DGC-2020ES and wait for the boot sequence to complete. 
2. Connect a USB cable between the PC and DGC-2020ES. 
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3. The Found New Hardware Wizard dialog box appears. 
4. Select “No, not this time” and select Next to continue. 
5. Choose to “Install from a list or specific location (Advanced)” and select Next to continue. 
6. Navigate to C:\Program Files\Basler Electric\BESTCOMSPlus\USBDeviceDrivers\ and select 

Next to continue. 

When installation of the driver is complete, you may be asked to restart your computer. 

Manual Activation of the DGC-2020ES Plugin 
Manual activation of the DGC-2020ES plugin is required only if your initial use of BESTCOMSPlus will be 
on a PC that is not connected to a DGC-2020ES. Manual activation is described in the following 
paragraphs. 

Requesting an Activation Key 

When initially running the DGC-2020ES plugin, the Activate Device Plugin pop-up appears. You must 
contact Basler Electric for an activation key before you can activate the DGC-2020ES plugin. You can 
request an activation key through email or the Basler Electric website. Click either the Website or Email 
button. Click the Activate button when you are ready to enter the activation key you received from Basler 
Electric. The Activate Device Plugin pop-up appears. Refer to Figure 3-6. 

Entering an Activation Key 

Select DGC-2020ES from the Device pull-down menu. Enter your Email Address and Activation Key 
provided by Basler Electric. If you received an email containing the Activation Key, you can select all of 
the text in the email and copy it to the Windows clipboard using normal Windows techniques. The Get 
Data button will extract the Device, Email Address, and Activation Key from the Windows clipboard and 
paste it into the appropriate fields. Click the Activate button to continue. The Activate Device Plugin 
screen is also found by selecting Activate Device from the Tools pull-down menu of the BESTCOMSPlus 
main screen. 

 
Figure 3-6. Activate Device Plugin 

Establishing Communication 
Communication between BESTCOMSPlus and the DGC-2020ES is established by clicking on the 
Connect button on the DGC-2020ES Connection screen (see Figure 3-4) or by clicking on the Connect 
button on the lower menu bar of the main BESTCOMSPlus screen (Figure 3-1). Download all settings 
and logic from the DGC-2020ES by selecting Download Settings and Logic from the Communication pull-
down menu. BESTCOMSPlus will read all settings and logic from the DGC-2020ES and load them into 
BESTCOMSPlus memory. See Figure 3-7. 
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Figure 3-7. Processing, Please Wait… 

Advanced Properties 

Click the Advanced button on the Connection screen to display the Advanced Properties dialog. Default 
settings are shown in Figure 3-8. 

 
Figure 3-8. Advanced Properties Dialog 

Menu Bars 

The menu bars are located near the top of the BESTCOMSPlus window (see Figure 3-1). The upper 
menu bar has five pull-down menus. With the upper menu bar, it is possible to manage settings files, 
configure communication settings, upload and download settings/security files, and compare settings 
files. The lower menu bar consists of clickable icons. The lower menu bar is used to change 
BESTCOMSPlus views, save or load a BESTspace™ workspace, open a settings file, 
connect/disconnect, preview metering printout, export metering, switch to live mode, and send settings to 
the DGC-2020ES. 

Upper Menu Bar (BESTCOMSPlus® Shell) 
Upper menu bar functions are listed and described in Table 3-2. 

Table 3-2. Upper Menu Bar (BESTCOMSPlus Shell) 

Menu Item Description 
File 

New Create a new settings file 
Open Open an existing settings file 
Close Close settings file 
Save Save settings file 
Save As Save settings file with a different name 
Export To File Save settings as a *.csv file 
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Menu Item Description 
Print Print, export, or send a settings file 
Properties View properties of a settings file 
History View history of a settings file 
Recent Files Open a previously opened file 
Exit Close BESTCOMSPlus program 

Communication 
New Connection Choose new device or DGC-2020ES 
Close Connection Close communication between BESTCOMSPlus and DGC-2020ES 

Download Settings and Logic from 
Device 

Download operational and logic settings from the device 

Upload Settings and Logic to Device Upload operational and logic settings to the device 
Upload Settings to Device Upload operational settings to the device 
Upload Logic to Device Upload logic settings to the device 
Download Security from Device Download security settings from the device 
Upload Security to Device Upload security settings to the device 
Upload Device Files Upload firmware to the device 

Tools 
Select Language Select BESTCOMSPlus language 

Activate Device Activate the DGC-2020ES plugin 
Set File Password Password protect a settings file 
Compare Settings Files Compare two settings files 
Auto Export Metering Exports metering data on a user-defined interval 
Event Log - View View the BESTCOMSPlus event log 

Event Log - Verbose Logging Enable/disable verbose logging 

Event Log - Verbose 
Communications Logging 

Enable/disable verbose communications logging 

Set Default Shell Select the default product shell view for BESTCOMSPlus. Options 
include Classic view, Updated view, or Combined view. 

Generate Certificate (this function is 
not applicable to the DGC-2020ES) 

Generate a certificate 

Accepted Devices (this function is not 
applicable to the DGC-2020ES) 

View and delete accepted certificates 

Help 
Check for Updates Check for BESTCOMSPlus updates via the internet 

Check for Update Settings Enable or change automatic checking for updates 
About View general, detailed build, and system information 

Lower Menu Bar (DGC-2020ES Plugin) 
The lower menu bar functions are listed and described in Table 3-3. 

Table 3-3. Lower Menu Bar (DGC-2020ES Plugin) 

Menu Button Description 

 Enables you to show/hide the Metering Panel, Settings Panel, or Settings Info 
Panel. 
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Opens and saves BESTspace™ workspaces. Customized workspaces make 
switching between tasks easier and more efficient. 

 Opens a saved settings file. 

 Connect: Opens the DGC-2020ES Connection screen which enables you to 
connect to the DGC-2020ES via USB or a modem. This button only appears 
when a DGC-2020ES is not connected. 

 Disconnect: Used to disconnect a connected DGC-2020ES. This button only 
appears when a DGC-2020ES is connected. 

 Displays the Print Preview screen where a preview of the Metering printout is 
shown. Click on the printer button to send to a printer. 

 Enables all metering values to be exported into a *.csv file. 

 Displays a drop-down list entitled Live Mode Settings which enables Live mode 
where settings are automatically sent to the device in real time as they are 
changed. 

 Sends settings to the DGC-2020ES when BESTCOMSPlus is not operating in 
Live Mode. Click this button after making a setting change to send the modified 
setting to the DGC-2020ES. 

Settings Explorer 

The Settings Explorer is a convenient tool within BESTCOMSPlus used to navigate through the various 
settings screens of the DGC-2020ES plugin. 

These screens allow the user to edit general settings, communications, system parameters, 
programmable inputs, programmable outputs, alarm configuration, generator protection, breaker 
management, programmable senders, and BESTlogicPlus programmable logic. 

Logic setup will be necessary after making certain setting changes. For more information, refer to the 
BESTlogicPlus chapter. 

Settings Entry 

When entering settings in BESTCOMSPlus, each setting is validated against prescribed limits. Entered 
settings that do not conform with the prescribed limits are accepted but flagged as noncompliant. Figure 
3-9 illustrates an example of flagged, noncompliant settings (locator A) and the Setting Validation window 
(locator B) used to diagnose faulty settings.  



9469200995 3-9 

DGC-2020ES BESTCOMSPlus® 

 
Figure 3-9. Flagged, Noncompliant Settings and the Seting Validation Window 

The Setting Validation window, viewed by selecting the Setting Validation tab (locator C), displays three 
types of annunciations: errors, warnings, and messages. An error describes a problem such as a setting 
that is out of range. A warning describes a condition where supporting settings are invalid, causing other 
settings to be noncompliant with the prescribed limits. A message describes a minor setting issue that 
was automatically resolved by BESTCOMSPlus. An example of a condition triggering a message is entry 
of a settings value with a resolution that exceeds the limit imposed by BESTCOMSPlus. In this situation, 
the value is automatically rounded and a message is triggered. Each annunciation lists a hyperlinked 
name for the noncompliant setting and an error message describing the issue. Clicking the hyperlinked 
setting name takes you to the setting screen with the offending setting. Right-clicking the hyperlinked 
setting name will restore the setting to its default value. 
 

Note 
It is possible to save a DGC-2020ES settings file in BESTCOMSPlus 
with noncompliant settings. However, it is not possible to upload 
noncompliant settings to the DGC-2020ES.  

Metering Explorer 

The Metering Explorer is a convenient tool within BESTCOMSPlus used to navigate through the various 
metering screens of the DGC-2020ES plugin. 

These screens allow the user to view real-time system data including generator voltages and currents, 
input/output status, alarms, reports, and other parameters. Refer to the Metering chapter in the Operation 
manual for more information on the Metering Explorer. 
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BESTspace™ 

BESTspace provides the ability to manage customized workspaces. A workspace consists of the position 
and size of all open screens within BESTCOMSPlus. Pre-saved workspaces can be quickly loaded to fit 
the specific task at hand. Any number of different workspaces can be saved including a default 
workspace which loads when the DGC-2020ES plug-in is started. The Metering Explorer screens and the 
Settings Explorer screens can be saved independently into the workspace file. A Comments box is 
provided for writing a description or leaving notes for each saved workspace. To access BESTspace, click 
View (on the lower menu bar) and hover over BESTspace. Figure 3-10 illustrates the BESTspace options 
found under the View pull-down menu. Figure 3-11 illustrates the options included in the Load/Save 
Workspace File screen. 

 
Figure 3-10. View Menu, BESTspace™ Options 

 
Figure 3-11. View Menu, BESTspace™, Save Workspace Screen  

Settings File Management 

A settings file contains all DGC-2020ES settings, including logic. A settings file assumes a file extension 
of “∗.bstx”. It is possible to save the logic only as a separate logic library file on the BESTlogicPlus 
Programmable Logic screen. This function is helpful when similar logic is required for several devices. A 
logic library file assumes a file extension of “∗.bslx”. It is important to note that settings and logic can be 
uploaded to the device together or separately, but are always downloaded together. For more information 
on logic files, refer to the BESTlogicPlus chapter. 
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Opening a Settings File 
To open a DGC-2020ES settings file with BESTCOMSPlus, pull down the File menu and choose Open. 
The Open dialog box appears. This dialog box allows you to use normal Windows techniques to select 
the file that you want to open. Select the file and choose Open. You can also open a file by clicking on the 
Open File button on the lower menu bar. If connected to a device, you will be asked to upload the settings 
and logic from the file to the current device. If you choose Yes, the settings displayed in BESTCOMSPlus 
will be overwritten with the settings of the opened file. 

Saving a Settings File 
Select Save or Save As from the File pull-down menu. A dialog box appears allowing you to enter a 
filename and location to save the file. Select the Save button to complete the save. 

Upload Settings and/or Logic to Device 
To upload a settings file to the DGC-2020ES, open the file through BESTCOMSPlus or create the file 
using BESTCOMSPlus. Then pull down the Communication menu and select Upload Settings and Logic 
to Device. If you want to upload operational settings without logic, select Upload Settings to Device. If you 
want to upload logic without operational settings, select Upload Logic to Device. You are prompted to 
enter the password. The default password is “OEM”. If the password is correct, the upload begins and the 
progress bar is shown. 

Download Settings and Logic from Device 
To download settings and logic from the DGC-2020ES, pull down the Communication menu and select 
Download Settings and Logic from Device. If the settings in BESTCOMSPlus have changed, a dialog box 
will open asking if you want to save the current settings changes. You can choose Yes or No. After you 
have taken the required action to save or discard the current settings, downloading begins. 
BESTCOMSPlus will read all settings and logic from the DGC-2020ES and load them into 
BESTCOMSPlus memory. 

Print a Settings File 
To view a preview of the settings printout, select Print Preview from the File pull-down menu. To print the 
settings, select the printer icon in the upper left corner of the Print Preview screen. 

You can skip the print preview and go directly to print by pulling down the File menu and selecting Print. A 
dialog box opens containing the typical Windows options for setting the properties of the printer. 
Configure these settings as necessary and then select Print. 

Compare Settings Files 
BESTCOMSPlus has the ability to compare two settings files. To compare files, pull down the Tools menu 
and select Compare Settings Files. The BESTCOMSPlus Settings Compare Setup dialog box appears 
(Figure 3-12). Select the location of the first file under Left Settings Source and select the location of the 
second file under Right Settings Source. If you are comparing a settings file located on your PC hard 
drive or portable media, click the folder button and navigate to the file. If you want to compare settings 
downloaded from a unit, click the Select Unit button to set up the communication port. Click the Compare 
button to compare the selected settings files. 
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Figure 3-12. Tools, Compare Settings Files Screen 

A dialog box appears, displaying the results of the comparison. The BESTCOMSPlus Settings Compare 
dialog box (Figure 3-13) is displayed where you can view all settings (Show All Settings), view only the 
differences (Show Settings Differences), view all logic (Show All Logic Paths), or view only logic 
differences (Show Logic Path Differences). Select Close when finished. 

 
Figure 3-13. Settings Comparison Results Screen 

Firmware Updates 

Future enhancements to the DGC-2020ES functionality will make a firmware update desirable. Because 
default settings are loaded when DGC-2020ES firmware is updated, your settings should be saved in a 
file prior to upgrading firmware. 
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Caution 
Installing previous versions of firmware may result in compatibility issues causing the 
inability to operate properly and may not have the enhancements and resolutions to 
issues that more recent versions provide. Basler Electric highly recommends using the 
latest version of firmware at all times. Using previous versions of firmware is at the 
user’s risk and may void the warranty of the unit. 

 

Note 

The latest version of BESTCOMSPlus software should be downloaded from the Basler 
Electric website and installed before performing a firmware upgrade. 

A device package contains firmware and a language module. Embedded firmware is the operating 
program that controls the actions of the DGC-2020ES. The DGC-2020ES stores firmware in nonvolatile 
flash memory that can be reprogrammed through the communication ports. It is not necessary to replace 
EPROM chips when updating the firmware with a newer version. 

The language of the front panel LCD can be changed by uploading a different language module into the 
DGC-2020ES. The DGC-2020ES stores the language module in nonvolatile flash memory; the language 
module contains all language translations for the DGC-2020ES. The language module can be 
reprogrammed through the communications port. In general, any time a firmware upgrade is made to the 
DGC-2020ES, the language module should be uploaded as well. 

The DGC-2020ES can be used in conjunction with the Contact Expansion Module (CEM-2020) which 
expands the DGC-2020ES capabilities. When upgrading the firmware in any component of this system, 
the firmware in ALL of the components of the system should be upgraded to ensure compatibility of 
communications between the components. 

Caution 

The order in which the components are upgraded is critical. Assuming 
a system of a DGC-2020ES and expansion module is in a state where 
the DGC-2020ES is communicating with the system expansion 
module, the expansion module must be upgraded before the 
DGC-2020ES. This is necessary because the DGC-2020ES must be 
able to communicate with the expansion module before the DGC-
2020ES can send firmware to it. If the DGC-2020ES were upgraded 
first, and the new firmware included a change to the expansion 
module communication protocol, it is possible that the expansion 
module could no longer communicate with the upgraded DGC-
2020ES. Without communications between the DGC-2020ES and the 
expansion module, upgrading the expansion module is not possible. 

 

Note 

If power is lost or communication is interrupted during file transfer to 
the DGC-2020ES, it will cease to operate and will not recover 
automatically. If this occurs or if the front panel HMI becomes blank 
and all LEDs are flashing at a two-second rate, the DGC-2020ES will 
not have valid firmware installed and the firmware must be uploaded 
again. To accomplish this, cycle power to the DGC-2020ES and 
activate the DGC-2020ES plugin in BESTCOMSPlus. Select Upload 
Device Files from the Communication pull-down menu and proceed 
normally. 
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Upgrading Firmware in Expansion Modules 
The following procedure is used to upgrade firmware in the DGC-2020ES expansion module. This must 
be completed before upgrading firmware in the DGC-2020ES. If no expansion module is present, proceed 
to Upgrading Firmware in the DGC-2020ES. 

1. Place the DGC-2020ES in OFF mode. This can be accomplished by clicking the Off button on the 
Control screen inside the Metering Explorer or by pressing the Off button on the DGC-2020ES front 
panel. 

2. Enable the expansion module that is present in the system. If it has not already been enabled, enable 
the expansion module on the SETTINGS > SYSTEM PARAMETERS > REMOTE MODULE SETUP 
screen. 

3. Verify that the DGC-2020ES and the associated expansion module are communicating. This can be 
verified by examining the pre-alarm status using the Metering Explorer in BESTCOMSPlus or from 
the front panel by navigating to METERING > ALARMS-STATUS > PRE-ALARMS. There should be 
no Loss of Comms pre-alarms in the pre-alarm status when communications are functioning properly. 

4. Connect to the DGC-2020ES through the USB port if not already connected. 

5. Select Upload Device Files from the Communication pull-down menu. 

6. You will be asked to save the current settings file. Select Yes or No. 

7. When the Basler Electric Device Package Uploader screen (Figure 3-14) appears, click on the Open 
button to browse for the device package you have received from Basler Electric. The Package Files 
along with File Details are listed. Place a check in the boxes next to the individual files you want to 
upload. 

 
Figure 3-14. Basler Electric Device Package Uploader 

8. Click on the Upload button and the Proceed with Device Upload screen will appear. Select Yes or No. 

9. After selecting Yes, the DGC-2020ES Selection screen will appear. Select the communication port to 
begin upload. Refer to Figure 3-15. 

10. After file(s) have been uploaded, click the Close button on the Basler Electric Device Package 
Uploader screen and disconnect communication to the DGC-2020ES. 
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Figure 3-15. DGC-2020ES Selection 

Upgrading Firmware in the DGC-2020ES 
Upgrade DGC-2020ES firmware and then load a saved settings file. 

1. Upgrade the DGC-2020ES firmware and language module. 

a. Connect to the DGC-2020ES with BESTCOMSPlus. Check the firmware Application 
Version on the GENERAL SETTINGS > VERSION INFO > DGC-2020ES screen. 

b. Select Upload Device Files from the Communication pull-down menu. You do not have to 
be connected to the DGC-2020ES at this time. Save settings when prompted, if desired. 

c. Open the desired device package file (∗∗∗∗DGC-2020ES-∗∗∗∗∗_xxyyzz.bef, where ∗∗∗∗ 
may be additional descriptive text of varying length, and xx.yy.zz is the version number of 
the device package file.) 

d. Check the boxes for DGC-2020ES Firmware and DGC-2020ES Language Module. Note 
the version number of the DGC-2020ES firmware; this is the version that will be used to 
set the Application Version in the settings file in a later step. This is NOT the same as the 
version of the package file that is contained in the fields xx.yy.zz in the package file 
name. 

e. Click the Upload button and follow the instructions that appear to begin the upgrade 
process. 

f. After the upload is complete, disconnect communication to the DGC-2020ES. 

2. Load the saved settings file into the DGC-2020ES. 

a. Close all settings files. 

b. From the File pull-down menu, select New, DGC-2020ES. 

c. Connect to the DGC-2020ES. 

d. Once all settings have been read from the DGC-2020ES, open the saved settings file by 
selecting the file with File, Open File in the BESTCOMSPlus menu. 

e. When BESTCOMSPlus asks if you wish to upload settings and logic to the device, click 
Yes. 

f. If you are receiving upload failures and indications that the logic is incompatible with the 
firmware version, check that the DGC-2020ES style number in the saved file matches 
that of the DGC-2020ES into which the file is being uploaded. The style number in the 
settings file is found under GENERAL SETTINGS > STYLE NUMBER in 
BESTCOMSPlus. 

g. If the style number of the settings file does not match that of the DGC-2020ES into which 
it is to be loaded, disconnect from the DGC-2020ES, then modify the style number in the 
settings file. Then repeat the steps titled Load the Settings File into the DGC-2020ES. 
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BESTCOMSPlus® Updates 

Ongoing DGC-2020ES functionality enhancements may make future DGC-2020ES firmware updates 
desirable. Enhancements to DGC-2020ES firmware typically coincide with enhancements to the DGC-
2020ES plugin for BESTCOMSPlus. When a DGC-2020ES is updated with the latest version of firmware, 
the latest version of BESTCOMSPlus should also be obtained. 

• You can check for BESTCOMSPlus updates by visiting www.basler.com. 

• BESTCOMSPlus automatically checks for updates when Check Automatically is selected on the 
Check for Updates User Settings screen. This screen is accessed under the Help drop-down 
menu. (An internet connection is required.) 

• You can use the manual “check for updates” function in BESTCOMSPlus to ensure that the latest 
version is installed by selecting Check for Updates in the Help drop-down menu. (An internet 
connection is required.) 

http://www.basler.com/
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4 • Communication 
DGC-2020ES communication ports include a mini-B USB port, CAN terminals, and provisions for an 
optional Remote Display Panel. The following paragraphs describe the DGC-2020ES communication 
ports in detail. 

Caution 

This product contains one or more nonvolatile memory devices. 
Nonvolatile memory is used to store information (such as settings) that 
needs to be preserved when the product is power-cycled or otherwise 
restarted. Established nonvolatile memory technologies have a physical 
limit on the number of times they can be erased and written. In this 
product, the limit is 100,000 erase/write cycles. During product 
application, consideration should be given to communications, logic, and 
other factors that may cause frequent/repeated writes of settings or other 
information that is retained by the product. Applications that result in such 
frequent/repeated writes may reduce the useable product life and result in 
loss of information and/or product inoperability. 

USB 

The rear-panel, mini-B USB port enables local communication with a PC running BESTCOMSPlus® 
software. The DGC-2020ES is connected to a PC using a standard USB cable. BESTCOMSPlus is a 
Windows®-based communication software package that is supplied with the DGC-2020ES. A detailed 
description of BESTCOMSPlus is provided in the BESTCOMSPlus chapter. 

CAN 

A Controller Area Network (CAN) is a standard interface that enables communication between multiple 
controllers on a common network using a standard message protocol. DGC-2020ES controllers have a 
CAN interface that supports the SAE J1939 protocol and the mtu protocol. 

Applications using an engine-driven generator set controlled by a DGC-2020ES may also have an Engine 
Control Unit (ECU). The CAN interface allows the ECU and DGC-2020ES to communicate. The ECU 
reports operating information to the DGC-2020ES through the CAN interface. Operating parameters and 
diagnostic information, if supported by the ECU, are decoded and displayed for monitoring. 

The primary use of the CAN interface is to obtain engine operating parameters for monitoring speed, 
coolant temperature, oil pressure, coolant level, and engine hours without the need for direct connection 
to individual senders. Table 4-1 lists the ECU parameters and Table 4-2 lists the engine configuration 
parameters supported by the DGC-2020ES CAN interface. These parameters are transmitted via the 
CAN interface at preset intervals. See the column labeled Update Rate in Table 4-1 for transmission 
rates. 

CAN interface connections are made at 13 (CAN H), 14 (CAN L), and 15 (SHIELD).   
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Table 4-1. ECU Parameters Obtained from CAN Interface 

ECU Parameter Metric Units English Units Update Rate ∗ 
SPN 

Actual Engine Percent Torque % % Engine Speed 
Dependent 

513 

Aftertreatment Diesel Particulate Filter 
Status 

0 = Regeneration not needed 
1 = Regeneration needed, lowest level 
2 = Regeneration needed, moderate 
level 
3 = Regeneration needed, highest level 
4–6 = Reserved 
7 = Not available 

500 ms 3701 

Aftertreatment 1 Diesel Particulate Filter 
Intake Temperature (DOC Inlet 
Temperature) 

°C °F 500 ms 3242 

Aftertreatment 1 Diesel Particulate Filter 
Intermediate Temperature (DOC Outlet 
Temperature) 

°C °F 500 ms 3250 

Aftertreatment 1 Diesel Particulate Filter 
Outlet Temperature 

°C °F 500 ms 3246 

Air Filter Differential Pressure kPa psi 500 ms 107 
Air Inlet Temperature kPa °F 1 s 172 

Alarm Reset Feedback Binary (0 or 1) 1 s 2815 
Ambient Air Temperature °C °F 1 s 171 

Auxiliary Pressure 1 kPa psi On Request 1387 
Auxiliary Pressure 2 kPa psi On Request 1388 
Barometric Pressure kPa psi 1 s 108 
Battery Charger 1 State 0 = Idle (not Connected to Battery) 

1 = Charging 
2 = Maintaining Battery Charge 
3–12 = Reserved 
13 = Battery Failure 
14 = Charger Failure 
15 = Not Available 

1 s 4990 

Battery Charger 1 AC Line State 0 = Disconnected 
1 = Connected 
2 = Error 
3 = N/A 

1 s 4991 

Battery Charger 1 Output Voltage Vdc Vdc 1 s 4992 
Battery Charger 1 Output Current Adc Adc 1 s 4993 
Battery Charger 2 State 0 = Idle (not Connected to Battery) 

1 = Charging 
2 = Maintaining Battery Charge 
3–12 = Reserved 
13 = Battery Failure 
14 = Charger Failure 
15 = Not Available 

1 s 4994 

Battery Charger 2 AC Line State 0 = Disconnected 
1 = Connected 
2 = Error 
3 = N/A 

1 s 4995 

Battery Charger 2 Output Voltage Vdc Vdc 1 s 4996 
Battery Charger 2 Output Current Adc Adc 1 s 4997 
Battery 1 Temperature °C °F 1 s 1800 
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ECU Parameter Metric Units English Units Update Rate ∗ 
SPN 

Battery 2 Temperature °C °F 1 s 1801 

Battery Voltage Vdc Vdc 1 s 168 
Boost Pressure kPa psi 500 ms 102 
Charge Air Temperature °C °F 1 s 2629 

Coolant Level % % 500 ms 111 
Coolant Pressure kPa psi 500 ms 109 
DEF Inducement Level - Level of 
Inducement Not to Run the Engine 

% % 1 s 5246 

DEF Severity Level - Severity of Tank 
Low Level 

% % 1 s 5245 

DEF Tank 1 Level % % 1 s 1761 
DEF Tank 2 Level % % 1 s 4367 
DPF Ash Level % % % On Request 3720 
DPF Soot Level % % % On Request 3719 
ECU Temperature °C °F 1 s 1136 

Engine Coolant Preheated State Binary (0 or 1) 500 ms 3552 
Engine Coolant Temperature °C °F 1 s 110 

Engine Desired Operating Speed rpm rpm 250 ms 515 
Engine Intake Manifold #1 Absolute 
Pressure 

kPa psi 500 ms 3563 

Engine Intercooler Coolant Level % % 500 ms 3668 
Engine Intercooler Temperature °C °F 1 s 52 

Engine Oil Level % % 500 ms 98 
Engine Oil Pressure kPa psi 500 ms 100 
Engine Oil Temperature °C °F 1 s 175 

Engine Speed rpm rpm Engine Speed 
Dependent 

190 

Exhaust Gas Temperature °C °F 500 ms 173 

Exhaust Temperature A °C °F 500 ms 2433 

Exhaust Temperature B °C °F 500 ms 2434 

Fuel Delivery Pressure kPa psi 500 ms 94 
Fuel Leak Filter 1 Binary (0 or 1) 1 s 1239 
Fuel Leak Filter 2 Binary (0 or 1) 1 s 1240 
Fuel Rate liter/hr gal/hr 100 ms 183 
Fuel Temperature °C °F 1 s 174 

High Exhaust System Temp (HEST) 
Lamp/Indicator 

— — 500 ms 3698 

Injection Control Pressure MPa psi 500 ms 164 
Injector Metering Rail Pressure MPa psi 500 ms 157 
Intake Manifold Temperature °C °F 500 ms 105 

Particulate Filter (DPF) Lamp/Indicator — — 500 ms 3697 
Percent Load at Current rpm % % 50 ms 92 
Rated Power watts watts On Request 166 
Rated rpm rpm rpm On Request 189 
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ECU Parameter Metric Units English Units Update Rate ∗ 
SPN 

Regeneration Disabled (Inhibit) 
Lamp/Indicator 

— — 500 ms 3703 

Shutdown from ECU Binary (0 or 1) 1 s 1110 
Switched Battery Voltage (at ECU) Vdc Vdc 1 s 158 
Throttle (Accelerator Pedal) Position % % 50 ms 91 
Total Engine Hours hours hours Requested 1.5 s 247 
Total Fuel Used liters gallons Requested 1.5 s 250 
Transmission Oil Pressure kPa psi 1 s 127 
Transmission Oil Temperature °C °F 1 s 177 

Trip Average Fuel Rate liters gallons 500 ms 1029 
Trip Fuel liters gallons Requested 1.5 s 182 
Winding 1 Temperature °C °F 1 s 1124 

Winding 2 Temperature °C °F 1 s 1125 

Winding 3 Temperature °C °F 1 s 1126 

∗  SPN is suspect parameter number. 
Table 4-2. Engine Configuration Parameters Obtained from CAN Interface 

ECU Parameter Metric Units English Units Update Rate ∗ 
SPN 

Engine Speed at High Idle Point 6 rpm rpm 5 s 532 
Engine Speed at Idle Point 1 rpm rpm 5 s 188 
Engine Speed at Point 2 rpm rpm 5 s 528 
Engine Speed at Point 3 rpm rpm 5 s 529 
Engine Speed at Point 4 rpm rpm 5 s 530 
Engine Speed at Point 5 rpm rpm 5 s 531 
Gain (Kp) of End Speed Governor %/rpm %/rpm 5 s 545 
Maximum Momentary Engine Override Speed Point 7 rpm rpm 5 s 533 
Maximum Momentary Engine Override Time Limit seconds seconds 5 s 534 
Percent Torque at Idle Point 1 % % 5 s 539 
Percent Torque at Point 2 % % 5 s 540 
Percent Torque at Point 3 % % 5 s 541 
Percent Torque at Point 4 % % 5 s 542 
Percent Torque at Point 5 % % 5 s 543 
Reference Engine Torque N•m ft-lb 5 s 544 

Requested Speed Control Range Lower Limit rpm rpm 5 s 535 
Requested Speed Control Range Upper Limit rpm rpm 5 s 536 
Requested Torque Control Range Lower Limit % % 5 s 537 
Requested Torque Control Range Upper Limit % % 5 s 538 

∗  SPN is suspect parameter number. 
 

Caution 
When the CAN is enabled, the DGC-2020ES ignores the following 
sender inputs: oil pressure, coolant temperature, and magnetic pickup. 
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Under certain circumstances, the following strings may be displayed on the front panel HMI and in the 
Metering Explorer of BESTCOMSPlus: 

• NC (Not Connected) - String displayed for a J1939 parameter when the engine ECU is not connected 
to the DGC-2020ES. 

• SF (Sender Fail) - String displayed for a J1939 parameter when the engine ECU sends a special 
code indicating a measurement failure for the parameter. For example, if oil sender is determined to 
be bad by the ECU, it sends a special code in place of the J1939 oil pressure data indicating a sender 
fail condition. 

• NS (Not Sent) - String displayed for a J1939 parameter when the J1939 parameter has not been sent 
to the DGC-2020ES by the engine ECU. 

• NA (Not Applicable) - String displayed for a J1939 parameter when the engine ECU sends a special 
code for the parameter indicating that the parameter is not implemented or not applicable in the ECU. 

• UF (Unknown Failure) - String displayed when the J1939 parameter data received by the ECU is not 
within the valid J1939 data range for the parameter but is not one of the special codes above. 

Table 4-3 lists the J1939 data transmitted from the DGC-2020ES. 
Table 4-3. J1939 Data Transmitted from the DGC-2020ES 

ECU Parameter Update Rate ∗ 
SPN 

Battle Override Switch 100 ms 1237 
Speed Request 10 ms 898 
Note: Requests from the DGC-2020 to the Engine ECU for various parameters are made by issuing the request. 
Address Claim Request Once on power up, and any time a Global Request for 

Address Claim (GRAC) PGN is received. 
NA 

Currently Active Diagnostic Trouble Codes 
Request 

Whenever a refresh of Currently Active Diagnostic 
Trouble Code Requests is received. 

NA 

Previously Active Diagnostic Trouble Codes 
Request 

2 s NA 

Clear Currently Active Diagnostic Trouble 
Codes Request 

Whenever a request to reset Currently Active Diagnostic 
Trouble Code Request is made. 

NA 

Clear Previously Active Diagnostic Trouble 
Codes Request 

Whenever a request to reset Previously Active Diagnostic 
Trouble Code Request is made. 

NA 

Engine Hours/Revolutions Request 2 s NA 
Fuel Consumption Request 2 s NA 
Electronic Engine Controller #4 (Rated 
Speed and Power) Request 

2 s NA 

Auxiliary Analog Information 2 s N/A 

CAN Setup 
The following paragraphs describe the settings found on the CAN Setup screen. This screen is found in 
the BESTCOMSPlus Settings Explorer, under the Communications, CAN Bus category. If using the front 
panel, navigate to Settings > Communications > CAN Bus Setup > CAN Bus Setup. Figure 4-1 illustrates 
the BESTCOMSPlus CAN Bus Setup screen. 

Enable ECU Support  

Set to Enabled for the DGC-2020ES to communicate with the ECU. 

Enable DTC (Diagnostic Trouble Code) Support 

If the ECU is a J1939 ECU, enable DTC support. If the ECU does not support it, no diagnostic trouble 
codes will be logged by the DGC-2020ES. 
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SPN Conversion Method 

The most common SPN conversion method is 4 and is the default for the DGC-2020ES. Refer to ECU 
manufacturer documentation to determine the correct SPN conversion method of the ECU and set the 
SPN Conversion Method setting in the DGC-2020ES accordingly. 

CAN bus Address 

This parameter sets a unique address number for the DGC-2020ES operating on a CAN. The CAN 
Address is set internally by the DGC-2020ES when certain types of ECUs are selected on the ECU Setup 
screen, and in this case, the user-entered value does not apply. See Table 4-4. 

Table 4-4. CAN Bus Address per ECU Type 

ECU Type CAN Bus Address 
Cummins 220 
Daimler CPC4 User-selectable 
Deutz User-selectable 
GM/Doosan User-selectable 
Isuzu User-selectable 
John Deere User-selectable 
mtu ADEC 1 
mtu ECU7/ECU8 6 
mtu MDEC 6 
mtu Smart Connect 234 
Scania 39 
Standard User-selectable 
Volvo Penta 17 
Yanmar User-selectable 

Engine ECU Address 

Set this parameter to the address claimed by the Engine ECU operating on the J1939 network. In certain 
cases, there is more than one ECU transmitting data on the J1939 network. This setting specifies the 
ECU on the network to which the DGC-2020ES should transmit data. For more information on J1939 
address handling, see J1939 Addresses below. When GM/Doosan is selected as the ECU type, the value 
of this setting is ignored and the Engine ECU Address value is always 0. 

Coolant Temperature Source 

With From ECU selected, the DGC-2020ES accepts coolant temperature data from the ECU on CAN 2 
(ECU). With From DGC Input selected, the DGC-2020ES accepts coolant temperature data from the 
coolant temperature engine sender input. 

Oil Pressure Source 

With From ECU selected, the DGC-2020ES accepts oil pressure data from the ECU on CAN 2 (ECU). 
With From DGC Input selected, the DGC-2020ES accepts oil pressure data from the oil pressure engine 
sender input. 

Engine Run Time Source 

With From ECU selected, the DGC-2020ES accepts Engine Run Time data from the ECU on CAN 2 
(ECU). With From DGC Input selected, the DGC-2020ES uses its internally tracked Engine Run Time 
data. 



9469200995 4-7 

DGC-2020ES Communication 

ECU Contact Control - Output Select 

Select whether the RUN output relay or the PRE (Prestart) output relay closes to give the ECU its 
“energize to run” signal. In some implementations, this relay may actually be providing ECU power. 

ECU Contact Control - Pulsing Enable 

Select if the ECU is not to be on line at all times. Often ECUs are allowed to go “off line” to conserve 
battery drain when the engine is not running. The DGC-2020ES will “pulse” it periodically to force it to be 
active to allow the DGC-2020ES to read data such as coolant temperature and coolant level. This is 
required if the DGC-2020ES is to report low coolant temperature conditions (which may indicate a failure 
of a block heater), or low coolant level conditions (if a leak occurs while the machine is not running). 
Pulsing is also used to check the integrity of CAN communications when the machine is not running. 

ECU Related Time Values - Engine Shut Down 

Set this parameter for a value longer than the duration required to stop the engine after being shut down. 
The ECU is pulsed after this time expires. If the time is too short, the pulse may occur while the engine is 
still turning which could cause a brief re-start and possibly damage the flywheel and starter system. 

ECU Related Time Values - Pulse Cycle Time 

Set this parameter for the desired time between ECU pulse cycles. 

ECU Related Time Values - Settling Time 

This parameter is the duration of the “on line” time of the pulse cycle during which the DGC-2020ES 
reads data from the ECU. The settling time should be set long enough so that any ECU parameters that 
require time to “settle down” after the ECU is on line can do so. Since the DGC-2020ES may use some of 
the ECU data for alarm or pre-alarm annunciation, it is important that the data have time to settle. 

ECU Related Time Values - Response Timeout 

This setting defines the amount of time that the DGC-2020ES will wait to receive data from the ECU 
during a pulse cycle or start attempt. If no data is received during this time in a pulse cycle, a LOSS OF 
ECU COMMS pre-alarm is annunciated. If no data is received in this time during an engine starting 
attempt, a LOSS OF ECU COMMS alarm is annunciated. 
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Figure 4-1. Settings Explorer, Communications, CAN Bus, CAN Bus Setup 

ECU Setup 
The following paragraphs describe the settings on the ECU Setup screen. This screen is found in the 
BESTCOMSPlus Settings Explorer, under the Communications, CAN Bus category. If using the front 
panel, navigate to Settings > Communications > CAN Bus Setup > ECU Setup. Refer to Figure 4-2. 

ECU Type 

The DGC-2020ES can be configured for Standard, Volvo Penta, mtu MDEC, mtu ADEC, mtu 
ECU7/ECU8, GM/Doosan, Cummins, mtu Smart Connect, Scania, John Deere, Isuzu, Daimler CPC4, 
Yanmar, or Deutz. 

Generator Parameter Transmit 

When the Generator Parameter Transmit setting is enabled, the DGC-2020ES broadcasts generator 
metered parameters over CAN as listed in Table 4-5. The Generator Parameter Transmit setting is not 
used when ECU Type is set for mtu MDEC, mtu ECU7/ECU8, or mtu Smart Connect. 

Engine Parameter Transmit 

When the Engine Parameter Transmit setting is enabled, the DGC-2020ES broadcasts engine metered 
parameters over CAN. When the Engine Parameter Transmit setting is disabled, transmission of J1939 
commands from the DGC-2020ES to the engine are disabled, but commands from the engine to the 
DGC-2020ES are allowed. 
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Table 4-5. Generator Parameter Transmit 

PGN Name PGN Hex SPN Parameter 
Bytes 

Within PGN 
Data 

Generator Total 
AC Energy 65018 FDFA 

2468 Generator Total kW Hours Export 1 to 4 

2469 Generator Total kW Hours Import 5 to 8 

Generator Total 
AC Reactive 
Power 

65028 FE04 

2456 Generator Total Reactive Power 1 to 4 

2464 Generator Overall Power Factor  5 to 6 

2518 Generator Overall Power Factor Lagging 7, bits 1 & 2 

Generator Total 
AC Power 65029 FE05 

2452 Generator Total Real Power 1 to 4 

2460 Generator Total Apparent Power 5 to 8 

Generator 
Average Basic AC 
Quantities 

65030 FE06 

2440 Generator Average L-L AC RMS Voltage 1 to 2 

2444 Generator Average L-N AC RMS Voltage 3 to 4 

2436 Generator Average AC Frequency 5 to 6 

2448 Generator Average AC RMS Current 7 to 8 

Engine 
Temperature 65262 FEEE 110 Engine Coolant Temperature (Not sent 

when CAN is enabled.) 1 

Engine Fluid 
Level/Pressure 65263 FEEF 100 Engine Oil Pressure (Not sent when CAN 

is enabled. 4 

Dash Display 65276 FEFC 96 Fuel Level 2 

Diesel Particulate Filter (DPF) 

The diesel particulate filter settings are used when the ECU is configured for Standard, Volvo Penta, mtu 
ADEC, GM/Doosan, Cummins, or mtu Smart Connect. The DGC-2020ES supports the CAN parameters 
that are related to the diesel particulate filter implemented on certain engines to meet Tier 4 emission 
requirements. 

Two parameters are provided to initiate or disable DPF regeneration. The first, Manual Regeneration, is 
transmitted to the engine via CAN to initiate DPF regeneration. The second, Disable Regeneration, is 
transmitted to the engine via CAN to disable DPF regeneration. Extended operation with regeneration 
disabled is not recommended. 

Speed Setup 

Speed control over J1939 and ECU7/ECU8 is implemented over CAN when the CAN bus RPM Request 
setting is enabled. This is implemented for all ECUs.  

Engine RPM: The Engine RPM setting defines the nominal requested engine rpm.  

Idle RPM: The Idle RPM setting is the requested rpm when the IDLE REQUEST logic element is true.  

Remember Speed Adjustments: A Remember Speed Adjustments setting is provided to establish how 
RPM adjustments by raise/lower commands are saved. When Yes is selected, adjustments to RPM by 
raise/lower commands are saved to memory and used for all subsequent run sessions. This is true even 
when power is cycled to the DGC- 2020ES. When No is selected, adjustments to rpm by raise/lower 
commands are retained for the duration of only the current run session. The adjustments are discarded 
the next time the engine is run or the DGC-2020ES is power cycled. 

RPM Bandwidth: The RPM Bandwidth setting defines the speed adjustment range. For example, if the 
Engine RPM setting is 1800 and the RPM Bandwidth is set to 100, the rpm can be adjusted from 1750 to 
1850 rpm. 

RPM Checksum: Some newer engine ECUs will not respond to TSC1 speed request when the speed is 
a constant value unless a Message Counter and Checksum are implemented. This setting enables or 
disables the Message Counter and RPM Checksum. 
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Start Mode 

The Start mode specifies whether the engine should start normally or as rapidly as possible. When 
Normal mode is selected, the engine will go through a normal start sequence when started. When Rapid 
mode is selected, the engine will go through a rapid start sequence if the engine ECU is programmed for 
a rapid start. A normal start could be employed when starting the generator is not time critical. However, if 
there was a power outage, a rapid start could be employed to restore power as soon as possible. 

Volvo Penta 

Configuring the DGC-2020ES for Volvo Penta* necessitates the configuration of two additional settings: 
Speed Select and Accelerator Position. The Speed Select setting configures the Volvo Penta ECU to 
operate the engine at the primary or secondary base speed. If the engine is configured by Volvo for 60 Hz 
applications, the primary base speed is 1,800 rpm and the secondary base speed is 1,500 rpm. If the 
engine is configured by Volvo for 50 Hz applications, the primary base speed is 1,500 rpm and the 
secondary base speed is 1,800 rpm. The Accelerator Position setting is expressed as a percentage and 
tells the Volvo Penta ECU where to set the engine speed (trim) relative to the base speed. The range of 
the setting is the base speed ±120 rpm. A setting of 0% will cause the engine to run at 120 rpm below the 
base speed, a setting of 50% will cause the engine to run at the base speed, and a setting of 100% will 
cause the engine to run at 120 rpm above the base speed. The Accelerator Position setting is linear with 
a gain of 2.4 rpm/percentage. This setting is not saved in nonvolatile memory and defaults back to 50% 
after DGC-2020ES control power is cycled. 

The DGC-2020ES sends the following parameters to a Volvo Penta ECU through Volvo Proprietary 
J1939 communications: 

• Start Request - sent when starting the engine. 
• Stop Request - sent when shutting down the engine. 
• Idle Request - sent when the Idle Request logic element is true in BESTlogicPlus. 
• Preheat Request - sent anytime the DGC-2020ES would normally have its PRE relay closed for 

engines requiring a preheat contact. 
• Accelerator Pedal Position - sent based on the Accelerator Position setting. If the Accelerator Pedal 

Position setting is left at the default 50%, this is calculated and sent based on the programmable 
Engine RPM setting to achieve the desired engine RPM. 

• Primary/Secondary Engine Speed - sent based on the Speed Select setting and the state of the 
Alternate Frequency Override element in BESTlogicPlus. Primary speed is sent when the Speed 
Select setting is set for Primary and Secondary speed is sent when the Speed Select setting is set 
for Secondary. However, these are reversed if the Alternate Frequency Override is true. A setting 
of Primary results in Secondary being sent and a setting of Secondary results in Primary being sent 
when the Alternate Frequency Override is true. 

∗ The Volvo Penta ECU configuration is applicable only to the EDC3 and EMS2 models of Volvo Penta 
engine controllers. 

Cummins 

When Cummins is selected as the ECU type, the following parameters are sent to the engine via 
Cummins Proprietary J1939 communications: 

• Start Request - sent when starting or running the engine. 
• Stop Request - sent when stopping the engine. 
• Idle Request - sent when the Idle Request logic element is true in BESTlogicPlus. 
• Rated Speed (50 or 60 Hz) - sent based on the Rated Speed setting of the DGC-2020ES. However, 

these are reversed if the Alternate Frequency Override is true. A setting of 60 Hz Rated Speed 
results in 50 Hz being sent and a setting of 50 Hz Rated Speed results in 60 Hz being sent when 
the Alternate Frequency Override is true. 

Generator Control Communications Configuration: A parameter is provided to configure generator 
control communications. If the standard PGNs for Generator Control One and Generator Control Two are 
broadcast by the generator controller, the Cummins ECU will use those. If they are not broadcast, the 
ECU will expect the Cummins Engine Governing PGN (0xFF69) and Cummins Generator Control PGN 
(0xFF73). If the user selects Standard for the Generator Control Communications setting, the DGC-
2020ES will not broadcast 0xFF69 and 0xFF73 in order to minimize loading on the CAN Bus. 
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mtu 

If the engine is configured as mtu MDEC, the configuration of the following settings is necessary: 
• MDEC Module Type - Specifies the type of MDEC module. 
• Speed Demand Switch - Specifies speed demand source for the mtu engine ECU. 
• NMT Alive Transmit Rate - Specifies the rate at which messages are transmitted to the mtu engine. 

If the engine is configured as mtu ADEC, the configuration of the following settings is necessary: 
• Speed Demand Switch - Specifies speed demand source for the mtu engine ECU.  
• Overspeed Test - Temporarily drives an mtu ECU into overspeed for testing overspeed. 
• Governor Param Switch Over - Specifies which governor parameters an mtu ECU should use. 
• Trip Reset - Resets trip information such as trip fuel used, trip hours, trip idle time, etc. 
• Int Oil Prime - Causes an mtu ECU engine to perform an internal lubrication cycle. 
• CAN Start Stop Configuration – Specifies when to broadcast Start / Stop status. 

If the engine is configured as mtu ECU7/ECU8, the configuration of the following settings is necessary: 
• Speed Demand Switch - Specifies speed demand source for the mtu engine ECU. 
• Overspeed Test - Temporarily drives an mtu ECU into overspeed for testing overspeed. 
• Speed Up - Increases speed of the mtu ECU. 
• Speed Down - Decreases speed of the mtu ECU. 
• Idle Request - Turns the idle request on or off. 
• Increased Idle - Sets the mtu ECU idle. 
• Trip Reset - Resets trip information such as trip fuel used, trip hours, trip idle time, etc. 
• Int Oil Prime - Causes an mtu ECU engine to perform an internal lubrication cycle. 
• mtu 50 Hz 60 Hz Switch Setting - Set automatically based on rated frequency of the DGC-2020ES 

and the state of the alternate frequency override. 
• Engine Start Prime - Turns the engine start prime on or off. 
• Fan Override - Turns the fan override on or off. 
• Mode Switch - Turns the mode switch on or off. 
• Governor Param Set Select - Sets the governor parameter set select. 
• CAN Rating Switch 1 & 2 - Turns the CAN rating switch 1 & 2 on or off. 
• Cylinder Cutout Disable 1 & 2 - Turns the cylinder cutout disable 1 & 2 on or off. 
• mtu ECU7/ECU8 Module Type - Specifies ECU7/ECU8 Module type. 
• NMT Alive Transmit Rate - Specifies the rate at which messages are transmitted to the mtu engine. 
• CAN Start Stop Configuration – Specifies when to broadcast Start / Stop status. 

If the engine is configured as mtu Smart Connect, the configuration of the following settings is necessary: 
• Speed Demand Switch - Specifies speed demand source for the mtu engine ECU. 
• Overspeed Test - Temporarily drives an mtu ECU into overspeed for testing overspeed. 
• Speed Up - Increases speed of the mtu ECU. 
• Speed Down - Decreases speed of the mtu ECU. 
• Idle Request - Turns the idle request on or off. 
• Trip Reset - Resets trip information such as trip fuel used, trip hours, trip idle time, etc. 
• Int Oil Prime - Causes an mtu ECU engine to perform an internal lubrication cycle. 
• Governor Param Switch Over - Specifies which governor parameters an mtu ECU should use. 
• Cylinder Cutout Disable 2 - Turns the cylinder cutout disable 2 on or off. 
• Engine Operating Mode - Selects engine operating mode 1 or 2. 
• CAN Start Stop Configuration – Specifies when to broadcast Start / Stop status. 

CAN Start Stop Configuration: When this setting is set to Constant, either start or stop is true at all 
times. When set to On for Start/Stop, start is true only while starting and stop is true only while stopping. 
When set to Disabled, start and stop are implemented in the protocol, but are never set to true. When set 
to Not Implemented, the J1939 boolean start and stop parameters are set to 0x03 (Not Implemented) for 
mtu ADEC and mtu Smart Connect ECUs, and neither start nor stop are sent in MCS5 Protocol for mtu 
ECU7/8 ECUs. 
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Scania 

The majority of CAN Bus parameters are sent from Scania Engine ECUs via standard J1939 
communications. However, some additional proprietary parameters are sent via Scania proprietary J1939 
communications. Proprietary Start, Stop, and Emergency Stop commands are sent from the 
DGC-2020ES to the Scania ECU. The ECU communicates Diesel Exhaust Fluid (DEF) Levels, as well as 
DEF Fluid Low, DEF Low Severe, DEF Inducement, and DEF Severe Inducement Pre-Alarms to the 
DGC-2020ES through Proprietary Scania parameters. Additional information on DEF related parameters 
can be found in the Exhaust Treatment chapter. 

John Deere 

The Regeneration Interlock setting enables John Deere proprietary parameters to be broadcast over the 
J1939 CAN Bus. 

The Regeneration Interlock parameter is sent via the Stationary Regeneration/Cleaning CAN Lockout 
Message PGN, which is PGN 61194. When the DGC Regeneration Interlock value is set to Enabled, the 
DGC-2020ES sends a value of 01 (binary) for the two bit “Allowed” configuration which allows 
regeneration to occur. When the DGC-2020ES Regeneration Interlock value is set to Disabled, the DGC-
2020ES sends a value of 00 (binary) for the two bit “Not Allowed” configuration which inhibits 
regeneration. 

The DGC-2020ES sends starter engagement requests to the ECU via the SAE J1939 Engine Start 
Control PGN. When the DGC-2020ES requests the starter to be engaged it sends a value of 01 (binary) 
for the two-bit starter engagement parameter. Otherwise the DGC-2020ES sends a value of 00 (binary) 
for the two-bit starter engagement parameter. 

Isuzu 

When the ECU type is set for Isuzu, the Clear ECU Memory and Escape Mode Request buttons are 
operational. When the Clear ECU Memory button is clicked, it will remain on for five seconds and then 
turn off, sending a five-second long memory clear request to the engine ECU. When the Escape Mode 
Request button is clicked, a temporary override of inducement to not operate the engine is sent to the 
ECU. 

Daimler CPC4 

When the ECU type is set for Daimler CPC4, the DGC-2020ES monitors the Torque Limit (LIM) Lamp 
Status broadcast via proprietary J1939 communications from the Daimler engine ECU to the 
DGC-2020ES. When the monitored LIM Lamp status indicates the lamp is on solid, the DGC-2020 
annunciates a pre-alarm displaying the LIM symbol and text “Torque Limit”. When the monitored LIM 
Lamp status indicates the lamp is flashing, the DGC-2020ES annunciates a pre-alarm displaying the LIM 
symbol and text “Torque Limit Severe”. The DGC-2020ES also displays the LIM symbol in the exhaust 
status display portion of the front panel display. 

Yanmar 

Some DTC-FMI combinations report different Yanmar P Codes depending on whether the engine has 
three or four cylinders. The Number of Cylinders setting specifies how many cylinders exist in the engine. 

 



9469200995 4-13 

DGC-2020ES Communication 

 

 
Figure 4-2. Settings Explorer, CAN Bus, ECU Setup 

Remote Display Panel (optional) 

Applications that require remote annunciation can use Basler Electric’s Remote Display Panel. This 
device provides remote indication of many pre-alarm and alarm conditions. 

Remote Display Panel connections are made at 10 (RDP TxD–), 11 (RDP TxD+), 17 (BATT–), and 18 
(BATT+). 

The following pre-alarm conditions are indicated by LEDs on the Remote Display Panel: 
• High coolant temperature 
• Low coolant temperature 
• Low oil pressure 
• Low fuel level∗ 
• Weak battery 
• Battery overvoltage† 
• Battery charger failure∗† 

The following alarm conditions are indicated by LEDs and an audible alarm on the Remote Display Panel: 
• Low coolant level∗ 
• High coolant temperature 
• Low oil pressure 
• Overcrank 
• Overspeed 
• Emergency stop activated 
• Fuel leak/Sender failure∗† 
• Sender failure† 

∗ This can be configured in the DGC-2020ES as None, Alarm, or Pre-alarm. See the Contact Inputs 
chapter for more information. The LED on the Remote Display Panel illuminates when the input that is 
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assigned to the programmable function is closed, whether the function is configured as None, Alarm, or 
Pre-alarm. 

† This LED can be reprogrammed in the DGC-2020ES to suit the needs of a particular application. The 
condition listed above is annunciated by default. 

Additionally, the Remote Display Panel indicates when the DGC-2020ES is not operating in Auto mode 
and when the generator is supplying load or when the DGC-2020ES is in an alarm state not listed above. 

Refer to Basler Publication 9318100990 for more information on the Remote Display Panel. 

See the Terminals and Connectors chapter in the Installation manual for more information on connecting 
the Remote Display Panel to the DGC-2020ES. 
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5 • Device Configuration 
System parameters configure the DGC-2020ES for operation with a specific application. This chapter lists 
items to consider when configuring the DGC-2020ES. These items consist of system settings and rated 
data, remote module setup, crank settings, automatic restart settings, exercise timer settings, sensing 
transformer ratings, relay control settings, and system configuration detection settings. 

System Settings 

The System Settings parameters consist of number of fly wheel teeth, speed signal source, power-up 
delay, fuel level function, NFPA compliance level, EPS supplying load, system units, and metric pressure 
units. The System Settings screen is found in the BESTCOMSPlus® Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > System 
Settings. 

Number Flywheel Teeth 
The Number Fly Wheel Teeth setting accepts a value from 1 to 500, in increments of 0.1. This value is 
used when calculating engine rpm. 

Speed Signal Source 
The DGC-2020ES can be configured to detect engine speed from a magnetic pickup (MPU), the genset 
frequency, or both the MPU and genset frequency. On engines with CAN ECUs, if MPU or MPU Freq is 
selected as the Speed Signal Source, the DGC-2020ES uses CAN as the speed source when CAN is 
enabled. If Gen Freq is set as the Speed Signal Source, the DGC-2020ES uses the generator frequency. 

When engine speed is obtained from the genset frequency, the DGC-2020ES uses the rated (nominal) 
genset frequency and nominal rpm rating when calculating engine rpm. 

When engine speed is obtained from an MPU, the DGC-2020ES uses the nominal rpm rating and the 
number of flywheel teeth when calculating engine rpm. 

The speed signal from the MPU takes priority when both the genset frequency and MPU are selected as 
the engine speed source. If both MPU and genset frequency are selected and the MPU fails, the DGC-
2020ES automatically switches to the genset frequency as the engine speed source. 

Power Up Delay 
In some cases, the ECU takes longer than the DGC-2020ES to power up. The power up delay setting is 
used to delay the initial pulsing of the ECU for data on DGC-2020ES power up. This setting ranges from 0 
to 60 seconds in 1 second increments. 

Fuel Level Function 
This setting determines whether the fuel level indications and the related alarm and pre-alarm are 
enabled or disabled. Setting selections include, Fuel Lvl (Fuel Level), Natural Gas, Liquid Propane, or 
Disabled. Selecting a fuel type other than Fuel Lvl disables any fuel level indication, alarm, or pre-alarm. 
This includes the Fuel Level value on the Metering Explorer, Engine screen in BESTCOMSPlus. 

NFPA Compliance Level 
The DGC-2020ES can be used in an application requiring compliance with NFPA Standard 110. Levels 1 
and 2 of Standard 110 are supported. Selecting level 1 or 2 affects DGC-2020ES operation in the 
following ways: 

• The number of crank cycles is fixed at 3 
• Crank cycle time is fixed at 15 seconds 
• Continuous crank time is fixed at 45 seconds 
• The low coolant temperature pre-alarm setting is fixed at 70°F 
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EPS Supplying Load 
EPS Supplying Load settings consist of Low Line Scale Factor and EPS Threshold. These settings are 
described in the following paragraphs. 

Low Line Scale Factor 

Low Line Scale Factor automatically adjusts the EPS threshold setting in applications utilizing more than 
one type of genset connection. The scale factor setting is implemented when the DGC-2020ES senses a 
contact closure at a contact input programmed to activate scaling of the settings. The value of the scale 
factor setting serves as a multiplier for the threshold setting. For example, if a scale factor contact input is 
received by the DGC-2020ES and the scale factor setting is 2.000, the threshold setting is doubled (2.000 
x Threshold setting). 

EPS Threshold 

Indication that the emergency power system is supplying load is determined by a user-adjustable 
threshold setting. This setting is expressed as a percentage of the genset CT (nominal) primary rating. 

This setting accepts values from 3 to 10, in increments of 1%. 

System Units 
Engine oil pressure and coolant temperature can be displayed in English or metric units of measure. 

Metric Pressure Units 
This setting allows engine oil pressure to be displayed in bar or kPa/MPa. 

 
Figure 5-1. Settings Explorer, System Parameters, System Settings Screen 

Rated Data 

Rated Data parameters consist of sensing transformer ratings, voltage, power factor, kW, engine RPM, 
frequency, battery volts, generator and bus connection types, and phase rotation. The Rated Data screen 
is found in the BESTCOMSPlus Settings Explorer under the System Parameters category. If using the 
front panel, navigate to Settings > System Parameters > System Settings. 

Click the Edit button on the BESTCOMSPlus Rated Data settings screen to adjust values. Click OK to 
accept the changes, and Cancel to discard them. 

Sensing Transformers 
For information on sensing transformers settings, see Sensing Transformers, below. 

Rated Data 
Genset nameplate data used by the DGC-2020ES includes the rated voltage, power factor, kW, and 
engine RPM. 
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Rated Volts (V L-L) 

This setting accepts values from 1 to 99,999, in increments of 1. 

Rated Power Factor (PF) 

This setting accepts values from -1 to 1, in increments of 0.001. 

Genset kW Rating 

This setting accepts values from 5 to 9,999, in increments of 1. 

Rated Engine RPM 

This setting accepts values from 25 to 3,600, in increments of 1. 

Calculated Rated Data 

Rated Secondary Volts, Rated Phase Amps, Rated Secondary Phase Amps, Rated kVA, and Rated kvar 
are calculated automatically. The equations used for these calculations are listed below. 
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Frequency 
The frequency settings allow selection of the rated frequency of the generator and an alternate frequency. 

Rated Frequency of the Unit 

Rated frequency settings consist of 50 and 60 Hz. 

Alternate Frequency 

This setting accepts values from 10 to 450, in increments of 0.01. 

Battery Volts 
The nominal voltage of the starter battery is used by the DGC-2020ES to detect and annunciate battery 
overvoltage and low or weak battery voltage. The Battery Volts settings consist of 12 V and 24 V. 

Generator Connection 
Genset connection types accommodated by the DGC-2020ES include three, three-phase connections 
(delta, wye, and grounded delta) and a single-phase configuration (sensing across phases A and B.) 

Bus Connection 
Bus connection types consist of single- and three-phase. Single-phase bus voltage is sensed across 
phases A and B. 
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Phase Rotation 
The Phase Rotation setting allows selection of ABC or CBA rotation according to the phase rotation 
connection of the machine. The DGC-2020ES calculates the power angle as the angle between the 
Phase AB voltage and phase B current. An angle compensation factor, determined by the phase rotation 
setting, is then applied. If the actual phase rotation connection of the machine does not match the phase 
rotation setting, calculation of the power angle will be incorrect, which may result in a miscalculation of 
kW, kvar, and power factor. 

 
Figure 5-2. Settings Explorer, System Parameters, Rated Data Screen 

Remote Module Setup 

When the optional CEM-2020 is enabled, a J1939 address must be entered. Select the appropriate 
number of outputs available on the CEM-2020. The low current module (CEM-2020) provides 24 contact 
outputs and the high current module (CEM-2020H) provides 18 contact outputs. 

The Remote Module Setup screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Remote 
Module Setup. 

The BESTCOMSPlus Remote Module Setup screen is illustrated in Figure 5-3. 
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Figure 5-3. Settings Explorer, System Parameters, Remote Module Setup Screen 

Crank Settings 

The Crank Settings consist of pre-start, restart, cranking, crank disconnect, and cool down. These 
settings are described in the paragraphs below. 

The Crank Settings screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Crank 
Settings. 

The BESTCOMSPlus Crank Settings screen is illustrated in Figure 5-4. 

Pre-Start 
If desired, cycle or continuous cranking can be delayed after initiating engine startup. During this delay, 
the Pre-Start output closes to energize glow plugs or pre-start the lubrication pump. The Pre-crank Delay 
setting accepts values from 0 to 30, in increments of 1 second. 

The Pre-Start output can be configured to open upon the conclusion of engine cranking or remain closed 
as long as the engine is running. 

 

The Pre-Start output can be configured during the resting state. If Preheat Before Crank is selected, the 
Pre-Start output is closed for the duration of the Pre-crank Delay time prior to entering the first cranking 
state or any subsequent cranking state. If the Pre-crank Delay setting is longer than the rest interval, the 
Pre-Start output is closed for the entire duration of the rest time. 

For example, suppose Crank Cycle Time and  Rest Time are 30 seconds, Pre-crank Delay time is 15 
seconds, and Preheat Before Crank is selected. Then, when it is desired to start the engine, the following 
would occur: 

• Pre-Crank Delay of 15 seconds 
• Crank for 30 seconds 
• Rest for 15 seconds 
• Rest and Pre-Crank Delay for 15 seconds 
• Crank for 30 seconds 
• Rest and Pre-Crank Delay for 15 seconds 
• Crank for 30 seconds 
• Repeating until the engine starts or the maximum number of crank cycles has occurred. 

For another example, suppose Crank Cycle Time and Rest Time are 30 seconds, Pre-crank Delay time is 
60 seconds, and Preheat Before Crank is selected. Then, when it is desired to start the engine, the 
following would occur: 

• Pre-Crank Delay of 60 seconds 
• Crank for 30 seconds 
• Rest and Pre-Crank Delay for 30 seconds (the Rest Time setting controls the duration of this 

state) 
• Crank for 30 seconds,  
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• Rest and Pre-Crank Delay for 30 seconds (the Rest Time setting controls the duration of this 
state) 

• Crank for 30 seconds,  

Repeating until the engine starts or the maximum number of crank cycles has occurred. 

Restart 
Attempting to start an engine after a normal shutdown but before the engine RPM has settled to zero can 
stress an engine in certain situations. The Restart Delay inhibits attempts to start the engine immediately 
after a normal shutdown for the duration of the Restart Delay timer. This delay should allow an engine to 
properly spin down before attempting to restart. This setting accepts values from 0 to 120, in increments 
of 1 second. 

Cranking 
The DGC-2020ES can be programmed for either cycle or continuous cranking. 

Cycle cranking provides multiple engine starting attempts. Each starting attempt consists of a fixed 
interval of engine cranking followed by a rest interval. The Number of Crank Cycles setting accepts 
values from 1 to 7, in increments of 1. The Cycle Crank Time setting accepts values from 5 to 15, in 
increments of 1 second.  

Continuous cranking provides a single, extended engine-starting attempt. The Continuous Crank Time 
setting accepts values from 5 to 60, in increments of 1 second. 

A Minimum Crank Time setting can help prevent premature crank disconnections by ignoring engine rpm 
broadcast data until the minimum crank time has elapsed. 

Crank Disconnect 
Under normal operation, engine rpm is used to determine crank disconnect. The Crank Disconnect Limit 
setting establishes the engine rpm percentage at which the starter is disconnected. This setting accepts 
values from 10 to 100, in increments of 1 percent. 

The Oil Pressure Crank Disconnect provides a secondary indication that the engine is running. This 
ensures that the starter is disconnected, even if no engine rpm sources are functioning. When enabled, 
oil pressure is used to determine if the engine is running. If the engine oil pressure is above the threshold, 
the starter is disconnected from the engine. The Crank Disconnect Pressure threshold setting accepts 
values from 2.9 to 150 psi, 0.2 to 10.3 bar, and 20 to 1,034.5 kPa, in increments of 0.1. 

Cool Down 
After the load is removed from a genset, the DGC-2020ES implements a smart cool-down function. This 
function ensures that the engine and turbocharger properly cool down by maintaining engine operation for 
a user-defined duration.  

This cool-down function is initiated for any one of the following conditions: 
• Genset load is removed and engine shutdown is permitted while in AUTO mode 
• Auto Transfer switch (ATS) opens while operating in AUTO mode 
• Remote shutdown is initiated while in AUTO mode 
• Off Mode Cool down is initiated 
• The Cool-down Request logic element is initiated 
• The Cool and Stop Request logic element is initiated 

Settings 

Off Mode Cool Down: Upon receiving a cool-down request with this setting enabled, the unit will enter a 
cool down cycle when in Off mode. 

Cool-Down Configuration: Upon receiving a cool-down request with Only When Loaded selected, the 
unit will enter a cool-down cycle only if a load is currently applied. With Always selected, the unit will enter 
a cool-down cycle upon request with or without a load applied. 
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No Load Cool-Down Time: This setting establishes the duration of the cool-down cycle after load has 
been removed. 

Smart Cool-down Function 

The smart cool-down function reduces unnecessary fuel expenditure by considering overall cool-down 
time through multiple requests. For example, a new cool-down request is initiated after a previous cool-
down sequence has already started. The cool-down timer is not simply reset with each new request. 
Instead, the amount of time that the engine has spent cooling down is factored into the new request. This 
saves time and fuel by running the engine no longer than necessary to achieve proper cool down. 

 
Figure 5-4. Settings Explorer, System Parameters, Crank Settings Screen 

Automatic Restart 

When enabled, the Automatic Restart clears all alarms automatically if the DGC-2020ES shuts down due 
to an alarm condition. An attempt to restart the engine is made, after a predetermined time delay, if the 
ATS contact input is closed. If an ATS contact is not present, the unit remains in the READY state with 
alarms cleared. A restart is not attempted if a low fuel alarm or emergency stop is present. The number of 
restart attempts is programmable. Automatic restart attempts are recorded in the event log. 

The Auto Restart Interval setting accepts values from 0.5 to 30, in increments of 0.5 minutes. The Auto 
Restart Attempts setting accepts values from 1 to 10, in increments of 1. 

The Automatic Restart screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Automatic 
Restart. 

The BESTCOMSPlus Automatic Restart screen is illustrated in Figure 5-5. 
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Figure 5-5. Settings Explorer, System Parameters, Automatic Restart Screen 

Exercise Timer 

The exercise timer function starts and runs the genset at specified intervals. Exercise timer settings are 
described in the following paragraphs. 

Modes 
The Mode setting determines how often the generator is exercised. Each mode has supporting settings 
that establish the start time, date, and duration of each session. When a mode is selected, only the 
appropriate supporting settings for that mode are available while other settings are grayed out. Start 
Hour, Start Minute, Run Period Hours, Run Period Minutes, and Run with Load settings are available for 
all modes. The exercise timer modes are described below. 
Daily: The generator will run every day. 

Monthly: The generator will run on the same day every month using the numeric date. For example, the 
fifth of every month. See Start Day of Month under Supporting Settings below. 

N Week Intervals: On or after the specified start date, the generator will run on the same day every N 
weeks, where N is a value from 1 through 52. For example, every two weeks on Sundays, starting on 
January 1, 2020. See Start Day of Week, Week Interval, and Begin Date (Month, Day, Year) under 
Supporting Settings below. 

Weekday of Month: The generator will run on the same day of the week every month. For example, the 
third Tuesday of every month. See Start Day of Week and Week of Month under Supporting Settings 
below. 

Weekly: The generator will run on the same day every week. See Start Day of Week under Supporting 
Settings below. 

Supporting Settings 
Begin Date (Month, Day, Year): These three settings establish the date on which the exercise timer will 
start when Mode is set to N Week Intervals. 
Start Day of Month: Accepts values 1 through 31. Enabled when Mode is set to Monthly. 
Start Day of Week: Select Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, or Saturday. 
Enabled when Mode is set to Weekly, Weekday of Month, or N Week Intervals. 

Start Time and Run Period: The generator will start at the time established by the Start Hour and Start 
Minute settings and will run for the duration established by the Run Period Hours and Run Period Minutes 
settings. These settings are available for all modes. 

Run with Load: When enabled, the DGC-2020ES closes the generator breaker during the run time. 

Week Interval: Accepts values 1 through 52. Enabled when Mode is set to N Week Intervals. 

Week of Month: Select First, Second, Third, Fourth, or Last. Enabled when Mode is set to Weekday of 
Month. 
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Contact inputs and outputs can be assigned to this function. Refer to the BESTlogicPlus chapter for more 
information. 

The Exercise Timer screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Exercise 
Timer. 

The BESTCOMSPlus Exercise Timer screen is illustrated in Figure 5-6. 

 
Figure 5-6. Settings Explorer, System Parameters, Exercise Timer Screen 

Sensing Transformers 

Three sets of transformer settings configure the DGC-2020ES for operation with a specific system. These 
settings, along with the generator voltage, generator current, and bus voltage detected by the DGC-
2020ES, enable it to accurately meter system values and offer generator protection. 

The Sensing Transformers screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Sensing 
Transformers. 

When adjusting these settings using BESTCOMSPlus, click the Rated Data button. See Rated Data, 
above, for more information. 

Generator PT 
The generator PT settings establish the nominal primary (generator side) and secondary (DGC-2020ES 
side) voltage levels at the generator voltage-sensing transformer. The Generator PT Primary setting 
accepts values from 1 to 999,999, in increments of 1. The Generator PT Secondary setting accepts 
values from 1 to 480, in increments of 1. 

Bus PT 
Primary and secondary bus transformer ratings are used by the optional automatic transfer switch 
function. This function monitors a three-phase bus input to detect mains failure. The primary setting 
establishes the nominal voltage present at phases A, B, and, C of the bus. This setting accepts values 
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from 1 to 99,999, in increments of 1. The secondary setting establishes the nominal voltage detected at 
the bus voltage input of the DGC-2020ES. This setting accepts values from 1 to 480, in increments of 1. 

Generator CT 
The generator CT setting establishes the nominal, primary (generator side) current level at the generator 
current sensing transformer. This setting accepts values from 1 to 9,999, in increments of 1. The 
secondary value of the generator CT is dictated by the style number of the controller. A DGC-2020ES 
with a style number of 1xx uses a nominal CT secondary rating of 1 Aac. A DGC-2020ES with a style 
number of 5xx uses a nominal CT secondary rating of 5 Aac. 

The Gen CT Low Line Scale Factor setting is used to automatically adjust the Gen CT Primary Amps 
setting in applications that may utilize more than one type of genset connection. This setting accepts a 
value from 0.001 to 3, in increments of 0.001. The scale factor setting is implemented when the DGC-
2020ES senses a contact closure at a contact input programmed to activate scaling of the settings. The 
value of the scale factor setting serves as a multiplier for the Gen CT Primary Amps setting. For example, 
if a scale factor contact input is received by the DGC-2020ES and the scale factor setting is 2.000, the 
Gen CT Primary Amps setting is doubled (2.000 x Gen CT Primary Amps). 

Relay Control 

The default operational setting for the Start, Run, and Pre-start relays is Predefined or standard. Any of 
these relays can be logic driven by selecting the Programmable setting. Logic driven (programmable 
relays must be set up using BESTlogicPlus. 

The Relay Control screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Relay Control. 

The BESTCOMSPlus Relay Control screen is illustrated in Figure 5-7. 

 
Figure 5-7. Settings Explorer, System Parameters, Relay Control Screen 

System Configuration Detection 

When enabled, this feature allows the DGC-2020ES to automatically detect its sensing configuration in 
relation to the generator. Upon starting the genset, the configuration of the generator is automatically 
detected. The Single Phase Override and Low Line Override programmable function settings are then 
adjusted accordingly. 

There is a one-second delay in the detection to prevent the DGC-2020ES from alternating between 
detected configurations. When the DGC-2020ES is in the Off mode or the engine is not running, the 
Automatic Configuration Detection function is disabled. The DGC-2020ES is assumed to be in the last 
valid automatically detected configuration. 

It is recommended that the Single Phase Override and Low Line Override programmable functions are 
not assigned to contact inputs when Automatic Configuration Detection is enabled. 

Single Phase Detect Threshold 
If the difference between the maximum and minimum line-to-line voltage exceeds this threshold, the unit 
is determined to be in single-phase configuration. If determined to be in single-phase configuration, the 
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Single Phase Override programmable function forces the DGC-2020ES into single-phase mode. The 
single-phase mode connection is determined by the Single Phase Detect Generator Connection, below. 

If the Single Phase Override function is assigned to a contact output, the state of the contact output and 
the detected configuration are ORed. This means, if one or both are true, then the system is determined 
to be configured for single phase. 

Low Line Detect Threshold 
If the average of the valid line-to-line voltages for the detected configuration is above this threshold, the 
unit is determined to be in a high-line configuration. If the average is below this threshold, it is determined 
to be in a low-line configuration. If determined to be in low-line configuration, the Low-Line Override 
function forces the DGC-2020ES into the low-line configuration. 

If the Low-Line Override function is assigned to a contact output, the state of the contact output and the 
detected configuration are ORed. This means, if one or both are true, then the system is determined to be 
configured for low-line. 

Single Phase Detect Generator Connection 
This setting specifies which single-phase connection to use when the system is determined to be single-
phase. Single-phase AB or Single-phase AC can be selected. 

The Auto Config Detection screen is found in the BESTCOMSPlus Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Auto Config 
Detect. The BESTCOMSPlus Auto Config Detection screen is illustrated in Figure 5-8. 

 
Figure 5-8. Settings Explorer, System Parameters, Auto Config Detection Screen 
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6 • Timekeeping 
The DGC-2020ES provides a real-time clock with capacitor backup that is capable of operating the clock 
for up to 24 hours after power is removed from the controller. As the capacitor nears depletion, an internal 
backup battery takes over and maintains timekeeping. The battery will maintain the clock for 
approximately ten years depending on conditions. The battery is not replaceable. 

The clock is used by the events recorder function to time-stamp events and the exercise timer to start and 
stop the genset when the exercise feature is utilized. 

Clock Setup 

Clock settings are made through the communication ports using BESTCOMSPlus® or through the front-
panel interface. Write access to ports is required to program the clock. An alarm is provided to detect 
when the DGC-2020ES has powered up and the clock has not been set. 

The clock settings are made through BESTCOMSPlus by selecting Clock Setup under General Settings. 
If using the front panel, navigate to Settings > General Settings > Configure Date/Time. 

The BESTCOMSPlus Clock Setup screen is illustrated in Figure 6-1. Settings are listed in Table 6-1. 

The local time zone is configured on this screen. The Time Zone Offset is the local offset to UTC 
(Coordinated Universal Time). The Time Zone Offset is required when the Start/End Time Reference is 
set to UTC (Coordinated Universal Time). The Start/End Time Reference is set to UTC time if required by 
local daylight savings time rules. The Start/End Hour/Minute settings determine the time when the DST 
will go into effect. The Bias setting is the amount of time that the clock moves forward or backward. The 
user is notified when the clock is not set when the Clock Not Set Warning is enabled. 

 
Figure 6-1. Settings Explorer, General Settings, Clock Setup Screen 
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Table 6-1. Settings for Clock 

Setting Range Increment Unit Default 
UTC Offset –1,440 to 1,440 1 minutes –6 

DST Configuration Floating Dates or Fixed Dates n/a n/a Disabled 
Start/End Time 

Reference 
Respective to Local Time or 

Respective to UTC Time n/a n/a Respective to 
Local Time 

Bias Setup (Hour) –12 to 12 1 hours Disabled 
Bias Setup (Minute) –59 to 59 1 minutes 0 

Clock Not Set 
Warning Disable or Enable n/a n/a Disable 

Setting the Time and Date 

Time and date settings are made through BESTCOMSPlus on the Real Time Clock screen (Figure 6-2) of 
the Metering Explorer. Settings can also be made through the front panel. 

 
Figure 6-2. Metering Explorer, Real Time Clock Screen 
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7 • Engine Sender Inputs 
The DGC-2020ES has sender inputs dedicated to monitoring the engine fuel level, oil pressure, and 
coolant temperature. These inputs are programmable to give the user flexibility in selecting the sender to 
be used in an application. Information about programming sender inputs is provided later in this chapter. 

Compatible Senders 

Oil pressure senders that are compatible with the DGC-2020ES include Datcon model 02505-00, Isspro 
model R8919, Stewart-Warner models 279BF, 279C, 411K and 411M, and VDO models 360025 and 
360811. Compatible Fuel Level senders include the Isspro model R8925. Compatible Coolant 
Temperature senders include Datcon model 02019-00, Faria model TS4042, Isspro model, R8959, and 
Stewart-Warner model 334P. Other senders may also be used. 

Operation 

A current is provided to each sender. The developed voltage is measured and scaled for use by the 
internal circuitry. An open circuit or short circuit across the sender terminals will cause the DGC-2020ES 
to indicate a failed sender. 

Sender Programmability 

BESTCOMSPlus® software allows for the programming of sender characteristics. See Sender 
Characteristic Curves for more information. 

Sender Characteristic Curves 

The sender inputs of the DGC-2020ES can be customized to obtain maximum accuracy from the coolant 
temperature, oil pressure, and fuel level senders. 

The characteristic curve of each sender input can be configured with up to 11 points. Each point can be 
assigned a resistance input value and a corresponding temperature (coolant temperature sender), 
pressure (oil pressure sender), or percentage (fuel level sender) value. A sender slope setting 
automatically orders the values in the resistance column according to whether the sender requires a 
negative or positive slope. Sender curve points are automatically plotted on a curve in BESTCOMSPlus, 
which can be printed. 

Sender curve points configured in BESTCOMSPlus can be saved in the configuration file. The data for all 
three senders is automatically saved with the DGC-2020ES configuration file. 

Any changes made in BESTCOMSPlus to the sender points, can be reverted to the factory-default 
values. A new settings file can also be created. 

Curve Configuration 
If the DGC-2020ES receives engine information from an ECU, the programmable sender parameters for 
coolant temperature and oil pressure do not require configuration because they have no effect. 
Configuration of sender parameters is appropriate for resistive senders only. 

Fuel Level 

Figure 7-1 illustrates the Fuel Level screen found in the BESTCOMSPlus Settings Explorer under the 
Programmable Senders category. To program the fuel level sender, perform the following procedure: 

1. The percent fuel level sender is configured by selecting one of the sender types that come as a part 
of the BESTCOMSPlus sender library. Click on Load Fuel Settings File and select the appropriate 
sender. 
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2. If no sender file matches the sender being used, the individual points that map resistance points to 
fuel level may be modified by setting numeric values in the table, or dragging the points of the graph 
to the desired characteristic. Information on sender characteristics should be obtained from the 
sender manufacturer. 

3. Select Positive or Negative sender slope as required for the desired sender graph. 

4. Click Save Fuel Data to save the data in the current settings file. 

5. If you want to save newly entered sender data as a sender library file, click Create Fuel Settings File 
and enter a file name and location to save the file. 

6. Click the Send Settings button in BESTCOMSPlus to send the sender settings to the DGC-2020ES. 

 
Figure 7-1. Settings Explorer, Programmable Senders, Fuel Level Screen 

Oil Pressure 

Figure 7-2 illustrates the Oil Pressure screen found in the BESTCOMSPlus Settings Explorer under the 
Programmable Senders category. To program the oil pressure sender, perform the following procedure: 

1. The oil pressure sender can be configured by selecting one of the sender types that come as a part of 
the BESTCOMSPlus sender library. Click on Load Oil Settings File and select the appropriate sender. 

2. If no sender file matches the sender being used, the individual points that map resistance points to oil 
pressure may be modified by setting numeric values in the table, or dragging the points of the graph 
to the desired characteristic. Information on sender characteristics should be obtained from the 
sender manufacturer. 

3. Select Positive or Negative sender slope as required for the desired sender graph. 

4. Click Save Oil Data to save the data in the current settings file. 
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5. If you want to save newly entered sender data as a sender library file, click Create Oil Settings File 
and enter a file name and location to save the file. 

6. Click the Send Settings button in BESTCOMSPlus to send the sender settings to the DGC-2020ES. 

 
Figure 7-2. Settings Explorer, Programmable Senders, Oil Pressure Screen 

Coolant Temperature 

Figure 7-3 illustrates the Coolant Temperature screen found in the BESTCOMSPlus Settings Explorer 
under the Programmable Senders category. To program the fuel level sender, perform the following 
procedure: 

1. The coolant temperature sender can be configured by selecting one of the sender types that come as 
a part of the BESTCOMSPlus sender library. Click on Load Cool Settings File and select the 
appropriate sender. 

2. If no sender file matches the sender being used, the individual points that map resistance points to 
coolant temperature may be modified by setting numeric values in the table, or by dragging the points 
of the graph to the desired characteristic. Information on sender characteristics should be obtained 
from the sender manufacturer. 

3. Select Positive or Negative sender slope as required for the desired sender graph. 

4. Click Save Cool Data to save the data in the current settings file. 

5. If you want to save newly entered sender data as a sender library file, click Create Cool Settings File 
and enter a file name and location to save the file. 

6. Click the Send Settings button in BESTCOMSPlus to send the sender settings to the DGC-2020ES. 
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Figure 7-3. Settings Explorer, Programmable Senders, Coolant Temperature Screen 

Sender Failure Detection 

The DGC-2020ES can be configured to annunciate a pre-alarm or alarm when a loss of signal is detected 
at the coolant temperature, oil pressure, or fuel level sender input. Contact recognition can be set to 
Always or While Engine Running Only. Minimum and Maximum resistance values can be set. When the 
SF Display setting is set to Enable, “SF” is displayed instead of the measured parameter when the 
resistance value is outside the range specified by the Minimum and Maximum Resistance values. A loss 
of generator sensing voltage (when the DGC-2020ES is operating in Run or Auto mode with the ATS 
closed) can also be configured to trigger a pre-alarm or alarm. The speed sender fail alarm is always 
enabled. A user-adjustable time delay is provided for each sender/sensing alarm/pre-alarm. 

Alarm and pre-alarm annunciations for loss of engine speed signals are not user-programmable and 
operate as follows. If the MPU (magnetic pickup) or generator frequency is programmed as the sole 
engine speed source and that signal source fails, an alarm (and shutdown) is triggered. If the engine 
speed source is configured as MPU and generator frequency and a loss of one of the signal sources 
occurs, a pre-alarm is annunciated. An alarm (and shutdown) is triggered if both speed signals are lost. 

The BESTCOMSPlus Sender Fail screen is illustrated in Figure 7-4 and is found in the Settings Explorer 
under Alarm Configuration. If using the front panel, navigate to Settings > Alarm Configuration > Sender 
Fail. 

Voltage Sensing Fail 
The voltage sensing fail function monitors the generator line-to-neutral voltages. If any of the line-to-
neutral voltages decreases below 2% of the CT secondary voltage for the duration of the Activation 
Delay, the DGC-2020ES detects a Voltage Sensing Fail condition and annunciates an alarm based on 
the Alarm Configuration setting. 
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In a Grounded Delta configuration where one phase (A, B, or C) of the delta connection is grounded, it is 
likely a Voltage Sensing Fail condition will occur. 

In Delta connected systems where the DGC-2020ES neutral input is not connected, it is uncertain which 
line-to-neutral voltages will be monitored by the DGC-2020ES. Spurious Voltage Sensing Fail 
annunciations could occur. 

It is recommended that Phase Imbalance detection be used to detect sensing issues in Delta and 
Grounded Delta configurations. 

 
Figure 7-4. Settings Explorer, Alarm Configuration, Sender Fail Screen   
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8 • Contact Inputs 
Contact inputs are available to initiate DGC-2020ES actions. The DGC-2020ES has seven programmable 
contact sensing inputs. Additional contact inputs can be accommodated with an optional CEM-2020 
(Contact Expansion Module). Contact Basler Electric for availability and ordering information. 

Each programmable input (Input 1 through Input 7) can be independently configured to perform the 
following functions. By default, each programmable input is disabled. 

• Auto Transfer Switch 
• Battery Charger Fail 
• Battle Override 
• Emergency Stop 
• Fuel Leak Detect 
• Grounded Delta Override 
• Low Coolant Level 
• Low Fuel Level 
• Low Line Override 
• Single-Phase Override 

The programmable inputs accept dry contacts. A contact is connected between a programmable input 
and the negative side of the battery. Through BESTCOMSPlus®, each programmable contact input can 
be assigned a name (16 alphanumeric characters, maximum) and configured as an alarm input, a pre-
alarm input, or none. The default names for the inputs are INPUT_x (where x = 1 to 7). When a 
programmable contact input is closed, the front panel display shows the name of the closed input if it was 
programmed as an alarm or pre-alarm input. Alarm inputs are annunciated through the Normal display 
mode screens of the front panel. Pre-alarm inputs are annunciated through the pre-alarm metering screen 
of the front panel. If neither alarm nor pre-alarm is programmed, no indication is given. Programming an 
input as None is useful when a programmable input is used as an input to programmable logic. 

Connections for the programmable inputs are provided at terminals 3 (Input 1) through 9 (Input 7). The 
negative side of the battery voltage (terminal 17) serves as the return connection for the programmable 
inputs. 

Contact Input Configuration 

Figure 8-1 illustrates the Contact Inputs screen found in the BESTCOMSPlus Settings Explorer under the 
Programmable Inputs category. If using the front panel, navigate to Settings > Programmable Inputs > 
Configurable Inputs. 

For each contact input, configure the following parameters: 

1. Alarm Configuration - Select None, Alarm, or Pre-Alarm. When an alarm occurs, the horn output 
closes and the engine shuts down. When a pre-alarm occurs, the horn output toggles between open 
and closed while the engine remains running. If None is selected, the input is status only. The status 
is available to BESTlogic™Plus Programmable Logic regardless of Alarm Configuration setting. 

2. Activation Delay - This parameter defines the duration that the input remains on before any 
annunciation occurs. 

3. Label Text - Enter descriptive text that signifies the use of the input. This text appears next to the 
input in BESTlogic™Plus Programmable Logic and in the event log if the input is configured as an 
alarm or pre-alarm. 

4. Contact Recognition - Select whether the contact input should be recognized always, or only while 
the engine is running. For example, a switch closes when oil pressure is low. Such a switch would be 
closed when the engine is not running but a low oil pressure alarm or pre-alarm should not be 
annunciated unless the switch is closed while the engine is running. A selection of While Engine 
Running Only prevents spurious annunciation when the engine is not running. 
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Figure 8-1. Settings Explorer, Programmable Inputs, Contact Inputs Screen 

Programmable Functions 

Any of the seven contact inputs can be programmed to recognize any one of 10 function types: 
• Automatic Transfer Switch (ATS) - Start and run the generator while the ATS input is true and the 

DGC-2020ES is in Auto mode. When Input Mode is set to Complementary, a Normally Open 
Input and a Normally Closed Input must be selected. While the Normally Open Input is closed, 
the Normally Closed Input is open, and the DGC-2020ES is in Auto mode, the ATS function starts 
and runs the generator. If the Normally Open Input and the Normally Closed Inputs are not in 
opposite states for the duration of the Circuit Error Delay, an ATS Circuit Error Pre-alarm will 
occur. The Circuit Error Action setting dictates whether the generator should start or not start 
when an ATS Circuit Error Occurs. 

• Grounded Delta Override - Uses Grounded Delta sensing if the generator connection is set for 
Delta. 

• Battle Override - The alarms programmed to shut down the unit will be overridden and ignored. 
When a Battle Override condition is true the DGC annunciates a Battle Override Pre-alarm that is 
recorded in the event log. If an alarm occurs while a Battle Override condition is true, the alarm 
annunciates on the DGC front panel and is recorded in the event log, but the engine will not stop. 
The DGC-2020ES monitors engine rpm during battle override. If the engine rpm drops to zero 
while an alarm is active during a Battle Override condition, the DGC-2020ES proceeds to issue a 
normal shutdown to prevent fuel flow while the engine is not running. The Emergency Stop Alarm 
has priority over Battle Override. The engine will stop if the Emergency Stop is activated 
regardless of Battle Override status. 

• The DGC monitors engine RPM during battle override.  If the engine RPM drops to zero while an 
alarm is active during a Battle Override condition, the DGC will proceed to issue a normal 
shutdown to prevent fuel flow while the engine is not running. 

• Low-Line Override - The 51, 27, and 59 settings are scaled by the low-line scale factor setting. 
• Single-Phase Override - The unit switches to single-phase sensing configuration and uses the 1 

Phase Override Sensing setting (A-B or A-C). 
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• Emergency Stop – When an input is assigned to the Emergency Stop Programmable Function, 
the input functions in a normally-closed manner. When the input is closed, no alarm is 
annunciated. When the input is open, the DGC-2020ES will open the Start, Run, and Prestart 
relays and annunciate an Emergency Stop Alarm. 
Once an input is assigned to this programmable input, navigate to Settings Explorer > 
Programmable Inputs > Contact Inputs and configure the following settings: 

° Alarm Configuration: Status Only 
° Activation Delay: 0 
° Label Text: Any text is acceptable. 
° Contact Recognition: Always 

• Battery Charger Fail - When the selected input is invoked, a user selectable pre-alarm or alarm is 
annunciated after the activation delay. 

• Low Coolant Level - When the selected input is invoked, a Low Coolant Level pre-alarm or alarm 
is annunciated after the activation delay. 

• Low Fuel Level - When the selected input is invoked, a Low Fuel Level pre-alarm or alarm is 
annunciated after the activation delay. 

• Fuel Leak Detect - When the selected input is invoked, a Fuel Leak pre-alarm or alarm is 
annunciated after the activation delay. 

An Alarm Configuration setting of “None” prevents a function from being triggered by a contact input. 
Programmable function status is available in BESTlogic™Plus Programmable Logic when the “None” 
alarm configuration setting is selected. 

The Programmable Functions screen is found in the BESTCOMSPlus Settings Explorer under the 
Programmable Inputs category. If using the front panel, navigate to Settings > Programmable Inputs > 
Programmable Functions. 

The BESTCOMSPlus Programmable Functions screen is illustrated in Figure 8-2. 

 
Figure 8-2. Settings Explorer, Programmable Inputs, Programmable Functions   
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9 • Contact Outputs 
Output contact operation is controlled by the operating mode of the DGC-2020ES. The state of the 
Emergency Stop contact input also affects output contact operation. When the Emergency Stop contact 
input is open (emergency stop condition), the PRESTART, START, and RUN outputs open and an 
emergency stop alarm is annunciated. When the Emergency Stop input is closed, all output contacts 
operate normally. 

DGC-2020ES output contacts include PRESTART, START, RUN, and four programmable outputs. 
Additional output contacts can be accommodated with an optional CEM-2020 (Contact Expansion 
Module). 

Prestart 

This output closes to energize the engine glow plugs or run pre-lubrication pumps. The PRESTART 
output can be programmed to close up to 30 seconds prior to engine cranking. The PRESTART output 
can also be programmed to open upon engine startup or remain closed as long as the engine is 
operating. 

During the resting state, the PRESTART output can be set to Off, On, or Preheat Before Crank. If Preheat 
Before Crank is selected, the PRESTART output will be closed for a time equal to the Pre-crank delay 
time prior to re-entering the cranking state. If the Pre-crank delay setting is longer than the rest interval, 
the PRESTART output will be closed for the entire rest time. 

PRESTART output connections are made through terminals located on the PRESTART relay. 

Start 

This output closes when engine cranking is initiated by the DGC-2020ES and opens when the magnetic 
pickup (MPU) or generator frequency indicates that the engine has started. Prior to engine starting, the 
duration of cranking is determined by the cranking style (cycle or continuous) selected. Cycle cranking 
permits up to seven crank cycles with crank cycle duration of 5 to 15 seconds. The continuous crank time 
is adjustable from 5 to 60 seconds. 

START output connections are made through terminals located on the START relay. 

Run 

This output closes when engine cranking is initiated by the DGC-2020ES. The RUN output remains 
closed until it receives a command to stop the engine. 

RUN output connections are made through terminals located on the RUN relay. 

Relay Control 

In some applications, it may be beneficial to modify the standard operation of the DGC-2020ES Run, Pre-
Start, or Start relays. If desired, these relays can be configured to operate outside their predefined 
functionality. For example, if your genset does not require starting assistance from glow plugs, the Pre-
Start relay may be assigned for another purpose. Configuring these relays as programmable makes them 
available in BESTlogic™Plus programmable logic to be used in the same manner as the other 
programmable relay outputs. Predefined or programmable operation of the Run, Pre-Start, and Start 
relays is selected on the Relay Control screen (Figure 9-1). See the BESTlogicPlus chapter for more 
information about DGC-2020ES programmable logic. 
The Relay Control screen is found in the BESTCOMSPlus® Settings Explorer under the System 
Parameters category. If using the front panel, navigate to Settings > System Parameters > Relay Control. 
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Figure 9-1. Settings Explorer, System Parameters, Relay Control Screen 

For each relay (Start, Run, and Pre-Start), select whether it should use its predefined functionality or be 
made programmable. 

When Programmable is selected for a relay, it becomes available to BESTlogicPlus Programmable Logic 
as a logic element. The elements are titled Start Output, Prestart Out, and Run Output. The predefined 
functionality is available as an input to the logic. If Programmable is selected as the relay control mode, 
connecting the corresponding predefined input function to the relay causes it to function as if Predefined 
were selected as its relay control type. However, other logic can be combined with it to create operation 
that is more versatile. If Programmable is selected for a relay, but it is not used in the logic, that relay will 
never close. 

An example logic scheme connecting the predefined inputs directly to the “programmable” relay outputs 
for all three relays is shown in Figure 9-2. 

 
Figure 9-2. Example Logic Scheme of Programmable Relays 

Programmable 

DGC-2020ES controllers have four programmable output contacts (OUT 1 through 4). An additional 24 
contact outputs are provided with an optional CEM-2020 (Contact Expansion Module). An optional CEM-
2020H (Contact Expansion Module - High Current) provides 18 contact outputs. 

Programmable Output Configuration 
Figure 9-3 illustrates the Contact Outputs screen found in the BESTCOMSPlus Settings Explorer under 
the Programmable Outputs category. If using the front panel, navigate to Settings > Programmable 
Outputs > Contact Outputs. 

Each output can be programmed with a text label describing its use. This label appears in BESTlogicPlus 
Programmable Logic where the output is used to aid in program clarity and ease of programming. 
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Figure 9-3. Settings Explorer, Programmable Outputs, Contact Outputs 

Configurable Elements 
Configurable elements are connected to the logic scheme as outputs. The configurable elements are 
incorporated into a BESTlogicPlus programmable logic scheme by selecting them from the Elements 
group in BESTlogicPlus. For more details, refer to the BESTlogicPlus chapter. Each of the eight elements 
can be independently configured to annunciate an alarm or pre-alarm. A user-adjustable time delay can 
be set to delay recognition of an element. By default, all elements are configured so that they do not 
trigger an alarm or pre-alarm. To make identifying an element easier, each of the elements can be given 
a user-assigned name. If used for an alarm or pre-alarm, the user-assigned name appears in the alarm or 
pre-alarm annunciation and in the DGC-2020ES event log. Elements can be recognized always or only 
while the engine is running. A user-adjustable arming delay disables the configurable element during 
engine startup. If the arming delay is set to zero, the configurable element is active at all times, including 
when the engine is not running. If the arming delay is set to a non-zero value, the configurable element is 
inactive when the engine is not running, and does not become active until after the engine is started and 
the arming delay has elapsed. Configurable element status is available in BESTlogicPlus Programmable 
Logic when “None” is selected for Alarm Configuration. Configurable element status can be used as logic 
inputs to drive other logic in the program, similar to logic control relays.  

The BESTCOMSPlus Configurable Elements screen is illustrated in Figure 9-4 and found in the Settings 
Explorer under the Programmable Outputs category. If using the front panel, navigate to Settings > 
Programmable Outputs > Configurable Elements. 
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Figure 9-4. Settings Explorer, Programmable Outputs, Configurable Elements 
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10 • Breaker Management 
The DGC-2020ES is capable of controlling the generator breaker and the mains breaker. Once it is 
determined that a valid breaker request is available, the DGC-2020ES will attempt to operate the breaker 
if possible. The user can choose to control only the generator breaker, the generator and mains breakers, 
or none. BESTCOMSPlus® is used to configure breaker management. Refer to the BESTCOMSPlus 
chapter for setting information. 

Breaker Status 

The status of the breakers is determined by using BESTlogic™Plus programmable logic and sent to the 
GENBRK and MAINSBRK logic blocks. These logic blocks have outputs that can be configured to 
energize an output contact and control a breaker as well as inputs for breaker control and status. See 
Breaker Configuration, below, for details on configuring the logic. 

Breaker Operation 

The DGC-2020ES will attempt to close a breaker only after verifying that it can be closed. If the breaker 
cannot be closed, the close request will be ignored. Only one breaker can be closed at a time. Closure to 
a dead bus can be performed after meeting dead bus threshold and timing requirements set by the user. 

Breaker Operation Requests 
Types of breaker operation requests include: 
• Local Request - initiated by internal functions and based on operating modes. 
• Com Request - initiated through a communication port using BESTCOMSPlus or the front panel. 
• Logic Request - initiated from BESTlogicPlus. 

The type of response given for a local request depends on the operating mode of the DGC-2020ES. 

RUN Mode 

When in RUN mode, the generator and mains breakers can be closed manually using contact inputs or 
the breaker operation settings on the BESTCOMSPlus Control screen. 

OFF or AUTO Mode (Not Running) 

If operating in the OFF mode or AUTO and not running, the generator breaker can be closed if the bus is 
determined to be dead. 

AUTO Mode (Running) 

When in AUTO mode and running, the mains fail transfer feature will automatically control the mains 
breaker and the generator breaker. Or, the external ATS (automatic transfer switch) will start the 
generator and control the breakers itself. In addition, the generator breaker can be automatically 
controlled by the exercise timer function or a RUNWLOAD (run with load) start through BESTlogicPlus. 
The generator breaker can be manually controlled using contact inputs and outputs or the breaker 
operation settings on the BESTCOMSPlus Control screen. 

Breaker Closure Conditions 
The conditions under which the DGC-2020ES will close a breaker are described in the following 
paragraphs. 

Breaker Status and Voltage Stability 

Before the generator breaker can be closed, it must be configured in BESTCOMSPlus. If only the 
generator breaker is configured (mains breaker not configured) the DGC-2020ES reads user settings to 
determine if the generator side of the breaker is stable or dead and the bus side is dead. If both the 
generator and the mains breakers are configured and open, the DGC-2020ES closes the generator 
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breaker if the generator side of the breaker is stable or dead. If both breakers are configured and the 
mains breaker is closed, the DGC-2020ES will not close the generator breaker. 

Before the mains breaker can be closed, it must be configured in BESTCOMSPlus. If both the mains and 
the generator breakers are configured and open, the DGC-2020ES will close the mains breaker if the 
mains side of the breaker is stable. If both breakers are configured and the generator breaker is closed, 
the DGC-2020ES will not close the mains breaker. 

Command Agreement 

A breaker will not change state if it receives conflicting commands. In other words, if an input is indicating 
an open command at the same time another input is indicating a close command, the breaker will not 
change state. 

Breaker Configuration 

The following paragraphs describe how to properly configure a DGC-2020ES for generator breaker 
control. 

Initial System Setup 
Connect the DGC-2020ES according to the appropriate figure in the Typical Connections chapter in the 
Installation manual for the type of generator connection desired (wye, delta, etc.). Set up the basic system 
parameters that will govern engine operation and alarm and pre-alarm annunciation. Details can be found 
in the Device Configuration and Alarm Configuration chapters. 

Breaker Hardware 
Configure the generator breaker parameters on the BESTCOMSPlus Settings Explorer, Breaker 
Management, Breaker Hardware screen. If using the front panel, navigate to Settings > Breaker 
Management > Breaker Hardware. Figure 10-1 illustrates the BESTCOMSPlus Breaker Hardware screen. 

1. Mains Fail: When two breakers are configured (enabled), the DGC-2020ES can be enabled to 
automatically transfer load power from the mains to the genset during a mains failure. This feature 
also enables the DGC-2020ES to transfer the load back to the mains once mains power is restored. 
Settings include a transfer delay, return delay, max transfer time, and max return time. 

a. When enabled, Reverse Rotation Inhibit prevents automatic load transfer due to a mains 
failure when the machine is determined to have reverse phase rotation. 

b. If the in-phase monitor is enabled and the Mains Fail Return Delay time has expired, the 
generator waits until it detects that the phases are aligned between the generator and the 
mains before performing the open transition from the generator back to the utility. 

2. Breaker Close Wait Time: This is a time interval in which it is expected that the breaker will transition 
from open to closed or closed to open. If the generator breaker does not change state within that 
time, either a Gen Breaker Close Fail alarm or Gen Breaker Open Fail alarm is annunciated. If the 
mains breaker does not change state within that time, either a Mains Breaker Close Fail alarm or 
Mains Breaker Open Fail alarm is annunciated. 

3. Generator Breaker 

a. Set the Contact Type and Open/Close Pulse Times if pulsed contacts are used. 

b. Set the Breaker Closing Time. 

4. Mains Breaker 

a. Set the Mains Breaker as Configured if it is used, otherwise do not configure these settings. 

b. If the mains breaker is configured, set the contact type and pulse times if pulsed contacts are 
used. 

c. If the mains breaker is configured, set the breaker close time. 
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Figure 10-1. Settings Explorer, Breaker Management, Breaker Hardware Screen 

Breaker Setup in BESTlogic™Plus 
Set up the Gen Breaker in BESTlogicPlus Programmable Logic under the BESTCOMSPlus Settings 
Explorer, BESTlogicPlus Programmable Logic screen. BESTlogicPlus is not available through the front 
panel interface. Figure 10-2 illustrates the Gen breaker logic scheme in BESTlogicPlus. 
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Figure 10-2. Settings Explorer, BESTlogicPlus Programmable Logic Screen 

1. Generator Breaker 

a. Drag the Gen Breaker element into the logic diagram. 

b. Connect the breaker element open and close outputs to the contact outputs that will drive the 
breaker. 

c. Connect the physical input or remote input that has the breaker status (closed if breaker is 
closed, open when the breaker is open) to the Status input of the breaker element. This is the 
only way to indicate breaker status to the DGC-2020ES. 

d. If it is desired to have physical inputs that can request breaker open and close commands, 
connect the desired inputs to the open and close command inputs of the breaker element. 
These inputs should be pulsed. If both inputs close at the same time, the breaker will not 
change state. If it is not desired to have inputs for breaker commands, connect a “Logic 0” 
input object to the open and close command inputs of the breaker block. 

2. Mains Breaker (if configured) 

a. Drag the Mains Breaker element into the logic diagram. 

b. Connect the breaker element open and close outputs to the contact outputs that will drive the 
breaker. 

c. Connect the physical input or remote input that has the breaker status (closed if breaker is 
closed, open if the breaker is open) to the Status input of the breaker element. This is the 
only way to indicate breaker status to the DGC-2020ES. 

d. If it is desired to have physical inputs that can request breaker open and close commands, 
connect the desired inputs to the open and close command inputs of the breaker element. 
These inputs should be pulsed. If both inputs close at the same time, the breaker will not 
change state. If it is not desired to have inputs for breaker commands, connect a “Logic 0” 
input object to the open and close command inputs of the breaker block. 

3. Click the Save button when the logic setup is complete. 

4. From the Communication pull-down menu, select Upload Logic to Device to load the logic into the 
DGC-2020ES if connected, or save the settings file if working off line. 
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Bus Condition Detection 
(These thresholds determine when the generator and bus are considered to be stable or dead.) 

Set the parameters for detecting stable and failed bus and generator under the BESTCOMSPlus Settings 
Explorer, Breaker Management, Bus Condition Detection. If using the front panel, navigate to Settings > 
Breaker Management > Bus Condition Detection. 

Figure 10-3 illustrates the BESTCOMSPlus Bus Condition Detection screen. 

1. Generator Sensing 

a. Dead Bus Voltage Threshold and Activation Delay. When the generator voltage is below 
this threshold for the duration of the activation delay, the generator is deemed “Dead”. 

b. Gen Stable Overvoltage and Undervoltage thresholds and Overfrequency and 
Underfrequency thresholds and the Bus Stable and Bus Failed Activation Delay times. 
When the generator voltage frequency is within the specified range for the duration of the 
Bus Stable Activation Delay, the generator is deemed “Stable”. Otherwise, it is deemed 
“Failed”. 

2. Bus Sensing 

a. Dead Bus Voltage Threshold and Activation Delay. When the voltage of the bus is below 
this threshold for the duration of the activation delay, the bus is deemed “Dead”. 

b. Bus Stable Overvoltage and Undervoltage thresholds and Overfrequency and 
Underfrequency thresholds and the Bus Stable and Bus Failed Activation Delay times. 
When the bus voltage and frequencies are within the specified ranges for the duration of 
the Bus Stable Activation Delay, the bus is deemed “Stable”. Otherwise, it is deemed 
“Failed”. 

 

Caution 

The bus condition parameters are critical because they determine 
when a breaker can be closed. The generator breaker can be closed 
when any one of the following is true: 

• The generator is stable, the bus is dead, and both breakers are 
open. 

• The generator is dead, the bus is dead, and both breakers are 
open. 

The mains breaker can be closed only when the bus is stable and both 
breakers are open. 

Place the unit in AUTO. The unit is now configured for generator breaker control. It can be tested by 
driving the RUN WITH LOAD logic element true, setting up the exercise timer for a loaded test, or by 
starting the unit in RUN or AUTO mode and giving it CLOSE and OPEN commands from the physical 
inputs if they are available for breaker control. 

Refer to the Troubleshooting chapter if the breaker does not seem to operate properly. 
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Figure 10-3. Settings Explorer, Breaker Management, Bus Condition Detection 
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11 • Alarm Configuration 
Configuration of DGC-2020ES alarms, pre-alarms, sender failure alarms, and the audible horn is 
described in the following paragraphs. 

Alarms 

To configure alarms using BESTCOMSPlus, open the Alarm screen (Figure 11-1). This screen is found in 
the Settings Explorer under the Alarm Configuration category. If using the front panel, navigate to 
Settings > Alarm Configuration > Alarms. 

 
Figure 11-1. Settings Explorer, Alarm Configuration, Alarms Screen 

The alarm settings are described below. 

High Coolant Temp 
High coolant temperature alarm settings consist of an enable/disable setting, a threshold setting, and an 
arming delay. If enabled, a high coolant temperature alarm is triggered after a four second delay when the 
engine coolant temperature exceeds the threshold setting. The arming delay disables the high coolant 
temperature alarm function for a user-adjustable period after engine startup. System units are configured 
on the System Settings screen. 

Low Oil Pressure 
Low oil pressure alarm settings consist of an enable/disable setting, a threshold setting, and an arming 
delay. If enabled, a low oil pressure alarm is triggered after a two second delay when the engine oil 
pressure decreases below the threshold setting. The arming delay disables the low oil pressure alarm 
function for a user-adjustable period after engine startup. System units and metric pressure units are 
configured on the System Settings screen. 
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Overspeed 
Overspeed alarm settings include an enable/disable setting, a threshold setting, and an activation delay. 
If enabled, an overspeed alarm occurs when the engine speed (in rpm) exceeds the threshold setting for 
the duration of the activation time delay. 

Low Fuel Level 
Low fuel level alarm settings consist of an enable/disable setting, a threshold setting, an activation delay 
setting, and a hysteresis setting. If enabled, a low fuel level alarm is triggered when the metered fuel level 
drops below the threshold setting for the duration of the activation time delay. The hysteresis setting 
functions as an alarm dropout by preventing rapid switching of the alarm annunciation. Once the Low 
Fuel Level alarm has activated, it will not turn off until the fuel is increased to a level equal to the 
threshold plus the hysteresis setting. 

Low Coolant Level 
Low coolant level alarm settings consist of an enable/disable setting and a threshold setting. If enabled, a 
low coolant level alarm is triggered when the metered coolant level drops below the threshold setting. 
ECU Support must be enabled on the Communications, CAN Bus, CAN Bus Setup screen before this 
alarm can be configured. 

CAN Bus Low Coolant Level 
When enabled, any Low Coolant Level indication received over the J1939 CAN Bus it treated as an 
alarm. When disabled, Low Coolant Level indications received over the J1939 CAN Bus are treated as 
pre-alarms. 

Pre-alarms 

To configure pre-alarms using BESTCOMSPlus, open the Pre-Alarms screen (Figure 11-2). This screen 
is found in the Settings Explorer under the Alarm Configuration category. If using the front panel, navigate 
to Settings > Alarm Configuration > Pre-alarms. 

The pre-alarm settings are described below. 

High Fuel Level 
High fuel level pre-alarm settings consist of an enable/disable setting, a threshold setting, an activation 
delay setting, and a hysteresis setting. If enabled, a high fuel level pre-alarm is triggered when the 
metered fuel level increases above the threshold setting for the duration of the activation delay. The 
hysteresis setting functions as a pre-alarm dropout by preventing rapid switching of the alarm 
annunciation. Once the High Fuel Level pre-alarm has activated, it will not turn off until the fuel is 
decreased to a level equal to the threshold minus the hysteresis setting. 

Low Fuel Level 
Low fuel level pre-alarm settings consist of an enable/disable setting, a threshold setting, and a hysteresis 
setting. If enabled, a low fuel level pre-alarm is triggered when the metered fuel level decreases below the 
threshold setting. The hysteresis setting functions as a pre-alarm dropout by preventing rapid switching of 
the alarm annunciation. Once the Low Fuel Level pre-alarm has activated, it will not turn off until the fuel 
is increased to a level equal to the threshold plus the hysteresis setting. 

Low Battery Voltage 
Low battery voltage pre-alarm settings consist of an enable/disable setting, a threshold setting, and an 
activation delay. If enabled, a low battery voltage pre-alarm is triggered when the battery voltage 
decreases below the threshold setting for the duration of the activation time delay. The threshold can be 
entered in actual volts or a per-unit value. The per-unit threshold value is based on the nominal battery 
voltage setting found on the System Parameters, Rated Data screen. 
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High Coolant Temp 
High coolant temperature pre-alarm settings consist of an enable/disable setting and a threshold setting. 
If enabled, a high coolant temperature pre-alarm is annunciated when the engine coolant temperature 
exceeds the threshold setting for a fixed duration of four seconds. The arming delay disables the High 
Coolant Temp pre-alarm function for a user-adjustable time during engine startup. Delay duration is 
determined by the High Coolant Temp Alarm Arming Delay setting. System units are configured on the 
System Settings screen. 

Weak Battery Voltage 
Weak battery voltage pre-alarm settings consist of an enable/disable setting, a threshold setting, and an 
activation time delay. If enabled, a weak battery voltage pre-alarm latches during engine cranking when 
the battery voltage decreases below the threshold setting for the duration of the activation delay. The 
threshold can be entered in actual volts or a per-unit value. The per-unit threshold value is based on the 
nominal battery voltage setting found on the System Parameters, Rated Data screen. 

Low Coolant Temp 
Low coolant temperature pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a low coolant temperature pre-alarm occurs when the engine coolant temperature decreases 
below the threshold setting. System units are configured on the System Settings screen. 

Battery Overvoltage 
Battery overvoltage pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a battery overvoltage pre-alarm occurs when the battery voltage increases above the threshold 
setting. The threshold can be entered in actual volts or a per-unit value. The per-unit threshold value is 
based on the nominal battery voltage setting found on the System Parameters, Rated Data screen. 

ECU Coms Fail 
ECU communication failure pre-alarm settings consist of a single enable/disable setting. If enabled, this 
pre-alarm is triggered when the DGC-2020ES detects a problem in its J1939 CAN connection to the ECU. 

Coolant Level 
Low coolant level pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a low coolant level pre-alarm is triggered when the metered coolant level decreases below the 
threshold setting. 

Maintenance Interval 
Maintenance interval pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a maintenance interval pre-alarm is annunciated when the DGC-2020ES maintenance timer 
counts down to zero from the threshold time setting. 

Active DTC 
Active DTC (diagnostic trouble code) pre-alarm settings consist of a single enable/disable setting. If 
J1939 CAN and DTC support are both enabled, an “active DTC” pre-alarm can be enabled. This pre-
alarm is triggered when a DTC is sent from the ECU to the DGC-2020ES. 

Low Oil Pressure 
Low oil pressure pre-alarm settings consist of an enable/disable setting and a threshold setting. If 
enabled, a low oil pressure pre-alarm is triggered after a two second delay when the engine oil pressure 
decreases below the threshold setting. The arming delay disables the low oil pressure pre-alarm function 
for a user-adjustable time during engine startup. Delay duration is determined by the Low Oil Pressure 
Alarm Arming Delay setting. System units and metric pressure units are configured on the System 
Settings screen. 
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CEM Comm Failure 
CEM-2020 communication failure pre-alarm settings consist of a single enable/disable setting. If enabled, 
this pre-alarm is triggered when communication between the optional CEM-2020 and DGC-2020ES is 
lost. 

Checksum Failure 
When one of the internal checksum calculations, used for data integrity purposes, has failed, the 
checksum failure pre-alarm is triggered. This indicates that some of the user settings or firmware code 
has been corrupted. 

After upgrading firmware through BESTCOMSPlus, the checksum failure pre-alarm may trigger. This pre-
alarm is not indicative of an error in this case. It can be cleared by cycling power to the DGC-2020ES. If 
the pre-alarm reoccurs, then it is indicative of an error and corrective action should be taken. See 
Resetting Alarms, Checksum Failure, below, for more information. 

Breaker Close Failure 
If enabled, this pre-alarm is triggered when the DGC-2020ES has issued a "breaker close" output and has 
not received "breaker closed" feedback from the breaker within the allowed closing time. The Monitor 
setting determines whether this condition is monitored only during transitions or always. 

Breaker Open Failure 
If enabled, this pre-alarm is triggered when the DGC-2020ES has issued a "breaker open" output and has 
not received "breaker opened" feedback from the breaker within the allowed closing time. The Monitor 
setting determines whether this condition is monitored only during transitions or always. 

Reverse Rotation 
If enabled, this pre-alarm is triggered when the Generator or Bus rotation is opposite of the Phase 
Rotation setting defined on the Rated Data screen. 

DEF Pre-Alarms Enable 
The DEF Pre-Alarms Enable setting allows the user to disable any DEF related pre-alarms in the DGC-
2020ES. There have been occurrences where some engines that do not have DEF-based exhaust 
treatment systems send information over the J1939 CAN Bus that causes the DGC-2020ES to 
annunciate DEF related pre-alarms. Since these pre-alarms are not applicable on this type of system, 
they can be disabled with this setting. 

Engine kW Overload 
By comparing the genset power output with the rated genset output, the level of engine loading can be 
determined. Three engine overload pre-alarms are available that monitor three-phase real power when 
three-phase sensing is active or single-phase real power if single-phase sensing is active. Settings for 
each pre-alarm consist of an enable/disable setting, three-phase threshold setting, three-phase hysteresis 
setting, single-phase threshold setting, single-phase hysteresis setting, and low-line scale factor setting. If 
enabled, an engine overload pre-alarm occurs when the metered power level exceeds the threshold 
setting. The threshold setting is expressed as a percentage of the genset kW rating on the 
BESTCOMSPlus Rated Data screen (DGC-2020ES, System Parameters, Rated Data). The hysteresis 
setting functions as a pre-alarm dropout by preventing rapid switching of the alarm annunciation. When 
the low-line override is active, the thresholds for three-phase and single-phase detection are multiplied by 
the low-line scale factor. The effect is that low-line threshold = three-phase or single-phase threshold 
setting x low-line scale factor. 
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Figure 11-2. Settings Explorer, Alarm Configuration, Pre-Alarms Screen 

Horn Configuration 

To configure the audible horn using BESTCOMSPlus, open the Horn Configuration screen (Figure 11-3). 
This screen is found in the Settings Explorer under the Alarm Configuration category. If using the front 
panel, navigate to Settings > Alarm Configuration > Horn Configuration. 

An output contact is configured through programmable logic to energize an audible horn when an alarm 
or pre-alarm condition exists. The horn settings consist of an enable/disable setting and a Not in Auto 
enable/disable setting. If enabled, the contact output is closed when an alarm condition exists. The 
contact output is toggled between open and closed when a pre-alarm condition exists. If the Not in Auto 
setting is enabled, the horn is disabled when the DGC-2020ES is not operating in Auto mode. 
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Figure 11-3. Settings Explorer, Alarm Configuration, Horn Configuration Screen 

Sender Failure 

To configure sender failure alarms using BESTCOMSPlus, open the Sender Fail screen (Figure 11-4). 
This screen is found in the Settings Explorer under the Alarm Configuration category. If using the front 
panel, navigate to Settings > Alarm Configuration > Sender Fail. 

Coolant temperature, oil pressure, fuel level, and voltage sensing sender failure settings consist of an 
alarm configuration setting and an activation delay. The alarm configuration setting allows selection of the 
type of alarm to be annunciated when a sender fail condition exists. None, Alarm, and Pre-alarm can be 
selected. The selected alarm type is triggered when a sender failure exists for the duration of the 
activation time delay. 

Speed sender failure settings consist of a single activation delay. An alarm is triggered when a speed 
sender failure exists for the duration of the activation time delay. 

 
Figure 11-4. Settings Explorer, Alarm Configuration, Sender Fail Screen 
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12 • Generator Protection 
DGC-2020ES controllers offer standard protection consisting of undervoltage (27), overvoltage (59), 
overcurrent (50), overfrequency (81O), underfrequency (81U), and phase-imbalance voltage (47) 
elements. 

The description of generator protection is organized as follows: 
• Voltage (27, 59, 47) 
• Frequency (81) 
• Overcurrent (50) 

Voltage 

Voltage protection consists of an undervoltage element, an overvoltage element, and a phase-sequence 
voltage element. 

Undervoltage (27) 
Two sets of undervoltage settings are provided for this element: one for three-phase generator 
connections and one for single-phase generator connections. The pickup setting entered is based on the 
PT secondary side. When a single-phase override contact input is received, the DGC-2020ES 
automatically switches from the three-phase undervoltage settings to the single-phase undervoltage 
settings. 

An undervoltage condition is annunciated when the average of the three-phase (three-phase mode) or 
the line-to-line voltage (single-phase mode) decreases below the corresponding 27 pickup setting for the 
duration of the corresponding 27 activation delay. An undervoltage annunciation can be user-selected to 
trigger a pre-alarm (warning) or alarm (shutdown). An undervoltage annunciation can also be user-
configured to close a programmable output. 

The hysteresis setting functions as an undervoltage dropout by preventing rapid switching of the pickup 
output. 

A frequency-based inhibit setting prevents a 27 trip from occurring during an undervoltage condition 
associated with system startup. 

A low-line scale factor setting is used to automatically adjust the undervoltage pickup settings in 
applications that may utilize more than one type of genset connection. The scale factor setting is 
implemented when the DGC-2020ES senses a contact closure at a contact input programmed to activate 
low-line override. This triggers scaling of the protection settings. The value of the scale factor setting 
serves as a multiplier for the pickup settings. For example, if a scale factor contact input is received by the 
DGC-2020ES and the scale factor setting is 2.000, the pickup setting will be doubled (2.000 × PU). 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogic™Plus Programmable Logic when “Status Only” is selected. 

Settings which are related to machine ratings can be set in either actual units of voltage or in per unit 
values. When a native unit is edited, BESTCOMSPlus® automatically recalculates the per unit value 
based on the native unit setting and the rated data parameter (on the System Parameters, Rated Data 
screen) associated with it. When a per unit value is edited, BESTCOMSPlus automatically recalculates 
the native value based on the per unit setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following settings have native units of Secondary Volts, and the rated data associated with them is 
Rated Secondary Volts (on the System Parameters, Rated Data screen). 

• Undervoltage 27 Three-Phase Pickup 
• Undervoltage 27 Single-Phase Pickup 
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The Undervoltage screen is found in the BESTCOMSPlus Settings Explorer under the Generator 
Protection, Voltage category. If using the front panel, navigate to Settings > Generator Protection > 27 
Undervoltage. The BESTCOMSPlus Undervoltage screen is illustrated in Figure 12-1. 

 
Figure 12-1. Settings Explorer, Generator Protection, Voltage, Undervoltage (27) Screen 

Overvoltage (59) 
Two sets of overvoltage settings are provided for this element: one for three-phase generator connections 
and one for single-phase generator connections. The pickup setting entered is based on the PT 
secondary side (DGC-2020ES). When a single-phase override contact input is received, the DGC-
2020ES automatically switches from the three-phase overvoltage settings to the single-phase overvoltage 
settings. 

An overvoltage condition is annunciated when the average of the three-phase (three-phase mode) or the 
line-to-line voltage (single-phase mode) increases above the corresponding 59 pickup setting for the 
duration of the corresponding 59 activation delay. An overvoltage annunciation can be user-selected to 
trigger a pre-alarm (warning) or alarm (shutdown). An overvoltage annunciation can also be user-
configured to close a programmable output. 

The hysteresis setting functions as an undervoltage dropout by preventing rapid switching of the pickup 
output. 

A low-line scale factor setting is used to automatically adjust the overvoltage pickup settings in 
applications that may utilize more than one type of genset connection. The scale factor setting is 
implemented when the DGC-2020ES senses a contact closure at a contact input programmed to activate 
low-line override. This triggers scaling of the protection settings. The value of the scale factor setting 
serves as a multiplier for the pickup settings. For example, if a scale factor contact input is received by the 
DGC-2020ES and the scale factor setting is 2.000, the pickup setting will be doubled (2.000 × PU). 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogicPlus Programmable Logic when “Status Only” is selected. 

Settings which are related to machine ratings can be set in either actual units of voltage or in per unit 
values. When a native unit is edited, BESTCOMSPlus automatically recalculates the per unit value based 
on the native unit setting and the rated data parameter (on the System Parameters, Rated Data screen) 
associated with it. When a per unit value is edited, BESTCOMSPlus automatically recalculates the native 
value based on the per unit setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following settings have native units of Secondary Volts, and the rated data associated with them is 
Rated Secondary Volts (on the System Parameters, Rated Data screen). 

• Overvoltage 59 Three-Phase Pickup 
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• Overvoltage 59 Single-Phase Pickup 

The Overvoltage screen is found in the BESTCOMSPlus Settings Explorer under the Generator 
Protection, Voltage category. If using the front panel, navigate to Settings > Generator Protection > 59 
Overvoltage. The BESTCOMSPlus Overvoltage screen is illustrated in Figure 12-2.  

 
Figure 12-2. Settings Explorer, Generator Protection, Voltage, Overvoltage (59) Screen 

Phase Imbalance (47) 
DGC-2020ES controllers are capable of protecting against voltage imbalances between any of the three 
phases. The pickup setting entered is based on the PT secondary side. A phase imbalance condition is 
annunciated when the difference between any of the three phases of generator voltage increases above 
the 47 pickup setting for the duration of the 47 activation delay setting. A phase imbalance annunciation 
can be user-selected to trigger a pre-alarm (warning) or alarm (shutdown). A phase imbalance 
annunciation can also be user-configured to close a programmable output. 

The hysteresis setting functions as a phase imbalance dropout by preventing rapid switching of the 
pickup output. 

A low-line scale factor setting is used to automatically adjust the phase imbalance pickup setting in 
applications that may utilize more than one type of genset connection. The scale factor setting is 
implemented when the DGC-2020ES senses a contact closure at a contact input programmed to activate 
the low-line override. This triggers scaling of the protection settings. The value of the scale factor setting 
serves as a multiplier for the pickup setting. For example, if a scale factor contact input is received by the 
DGC-2020ES and the scale factor setting is 2.000, the pickup setting will be doubled (2.000 × PU). 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogicPlus Programmable Logic when “Status Only” is selected. 

Settings which are related to machine ratings can be set in either actual units of voltage or in per unit 
values. When a native unit is edited, BESTCOMSPlus automatically recalculates the per unit value based 
on the native unit setting and the rated data parameter (on the System Parameters, Rated Data screen) 
associated with it. When a per unit value is edited, BESTCOMSPlus automatically recalculates the native 
value based on the per unit setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following setting has native units of Secondary Volts, and the rated data associated with it is Rated 
Secondary Volts (on the System Parameters, Rated Data screen). 

• Phase Imbalance 47 Pickup 

The Phase Imbalance screen is found in the BESTCOMSPlus Settings Explorer under the Generator 
Protection, Voltage category. If using the front panel, navigate to Settings > Generator Protection > 47 
Phase Imbalance. The BESTCOMSPlus Phase Imbalance screen is illustrated in Figure 12-3. 
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Figure 12-3. Settings Explorer, Generator Protection, Voltage, Phase Imbalance (47) Screen 

Frequency 

Two sets of frequency protection settings are provided: one for underfrequency (81U) and one for 
overfrequency (81O). 

Underfrequency (81U) 
An underfrequency condition is annunciated when the generator frequency decreases below the 81U 
pickup setting for the duration of the 81U activation delay setting. An underfrequency annunciation can be 
user-selected to trigger a pre-alarm (warning) or alarm (shutdown). An underfrequency annunciation can 
also be user-configured to close a programmable output. 

A voltage-based inhibit setting prevents an 81U trip from occurring during an underfrequency condition 
associated with system startup. 

The hysteresis setting functions as an underfrequency dropout by preventing rapid switching of the pickup 
output. 

Overfrequency (81O) 
When the generator frequency increases above the 81O pickup setting for the duration of the 81O 
activation delay setting, an overfrequency condition is annunciated. An overfrequency annunciation can 
be user-selected to trigger a pre-alarm (warning) or alarm (shutdown). An overfrequency condition can 
also be user configured to close a programmable output. 

The hysteresis setting functions as an overfrequency dropout by preventing rapid switching of the pickup 
output. 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogicPlus Programmable Logic when “Status Only” is selected. 

Alternate Frequency Scale Factor 
An alternate frequency scale factor setting is used for automatic adjustment of the frequency pickup 
settings in applications that may utilize more than one operating frequency. For example, a machine that 
is configurable between 50 or 60 Hz operation. The scale factor setting is implemented when the DGC-
2020ES senses a contact closure at a contact input that is connected to the Alternate Frequency Override 
logic element in BESTlogicPlus Programmable Logic. When the Alternate Frequency Override is true, the 
scale factor setting serves as a multiplier for the pickup settings. For example, if an alternate frequency 
scale factor contact input is received by the DGC-2020ES and the scale factor setting is 2.000, the pickup 
setting is doubled (2.000 x PU). 
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Per Unit 
Settings which are related to machine ratings can be set in either actual units of hertz or in per unit 
values. Per unit settings are available for Pickup (81O/81U) and Inhibit Volts (81U). When a native unit is 
edited, BESTCOMSPlus automatically recalculates the per unit value based on the native unit setting and 
the rated data parameter (on the System Parameters, Rated Data screen) associated with it. When a per 
unit value is edited, BESTCOMSPlus automatically recalculates the native value based on the per unit 
setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following settings have native units of Frequency in Hz, and the rated data associated with them is 
Rated Frequency (on the System Parameters, Rated Data screen). 

• 81 U Pickup 
• 81 O Pickup 

The following setting has native units of Secondary Volts, and the rated data associated with it is Rated 
Secondary Volts (on the System Parameters, Rated Data screen). 

• 81 U Inhibit Voltage 

The Frequency screen is found in the BESTCOMSPlus Settings Explorer under the Generator Protection, 
Frequency category. If using the front panel, navigate to Settings > Generator Protection > 81 O/U 
Frequency. The BESTCOMSPlus Frequency screen is illustrated in Figure 12-4. 

 
Figure 12-4. Settings Explorer, Generator Protection, Frequency, Frequency (81) Screen 

Overcurrent 

Two sets of overcurrent settings are provided for this element: one for three-phase generator connections 
and one for single-phase generator connections. The pickup setting entered is based on the CT 
secondary side. When a single-phase override contact input is received by the DGC-2020ES, the 
overcurrent protection settings automatically switch from the three-phase settings to the single-phase 
overcurrent protection settings. 

When any of the phase currents increase above the pickup setting for the duration of the overcurrent time 
delay, an overcurrent condition is annunciated. An overcurrent annunciation can be user-selected to 
trigger a pre-alarm (warning) or alarm (shutdown). An overcurrent annunciation can also be user-
configured to close a programmable output. 

A low-line scale factor setting is used for automatic adjustment of the overcurrent pickup settings in 
applications that may utilize more than one type of genset connection. The scale factor setting is 
implemented when the DGC-2020ES senses a contact closure at a contact input programmed to activate 
low-line override. This triggers scaling of the protection settings. The value of the scale factor setting 
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serves as a multiplier for the pickup settings. For example, if a scale factor contact input is received by the 
DGC-2020ES and the scale factor setting is 2.000, the pickup setting will be doubled (2.000 × PU). 

The element is disabled when Alarm Configuration is set to “None”. Element status is available in 
BESTlogicPlus Programmable Logic when “Status Only” is selected. 

Settings which are related to machine ratings can be set in either actual units of current or in per unit 
values. When a native unit is edited, BESTCOMSPlus automatically recalculates the per unit value based 
on the native unit setting and the rated data parameter (on the System Parameters, Rated Data screen) 
associated with it. When a per unit value is edited, BESTCOMSPlus automatically recalculates the native 
value based on the per unit setting and the rated data parameter associated with it. 

Once all per unit values are assigned, if the rated data parameters are changed, BESTCOMSPlus 
automatically recalculates all native unit settings based on the modified rated data parameters. 

The following settings have native units of Secondary Amps, and the rated data associated with them is 
Rated Secondary Phase Amps (on the System Parameters, Rated Data screen). 

• Overcurrent 50 Three-Phase Pickup 
• Overcurrent 50 Single-Phase Pickup 

The Overcurrent screen is found in the BESTCOMSPlus Settings Explorer under the Generator 
Protection, Current category. If using the front panel, navigate to Settings > Generator Protection > 50 
Overcurrent. The BESTCOMSPlus Overcurrent screen is illustrated in Figure 12-5. 

 
Figure 12-5. Settings Explorer, Generator Protection, Current, Overcurrent 
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13 • BESTlogic™Plus 
BESTlogicPlus Programmable Logic is a programming method used for managing the input, output, 
protection, control, monitoring, and reporting capabilities of Basler Electric's DGC-2020ES Digital Genset 
Controller. Each DGC-2020ES has multiple, self-contained logic blocks that have all of the inputs and 
outputs of its discrete component counterpart. Each independent logic block interacts with control inputs 
and hardware outputs based on logic variables defined in equation form with BESTlogicPlus. 
BESTlogicPlus equations entered and saved in the DGC-2020ES system's nonvolatile memory integrate 
(electronically wire) the selected or enabled protection and control blocks with control inputs and 
hardware outputs. A group of logic equations defining the logic of the DGC-2020ES is called a logic 
scheme. 

One default active logic scheme is preloaded into the DGC-2020ES. This scheme is configured for a 
typical protection and control application and virtually eliminates the need for "start-from-scratch" 
programming. BESTCOMSPlus® can be used to open a logic scheme that was previously saved as a file 
and upload it to the DGC-2020ES. The default logic scheme can also be customized to suit your 
application. Detailed information about logic schemes is provided later in this section. 

BESTlogicPlus is not used to define the operating settings (modes, pickup thresholds, and time delays) of 
the individual protection and control functions. Operating settings and logic settings are interdependent 
but separately programmed functions. Changing logic settings is similar to rewiring a panel and is 
separate and distinct from making the operating settings that control the pickup thresholds and time 
delays of a DGC-2020ES. Detailed information about operating settings is provided in the 
BESTCOMSPlus chapter. 
 

Caution 

This product contains one or more nonvolatile memory devices. 
Nonvolatile memory is used to store information (such as settings) that 
needs to be preserved when the product is power-cycled or otherwise 
restarted. Established nonvolatile memory technologies have a 
physical limit on the number of times they can be erased and written. 
In this product, the limit is 100,000 erase/write cycles. During product 
application, consideration should be given to communications, logic, 
and other factors that may cause frequent/repeated writes of settings 
or other information that is retained by the product. Applications that 
result in such frequent/repeated writes may reduce the useable 
product life and result in loss of information and/or product 
inoperability. 

Overview of BESTlogic™Plus 

Use BESTCOMSPlus to change BESTlogicPlus settings. Use the Settings Explorer to open the 
BESTlogicPlus Programmable Logic tree branch as shown in Figure 13-1. 

The BESTlogicPlus Programmable Logic screen contains a logic library for opening and saving logic files, 
tools for creating and editing logic documents, and protection settings. 
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Figure 13-1. Settings Explorer, BESTlogicPlus Programmable Logic Screen 

BESTlogic™Plus Composition 

There are three main groups of objects used for programming BESTlogicPlus. These groups are I/O, 
Components, and Elements. For details on how these objects are used to program BESTlogicPlus, see 
the paragraphs on Programming BESTlogicPlus, later in this chapter. 

I/O 
This group contains Input Objects, Output Objects, Alarms, Pre-Alarms, Senders, and Logic Control 
Relays. Table 13-1 lists the names and descriptions of the objects in the I/O group. 

Table 13-1. I/O Group, Names and Descriptions 
Name Description Symbol 

Input Objects 
Logic 0 Always false (Low). 

 
Logic 1 Always true (High). 

 
Physical Inputs 
IN1 – IN7 

True when Physical Input x is active. 

 
Remote Inputs 
IN8 – IN17 

True when Remote Input x is active. (Available 
when an optional CEM-2020 is connected.) 

 
Virtual Inputs 
VIN1 – VIN4 

True when Virtual Input x is active. 

 

Status Input 
Active DTC’s 
Present 

True when Diagnostic Trouble Codes are 
present. 
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Name Description Symbol 
Status Input 
Alarm Silence 

True when the Alarm Silence logic element is 
true or the Alarm Silence button is pressed on 
the front panel.  

Status Input 
Alternate 
Frequency 
Override 

True when the Alternate Frequency Override 
logic element is true. 

 

Status Input 
ATS Input 

True when the ATS (Auto Transfer Switch) 
input is true or the ATS logic element is true. 

 
Status Input 
ATS Input Mode 
is Complementary 

True when the Auto Transfer Switch 
Programmable Function Input Mode is set for 
Complementary. False when it is set for 
Single. 

 

Status Input 
ATS Normally 
Open Input 

True when the input mapped to the ATS N.O. 
input is true. 

 

Status Input 
ATS Normally 
Closed Input 

True when the input mapped to the ATS N.C. 
input is true. 

 

Status Input 
ATS Status 

True when the ATS Programmable Function 
detects a true status. When the ATS Input 
Mode is set for Single, it is true when the input 
mapped to the ATS N.O. input is true.  When 
the ATS Input Mode is set for Complementary, 
it is true when the input mapped to the ATS 
N.O. input is true and the input mapped to the 
ATS N.C. input is false. 

 

Status Input 
Audible Horn 

True when the Audible Horn is active. 

 
Status Input 
Auto Mode 

True when the DGC-2020ES is in Auto Mode 
or the Auto Mode logic element is true. 

 
Status Input 
Auto Restart 

True when the Automatic Restart function is 
active. 

 
Status Input 
Battery Charger 
AC Off 

True when the ac power to the battery charger 
is off. (Battery Charger 1 shown.) 

 

Status Input 
Battery Charger 
Battery Failure 

True when the battery charger has detected 
that the battery has failed. (Battery Charger 1 
shown.)  

Status Input 
Battery Charger 
Comms Fail 

True when the battery charger has detected a 
J1939 communications failure. (Battery 
Charger 1 shown.)  

Status Input 
Battery Charger 
Fail 

True when the battery charger has failed. 
(Battery Charger 1 shown.) 

 

Status Input 
Battery Charger 
High Output Volts 

True when the battery charger output voltage 
is too high. (Battery Charger 1 shown.) 
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Name Description Symbol 
Status Input 
Battery Charger 
Invalid Settings 

True when the battery charger has detected 
settings that are not valid. (Battery Charger 1 
shown.)  

Status Input 
Battery Charger 
Low Cranking 
Volts 

True when the battery charger has detected 
that the voltage while the engine is cranking 
has dipped too low. (Battery Charger 1 shown.)  

Status Input 
Battery Charger 
Low Output Volts 

True when the battery charger output voltage 
is too low. (Battery Charger 1 shown.) 

 

Status Input 
Battery Charger 
Single Unit Fail 

True when the battery charger has detected 
one or more charging output stages in a 
charger with multiple charging output stages 
has failed. (Battery Charger 1 shown.) 

 

Status Input 
Battery Charger 
Thermal Limit 

True when the battery charger temperature is 
beyond the thermal limit. (Battery Charger 1 
shown.)  

Status Input 
Battery Charger 
Fail 

True when the Battery Charger Fail input is 
true. 

 
Status Input 
Battle Override 

True when the Battle Override input is true. 

 
Status Input 
Bus Dead 

True when the Bus Dead condition settings 
have been exceeded. 

 
Status Input 
Bus Fail 

True when the Bus Fail condition settings have 
been exceeded. 

 
Status Input 
Bus Forward 
Rotation 

True when the bus rotation matches the Phase 
Rotation setting. 

 

Status Input 
Bus Reverse 
Rotation 

True when the bus rotation is opposite of the 
Phase Rotation setting. 

 
Status Input 
Bus Stable 

True when the Bus Stable condition settings 
have been exceeded. 

 
Status Input 
CAN Bus - Bus 
Off 

True when the CAN Bus - bus is off. 

 

Status Input 
CAN Bus Error 
Passive 

True when a passive error is annunciated by 
the CAN Bus. 

 

Status Input 
Configurable 
Elements 1-8 

True when the Configurable Element x logic 
element is true. 

 

Status Input 
Contact 
Expansion 
Module 

Contact Expansion Module Connected. True 
when an optional CEM-2020 is connected to 
the DGC-2020ES.  
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Name Description Symbol 
Status Input 
Cool Down Timer 
Active 

True when the Cool Down Timer is timing out. 
The Cool Down Timer is true under two 
circumstances: 
1. The unit is in auto and ATS is removed, 

causing the DGC-2020ES to go into a 
cooldown state. 

2. The engine is running (in RUN or AUTO 
mode with ATS applied) and the load has 
been removed (i.e. the EPSSUPLOAD 
status input is false due to small load). If 
the load is reapplied, the Cool Down 
Timer stops and resets, and it will restart 
when the load is removed the next time. 

 

Status Input 
DPF Lamp 
Command 

True when DPF lamp is lit. This status input 
mimics the state of the DPF lamp. It remains 
true when the DPF lamp is constantly lit and 
toggles true and false at a rate of 1 Hz when 
DPF lamp is blinking. 

 

Status Input 
DPF Manual 
Regen Request 

True when a Diesel Particulate Filter (DPF) 
manual regen request has been initiated 
through the front panel, BESTCOMSPlus, or 
the Manual Regen Request logic element. 

 

Status Input 
DPF Regen Inhibit 
Request 

True when the Diesel Particulate Filter (DPF) 
regeneration inhibit setting is turned on through 
the front panel, BESTCOMSPlus, or logic.  

Status Input 
ECU Amber Lamp 

True when the engine ECU sends ECU Amber 
Lamp (Warning Lamp) status as part of J1939 
Diagnostic Trouble Code (DTC) 
communications. It may be off, on, or flashing. 
If the installation requires annunciation of 
engine warning and fault lamps, this may be 
connected to an output in logic to drive an 
amber lamp. 

 

Status Input 
ECU Red Lamp 

True when the engine ECU sends ECU Red 
Lamp (Fault Lamp) status as part of J1939 
Diagnostic Trouble Code (DTC) 
communications. It may be off, on, or flashing. 
If the installation requires annunciation of 
engine warning and fault lamps, this may be 
connected to an output in logic to drive a red 
lamp. 

 

Status Input 
Emergency Stop 

True when the Emergency Stop button has 
been pressed. 

 
Status Input 
Engine Running 

True while the Engine is Running. 

 
Status Input 
Engine Running 
15 Minutes 

True when the engine is presently running and 
has been running 15 minutes or more since the 
most recent start.  

Status Input 
EPS Supplying 
Load 

True while the EPS is supplying load. 

 
Status Input 
Front Panel 
Buttons 

True while the Auto front panel button is 
pressed. 

 



13-6  9469200995 

BESTlogic™Plus  DGC-2020ES 

Name Description Symbol 
Status Input 
Front Panel 
Buttons 

True while the Back front panel button is 
pressed. 

 

Status Input 
Front Panel 
Buttons 

True while the Down front panel button is 
pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Edit front panel button is 
pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Up and Down front panel 
buttons are simultaneously pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Off front panel button is 
pressed. 

 

Status Input 
Restart Delay 
Active 

True when the restart delay is currently active. 

 
Status Input 
Front Panel 
Buttons 

True while the Run front panel button is 
pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Back and Edit front panel 
buttons are simultaneously pressed. 

 
Status Input 
Front Panel 
Buttons 

True while the Up front panel button is 
pressed. 

 
Status Input 
Fuel Leak 

True when the Fuel Leak Detect input is true. 

 
Status Input 
Generator 
Breaker Status 

True when the generator breaker is closed. 

 
Status Input 
Generator Dead 

True when the Gen Dead condition settings 
have been exceeded. 

 
Status Input 
Generator Fail 

True when the Gen Fail condition settings 
have been exceeded. 

 
Status Input 
Generator 
Forward Rotation 

True when the generator rotation matches the 
Phase Rotation setting. 

 

Status Input 
Generator 
Protection 

True when the 27 element is tripped. 

 

Status Input 
Generator 
Protection 

True when the 59 element is tripped. 

 

Status Input 
Generator 
Protection 

True when the 47 element is tripped. 

 
Status Input 
Generator 
Protection 

True when the 50 element is tripped. 
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Name Description Symbol 
Status Input 
Generator 
Protection 

True when the 81 Over element is tripped. 

 
Status Input 
Generator 
Protection 

True when the 81 Under element is tripped. 

 
Status Input 
Generator 
Reverse Rotation 

True when the generator rotation is opposite of 
the Phase Rotation setting. 

 
Status Input 
Generator Stable 

True when the Gen Stable condition settings 
have been exceeded. 

 
Status Input 
Generator Test 
Loaded 

True when the Exercise Timer has started the 
generator and run with load is selected. 

 
Status Input 
Generator Test 

True when the Exercise Timer has started the 
generator. 

 
Status Input 
Global Low 
Coolant Level 

True when the Low Coolant Level input is true. 

 
Status Input 
Ground Delta 
Override 

True when the Grounded Delta Override input 
is true. 

 
Status Input 
Idle Request 

True when the Idle Request logic element is 
true. 

 
Status Input 
In Alarm State 

True when the DGC-2020ES is in the alarm 
state. 

 
Status Input 
In Connecting 
State 

True when the DGC-2020ES is in the 
connecting state. 

 

Status Input 
In Cooling State 

True when the DGC-2020ES is in the cooling 
state. 

 
Status Input 
In Cranking State 

True when the DGC-2020ES is in the cranking 
state. 

 
Status Input 
In Disconnect 
State 

True when the DGC-2020ES is in the 
disconnect state. 

 

Status Input 
In Prestart State 

True when the DGC-2020ES is in the pre-start 
state. 

 
Status Input 
In Pulsing State 

True when the DGC-2020ES is in the pulsing 
state. 

 
Status Input 
In Ready State 

True when the DGC-2020ES is in the ready 
state. 

 
Status Input 
In Resting State 

True when the DGC-2020ES is in the resting 
state. 

 
Status Input 
In Running State 

True when the DGC-2020ES is in the running 
state. 
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Name Description Symbol 
Status Input 
Lamp Test 

True when the Lamp Test logic element is true 
or the Lamp Test button is pressed on the front 
panel.  

Status Input 
Load Take Over 

True when the Load Take Over logic element 
is true. 

 
Status Input 
Low Line Override 

True when the Low Line Override input is true. 

 
Status Input 
Mains Breaker 
Status 

True when the mains breaker is closed. 

 

Status Input 
Mains Fail Test 

True when the Mains Fail Test logic element is 
true. 

 
Status Input 
Mains Fail 
Transfer 
Complete 

True when the DGC-2020ES is configured for 
mains fail transfers and has successfully 
transferred to the generator from the utility. It 
remains true until the utility power is deemed 
good and the DGC-2020ES transfers the load 
back to utility power. 

 

Status Input 
Mains Fail 
Transfer 
Disabled 

True when the Mains Fail Transfer 
Functionality is not enabled or when the DGC-
2020ES is operating in the Off or Run modes 
or in the alarm state. 

 

Status Input 
Mains Fail 
Transfer 
Power from Gens 

True when mains fail transfer function detects 
the load is powered from the generator bus. 

 

Status Input 
Mains Fail 
Transfer 
Power from Mains 

True when mains fail transfer function detects 
the load is powered from the mains bus. 

 

Status Input 
Mains Fail 
Transfer 
Return Timer 
Active 

True when mains fail transfer return delay 
timer is actively counting. 

 

Status Input 
Mains Fail 
Transfer 
Transfer Timer 
Active 

True when the mains fail transfer delay timer is 
actively counting. 

 

Status Input 
Mains Fail 
Transfer 
Transferring to 
Gens 

True when mains fail transfer is transferring 
load to the generator bus. 

 

Status Input 
Mains Fail 
Transfer 
Transferring to 
Mains 

True when mains fail transfer is transferring 
load to the mains bus. 
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Name Description Symbol 
Status Input 
Off Mode 

True when the DGC-2020ES is in Off Mode or 
the Off Mode logic element is true. 

 
Status Input 
Off Mode 
Cooldown 

True when the DGC-2020ES is in Off Mode 
and cooling down. 

 

Status Input 
Open Transition 
Delay 

True when the open transition delay is actively 
counting. 

 

Status Input 
Pre Start 
Condition in Effect 

True while in the Pre Start state. 

 
Status Input 
Pre Start Input 

True when the DGC-2020ES is indicating that 
the Pre Start relay should be closed. 

 
Status Input 
Regen Completed 

True for 30 seconds after a Yanmar ECU goes 
back into passive mode when the status of the 
DPF Active Regeneration Forced Status is 
“Regen Successful”. 

 

Status Input 
Regen 
Confirmation 
Requested 

True after a manual exhaust regeneration has 
been requested on a Yanmar ECU. Once in 
this state, another regen request must be 
issued to confirm manual regeneration. 

 

Status Input 
Regen Interlock 
from ECU 

True when John Deere proprietary parameters 
are broadcast over the J1939 CAN Bus. 

 

Status Input 
Regen Stopped 

True for 30 seconds after a Yanmar ECU goes 
back into passive mode when the status of the 
DPF Active Regeneration Forced Status is 
“Regen Not Successful”. 

 

Status Input 
Reset Active 

True when the Reset logic element is true or 
when the Reset key on the front panel is 
pressed.  

Status Input 
Restart Delay 
Active 

True when the Restart Delay timer is timing 
out. 

 
Status Input 
Run Input 

True when the DGC-2020ES is indicating that 
the Run relay should be closed. 

 
Status Input 
Run Mode 

True when the DGC-2020ES is in Run Mode 
or the Run Mode logic element is true. 

 
Status Input 
Single Phase 
Connection 
Override 

True when the Single Phase Override input is 
true. 

 

Status Input 
Switch not in Auto 

True when the DGC-2020ES is not in Auto 
Mode. 

 
Status Input 
Start Input 
 

True when the DGC-2020ES is indicating that 
the Start relay should be closed to start the 
engine.  

Output Objects 
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Name Description Symbol 
Physical Outputs 
OUT1 – OUT4 

Physical Outputs 1 through 4. 

 
Remote Outputs 
OUT5 – OUT28 

Remote Outputs 5 through 28. 
(Available when an optional CEM-2020 is 
connected.)  

Alarms 

Auto Restart Fail True after the Automatic Restart function fails 
to restart the generator. 

 
Battery Charger 
Fail 

True when the Battery Charger Fail function is 
configured as an alarm and the activation 
delay has expired.  

Coolant Level 
Sender Fail 

True when a low coolant level error status 
code is received from the ECU. CAN Bus must 
be enabled.  

Coolant Temp 
Sender Fail 

True when the Coolant Temp Sender Fail is 
configured as an alarm and the activation 
delay has expired.  

DEF Severe 
Inducement 

This alarm indicates the highest level of 
inducement not to operate the engine due to 
low or poor quality Diesel Exhaust Fluid (DEF), 
or a malfunction in the Exhaust After 
Treatment System (EATS). The engine may 
operate in a reduced power mode, or for a 
limited time, or may be prevented from starting 
by the ECU until the problem is corrected. A 
service tool may be required to restart the 
engine. 

 

Diagnostic 
Trouble Code 

True when a Diagnostic Trouble Code alarm 
exists. 

 
ECU Comm Loss True when communication to ECU has been 

lost. 
 

ECU Shutdown True when ECU has shut down the engine. 

 
Emergency Stop True when the Emergency Stop button has 

been pressed. 
 

Exhaust System 
Error 

This alarm annunciates when the DEF 
Inducement Level is greater than or equal to 3, 
the Isuzu Exhaust System lamp is on, and the 
Isuzu No Power lamp is on. The Exhaust 
System Error alarm appears in conjunction 
with a DEF Severe Inducement alarm to 
indicate why the machine has entered the 
severe inducement state due to SCR system 
malfunction. 

 

Fuel Leak True when the Fuel Leak Detect function is 
configured as an alarm and the activation 
delay has expired.  

Fuel Level Sender 
Fail 

True when the Fuel Level Sender Fail is 
configured as an alarm and the activation 
delay has expired.  
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Generator 
Protection 
27 

True when the 27 element is configured as an 
alarm and has tripped. 

 

Generator 
Protection 
59 

True when the 59 element is configured as an 
alarm and has tripped. 

 

Generator 
Protection 
47 

True when the 47 element is configured as an 
alarm and has tripped. 

 
Generator 
Protection 
50 

True when the 50 element is configured as an 
alarm and has tripped. 

 

Generator 
Protection 
81 Over 

True when the 81 Over element is configured 
as an alarm and has tripped. 

 
Generator 
Protection 
81 Under 

True when the 81 Under element is configured 
as an alarm and has tripped. 

 
Global Alarm True when one or more alarms are set. 

 
Global Sender 
Fail 

True when one or more of the Sender Fails are 
configured as alarms and are true. 

 
Hi Coolant Temp True when the High Coolant Temp Alarm 

settings have been exceeded. 
 

Isuzu DEF Low 
Refill DEF 

True when an Isuzu engine ECU has detected 
low DEF level and indicated the DEF symbol 
should be displayed, and the Isuzu No Power 
Lamp is active indicating that the engine has 
been shut down. 

 

Low Coolant 
Level 

True when the Low Coolant Level function is 
configured as an alarm and the activation 
delay has expired. In addition, true when CAN 
Bus is enabled and the Low Coolant Level 
Alarm threshold has been exceeded. 

 

Low Fuel Level True when the Low Fuel Level Alarm settings 
have been exceeded. 

 
Low Oil Pressure True when the Low Oil Pressure Alarm 

settings have been exceeded. 
 

Mains Fail 
Transfer Failed 

True when a mains fail transfer fail pre-alarm 
occurs. The pre-alarm occurs when the DGC-
2020ES is configured for mains fail transfers, 
but has not transferred to the generator from 
the utility before the Mains Fail Max Transfer 
Time has expired. It remains true until the pre-
alarm is cleared by pressing the Reset button 
on the front panel. 

 

mtu Combined 
Red 

This is an indication from the mtu Engine ECU 
that a Red Alarm has occurred. If any Red 
Alarm occurs, a Combined Red Alarm occurs.  
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Oil Pressure 
Sender Fail 

True when the Oil Pressure Sender Fail is 
configured as an alarm and the activation 
delay has expired.  

Overcrank True when an Overcrank condition exists. 

 
Overspeed True when the Overspeed Alarm settings have 

been exceeded. 
 

Speed Sender 
Fail 

True when the Speed Sender Fail activation 
delay has expired. 

 
Unexpected 
Shutdown Alarm 

True when the metered engine speed (RPM) 
unexpectedly drops to 0 while the engine is 
running.  

Voltage Sensing 
Fail 

True when the Voltage Sensing Fail is 
configured as an alarm and the activation 
delay has expired.  

Pre-Alarms 

ATS Circuit Error True when the input mapped to the ATS N.O. 
input and the input mapped to the ATS N.C. 
input are not opposite for a time longer than 
the ATS Circuit Error Delay setting. 

 

Battery Charger 
Fail 

True when the Battery Charger Fail function is 
configured as a pre-alarm and the activation 
delay has expired.  

Battery Charger 
AC Off 

True when the ac power to the battery charger 
is off. (Battery Charger 1 shown.) 

 
Battery Charger 
Battery Failure 

True when the battery charger has detected 
that the battery has failed. (Battery Charger 1 
shown.)  

Battery Charger 
Comms Fail 

True when the battery charger has detected a 
J1939 communications failure. (Battery 
Charger 1 shown.)  

Battery Charger 
Fail 

True when the battery charger has failed. 
(Battery Charger 1 shown.) 

 
Battery Charger 
High Output Volts 

True when the battery charger output voltage 
is too high. (Battery Charger 1 shown.) 

 
Battery Charger 
Invalid Settings 

True when the battery charger has detected 
invalid settings. (Battery Charger 1 shown.) 

 
Battery Charger 
Low Cranking 
Volts 

True when the battery charger has detected 
that the voltage while the engine is cranking 
has dipped too low. (Battery Charger 1 shown.)  

Battery Charger 
Low Output Volts 

True when the battery charger output voltage 
is too low. (Battery Charger 1 shown.) 

 
Battery Charger 
Single Unit Fail 

True when the battery charger has detected 
one or more charging output stages in a 
charger with multiple charging output stages 
has failed. (Battery Charger 1 shown.) 

 



9469200995 13-13 

DGC-2020ES BESTlogic™Plus 

Name Description Symbol 
Battery Charger 
Thermal Limit 

True when the battery charger temperature is 
beyond the thermal limit. (Battery Charger 1 
shown.)  

Battery 
Overvoltage 

True when the Battery Overvoltage pre-alarm 
threshold has been exceeded. 

 
Cannot Regen - 
Interlock Fail 

True when the regeneration interlock has failed 
on a Yanmar ECU. Manual regeneration is 
blocked.  

Cannot Regen - 
Low Coolant 
Temp 

True when the coolant temp is low on a 
Yanmar ECU. Manual regeneration is blocked. 

 
Cannot Regen - 
Not 50 Hours 
Since Last Regen 

True when 50 hours has not elapsed since last 
regeneration on a Yanmar ECU. Manual 
regeneration is blocked.  

Checksum Failure True when some of the user settings or 
firmware code has been corrupted. Refer to 
the Reporting and Alarms chapter for more 
details. 

 

Contact 
Expansion 
Module 
Multiple Contact 
Expansion 
Modules 
Connected 

True when more than one CEM-2020 is 
connected. 

 

Contact 
Expansion 
Module 
Contact 
Expansion 
Module Comm 
Fail 

True when communication from the CEM-2020 
to the DGC-2020ES has been lost. 

 

Contact 
Expansion 
Module 
Contact 
Expansion 
Modules 
Hardware 
Mismatch 

True when the connected CEM-2020 does not 
have the same number of outputs as  defined 
on the System Parameters, Remote Module 
Setup screen in BESTCOMSPlus. 

 

Coolant Temp 
Sender Fail 

True when the Coolant Temp Sender Fail is 
configured as a pre-alarm and the activation 
delay has expired.  

DEF 
Consumption 
Incorrect 

True when the engine ECU reports via CAN 
bus that a DEF Consumption Error has 
occurred.  

DEF Inducement This is the lowest level of inducement not to 
operate the engine when Diesel Exhaust Fluid 
(DEF) is low or of poor quality or there is a 
problem with the Exhaust After Treatment 
System (EATS). The engine is operating in a 
reduced power mode. Eventually the level of 
inducement will be increased unless the 
problem with the DEF or malfunction in the 
EATS is corrected. 
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DEF Low Severe True when the engine ECU reports via CAN 

Bus that Diesel Exhaust Fluid (DEF) is at a 
level below 8%.  

DEF Fluid Low True when the engine ECU reports via CAN 
Bus that the Diesel Exhaust Fluid (DEF) is at a 
level between 8 and 23%.  

DEF Inducement 
Override 

This pre-alarm indicates a temporary override 
of inducement not to operate the engine. This 
is set by the ECU and is not a user setting.   

DEF Pre-severe 
Inducement 

This pre-alarm indicates a high level of 
inducement not to operate the engine due to 
low or poor quality Diesel Exhaust Fluid (DEF), 
or a malfunction in the Exhaust After 
Treatment System (EATS). The engine may 
operate in a reduced power mode, or for a 
limited time, after which it will enter a state of 
severe inducement unless the problem with 
the DEF or malfunction in the EATS is 
corrected. 

 

DEF Quality Poor True when the engine ECU reports “DEF 
Quality Poor” via CAN Bus. 

 

DEF Severe 
Inducement 

This pre-alarm indicates the highest level of 
inducement not to operate the engine due to 
low or poor quality Diesel Exhaust Fluid (DEF), 
or a malfunction in the Exhaust After 
Treatment System (EATS). The engine may 
operate in a reduced power mode, or for a 
limited time, or may be prevented from starting 
by the ECU until the problem is corrected. A 
service tool may be required to restart the 
engine. 

 

DEF Tampering True when the engine ECU reports “DEF 
Tampering” via CAN Bus. 

 
DEF Warning This pre-alarm indicates the first level of 

warning when EATS is not functioning properly 
or DEF quality or level is not sufficient for 
proper operation. 

 

DEF Warning 
Level 2 

This pre-alarm indicates the second level of 
warning when EATS is not functioning properly 
or DEF quality or level is not sufficient for 
proper operation. 

 

Diag Trouble 
Code 

True when a Diagnostic Trouble Code exists. 

 
DPF Regenerate 
Disabled 

True when the Diesel Particulate Filter (DPF) 
lamp status broadcast over CAN Bus indicates 
that DPF regeneration is inhibited.  

DPF Regenerate 
Required 

True when the Diesel Particulate Filter (DPF) 
lamp status broadcast over CAN Bus indicates 
that DPF regeneration is required.  

DPF Soot Level 
High 

True when the engine ECU reports via CAN 
Bus that Diesel Particulate Filter (DPF) soot 
level is high.  
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DPF Soot Level 
Moderately High 

True when Diesel Particulate Filter (DPF) lamp 
status (yellow warning) broadcast over CAN 
Bus indicates that the soot level is moderately 
high. 

 

DPF Soot Level 
Severely High 

True when Diesel Particulate Filter (DPF) lamp 
status (red warning) broadcast over CAN Bus 
indicates that the soot level is severely high.  

ECU Comm Loss True when communication to ECU has been 
lost. 

 
EGR Inducement 
Level Low 

True when an issue has been detected in the 
Exhaust Gas Recirculation (EGR) system. This 
is the second level of inducement to correct the 
issue. There should also be Diagnostic Trouble 
Codes providing additional information about 
the issue. 

 

EGR Inducement 
Severe 

True when an issue has been detected in the 
Exhaust Gas Recirculation (EGR) system. This 
is the third level of inducement to correct the 
issue. If not corrected, engine power derating 
or shutdown may occur. There should also be 
Diagnostic Trouble Codes providing additional 
information about the issue. 

 

EGR Inducement 
Warning 

True when an issue has been detected in the 
Exhaust Gas Recirculation (EGR) system. This 
is the first level of inducement to correct the 
issue. There should also be Diagnostic Trouble 
Codes providing additional information about 
the issue. 

 

Engine kW Over 
Load 1 

True when the Engine kW Overload 1 Pre-
Alarm settings have been exceeded. 

 
Engine kW Over 
Load 2 

True when the Engine kW Overload 2 Pre-
Alarm settings have been exceeded. 

 
Engine kW Over 
Load 3 

True when the Engine kW Overload 3 Pre-
Alarm settings have been exceeded. 

 
Escape Mode This pre-alarm indicates a temporary override 

of inducement not to operate the engine. This 
is set by the ECU and is not a user setting.  

Exhaust System 
Error 

Pre-alarm indicating an Exhaust System Error 
has been detected.  A number of conditions 
cause this; examples include DEF Tank Low 
indication, Purge in Progress, Exhaust System 
Error, Exhaust System Inducement Indications, 
etc. This is derived based on ECU Lamp 
conditions communicated from the Engine 
ECU to the DGC-2020ES via J1939 CAN Bus 
communications. 

 

Fuel Leak True when the Fuel Leak Detect function is 
configured as a pre-alarm and the activation 
delay has expired.  

Fuel Level Sender 
Fail 

True when the Fuel Level Sender Fail is 
configured as a pre-alarm and the activation 
delay has expired.  
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Generator 
Breaker Close 
Fail 

True when a generator breaker close fail pre-
alarm occurs. The pre-alarm occurs when the 
DGC-2020ES has issued a generator breaker 
close output but does not receive a generator 
breaker status input that indicates the breaker 
has closed before the breaker close wait time 
has expired. 

 

Generator 
Breaker Open Fail 

True when a generator breaker open fail pre-
alarm occurs. The pre-alarm occurs when the 
DGC-2020ES has issued a generator breaker 
open output but does not receive a generator 
breaker status input that indicates the breaker 
has opened before the breaker close wait time 
has expired. 

 

Fuel Filter 1 Leak This logic status input indicates that the engine 
ECU has detected a leak in fuel filter 1, and 
has communicated this to the DGC-2020ES 
over CAN Bus. 

 

Fuel Filter 2 Leak This logic status input indicates that the engine 
ECU has detected a leak in fuel filter 2, and 
has communicated this to the DGC-2020ES 
over CAN Bus. 

 

Generator 
Protection 
27 

True when the 27 element is configured as a 
pre-alarm and has tripped. 

 

Generator 
Protection 
59 

True when the 59 element is configured as a 
pre-alarm and has tripped. 

 

Generator 
Protection 
47 

True when the 47 element is configured as a 
pre-alarm and has tripped. 

 
Generator 
Protection 
50 

True when the 50 element is configured as a 
pre-alarm and has tripped. 

 

Generator 
Protection 
81 Over 

True when the 81 Over element is configured 
as a pre-alarm and has tripped. 

 
Generator 
Protection 
81 Under 

True when the 81 Under element is configured 
as a pre-alarm and has tripped. 

 
Global Pre-Alarm True when one or more pre-alarms are set. 

 

Heating for 
Exhaust Regen 

A manual or automatic exhaust regeneration 
request has occurred, but the exhaust system 
is not hot enough for regeneration to occur. 
The ECU feeds fuel into the exhaust stream to 
increase the temperature to accomplish 
regeneration. 

 

Hi Coolant Temp True when the High Coolant Temp Pre-Alarm 
threshold has been exceeded. 

 
High Exhaust 
Temperature 

True when Diesel Particulate Filter (DPF) lamp 
status broadcast over CAN Bus indicates high 
exhaust temperature.  
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High Fuel Level True when the High Fuel Level Pre-Alarm 

settings have been exceeded. 
 

Inter Generator 
Comm Fail 

True when the DGC-2020ES detects that an 
individual generator previously connected to a 
generator network has lost connection.  

Isuzu DEF Low 
Refill DEF 

True when an Isuzu engine ECU has detected 
low DEF level and has indicated the DEF 
symbol should be displayed.  

Isuzu Forced 
Purge Request 

True when a forced purge has been requested 
by momentarily pressing the Manual 
Regeneration button or setting the DPF Regen 
setting on the front panel, or setting the DPF 
Manual Regenerate button in 
BESTCOMSPlus. 

 

Isuzu SCR Forced 
Purge 

True when a forced purge is in progress after 
having been requested. 

 
Isuzu SCR Purge True when a normal SCR Purge is in progress. 

Normal purges occur during normal operation if 
the engine load is sufficient to allow purge to 
occur. 

 

Isuzu Service 
Tool Forced 
Purge Request 

True when a forced purge has been requested 
through the Isuzu Service Tool. This will 
remain true until the forced purge cycle begins.  

Low Battery 
Voltage 

True when the Low Battery Voltage Pre-Alarm 
settings have been exceeded. 

 
Low Coolant 
Level 

True when the Low Coolant Level function is 
configured as a pre-alarm and the activation 
delay has expired. In addition, true when CAN 
Bus is enabled and the Low Coolant Level 
Pre-Alarm threshold has been exceeded. 

 

Low Coolant 
Temp 

True when the Low Coolant Temp Pre-Alarm 
threshold has been exceeded. 

 
Low DPF Temp 
Add Load 

True when a Yanmar engine ECU has 
received a regeneration request, but has 
detected that DPF temperature is too low to 
perform regeneration. Adding load to engine is 
recommended to increase temperature. 

 

Low Fuel Level True when the Low Fuel Level Pre-Alarm 
threshold has been exceeded. 

 
Low Oil Pressure True when the Low Oil Pressure Pre-Alarm 

threshold has been exceeded. 
 

Mains Breaker 
Close Fail 

True when a mains breaker close fail pre-
alarm occurs. The pre-alarm occurs when the 
DGC-2020ES has issued a mains breaker 
close output but does not receive a mains 
breaker status input that indicates the breaker 
has closed before the breaker close wait time 
has expired. 
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Mains Breaker 
Open Fail 

True when a mains breaker open fail pre-alarm 
occurs. The pre-alarm occurs when the DGC-
2020ES has issued a mains breaker open 
output but does not receive a mains breaker 
status input that indicates the breaker has 
opened before the breaker close wait time has 
expired. 

 

Mains Fail Return 
Failed 

True when a mains fail return fail pre-alarm 
has occurred. The pre-alarm occurs when the 
DGC-2020 is attempting to transfer from 
generator power to mains power after mains 
returns, but has not returned to the mains from 
the generator before the Mains Fail Return 
Delay has expired. 

 

Maintenance 
Interval 

True when the Maintenance Interval Pre-Alarm 
threshold has been exceeded. 

 
MPU Fail True when the MPU has failed. 

 

mtu Pre-Alarms 
Coil 1 High 
Temperature 

True when a High Coil Temperature 1 Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
Coil 2 High 
Temperature 

True when a High Coil Temperature 2 Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
Coil 3 High 
Temperature 

True when a High Coil Temperature 3 Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
Combined Yellow 

True when a Combined Yellow Pre-Alarm has 
been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
ECU Faulty 

True when an ECU Fault Pre-Alarm has been 
received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Engine Speed 
Too Low 

True when a Low Engine Speed Pre-Alarm 
has been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Fault Codes 

True whenever the presence of mtu Fault 
Codes is detected. 

 

mtu Pre-Alarms 
High Alternator 
Winding 
Temperature 

True when a High Temperature In the 
Alternator Windings Pre-Alarm has been 
received from an mtu Engine ECU.  

mtu Pre-Alarms 
High Ambient 
Temperature 

True when a High Ambient Temperature Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
High Charge Air 
Temp mtu Alarm 

True when a High Charge Air Temperature 
Alarm has been received from an mtu Engine 
ECU.  
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mtu Pre-Alarms 
High Charge Air 
Temp mtu Pre-
Alarm 

True when a High Charge Air Temperature 
Pre-Alarm has been received from an mtu 
Engine ECU.  

mtu Pre-Alarms 
High Coolant 
Temp mtu Alarm 

True when a High Coolant Temperature Alarm 
has been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
High Coolant 
Temp mtu Pre-
Alarm 

True when a High Coolant Temperature Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
High Day Tank 
Level 

True when a High Fuel Level in the Day Tank 
Pre-Alarm has been received from an mtu 
Engine ECU.  

mtu Pre-Alarms 
High ECU Supply 
Voltage 

True when a High ECU Supply Voltage Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
High ECU Temp 

True when a High ECU Temperature Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
High Exhaust 
Temp A 

True when a High Exhaust Temperature in 
Exhaust System True when aPre-Alarm has 
been received from an mtu Engine ECU.  

mtu Pre-Alarms 
High Exhaust 
Temp B 

True when a High Exhaust Temperature in 
Exhaust System B Pre-Alarm has been 
received from an mtu Engine ECU.  

mtu Pre-Alarms 
High Fuel Filter 
Diff Pressure 

True when a High Fuel Filter Differential 
Pressure Pre-Alarm has been received from 
an mtu Engine ECU.  

mtu Pre-Alarms 
High Fuel Rail 
Pressure 

True when a High Fuel Rail Pressure Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
High Fuel Temp 

True when a High Fuel Temperature Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
High Intercooler 
Temperature 

True when a High Intercooler Temperature 
Pre-Alarm has been received from an mtu 
Engine ECU.  

mtu Pre-Alarms 
High Oil Temp 
mtu Alarm 

True when a High Oil Temperature Alarm has 
been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
High Oil Temp 
mtu Pre-Alarm 

True when a High Oil Temperature Pre-Alarm 
has been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
High Pressure In 
1 

True when a High Pressure Level in Pressure 
Input 1 Pre-Alarm has been received from an 
mtu Engine ECU.  
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mtu Pre-Alarms 
High Pressure In 
2 

True when a High Pressure Level in Pressure 
Input 2 Pre-Alarm has been received from an 
mtu Engine ECU.  

mtu Pre-Alarms 
High Storage 
Tank Level 

True when a High Fuel Level in the Storage 
Tank Pre-Alarm has been received from an 
mtu Engine ECU.  

mtu Pre-Alarms 
High Voltage 
Supply 

True when a High System Power Supply 
Voltage Pre-Alarm has been received from an 
mtu Engine ECU.  

mtu Pre-Alarms 
Idle Speed Low 

True when a Low Idle Speed Pre-Alarm has 
been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Low After Cooler 
Coolant Level 

True when a Low Aftercooler Coolant level 
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
Low Charge Air 
Coolant Level 

True when a Low Charge Air Coolant Level 
Pre-Alarm has been received from an mtu 
Engine ECU.  

mtu Pre-Alarms 
Low Charge Air 
Pressure 

True when a Low Charge Air Pressure Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
Low Coolant 
Level mtu Pre-
Alarm 

True when a Low Coolant Level Pre-Alarm has 
been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Low Day Tank 
Level 

True when a Low Fuel Level in the Day Tank 
Pre-Alarm has been received from an mtu 
Engine ECU.  

mtu Pre-Alarms 
Low ECU Supply 
Voltage 

True when a Low ECU Supply Voltage Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
Low Fuel Delivery 
Pressure mtu 
Alarm 

True when a Low Fuel Delivery Pressure 
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
Low Fuel Delivery 
Pressure mtu Pre-
Alarm 

True when a Low Fuel Delivery Pressure Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
Low Fuel Rail 
Pressure 

True when a Low Fuel Rail Pressure Pre-
Alarm has been received from an mtu Engine 
ECU.  

mtu Pre-Alarms 
Low Oil Pressure 
mtu Alarm 

True when a Low Oil Pressure Alarm has been 
received from an mtu Engine ECU. 
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mtu Pre-Alarms 
Low Oil Pressure 
mtu Pre-Alarm 

True when a Low Oil Pressure Pre-Alarm has 
been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Low Storage Tank 
Level 

True when a Low Fuel Level in the Storage 
Tank Pre-Alarm has been received from an 
mtu Engine ECU.  

mtu Pre-Alarms 
Low Voltage 
Supply 

True when a Low System Power Supply 
Voltage Pre-Alarm has been received from an 
mtu Engine ECU.  

mtu Pre-Alarms 
Overspeed 

True when an Overspeed Alarm has been 
received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Priming Fault 

True when a Fault in the Engine Priming 
System Pre-Alarm has been received from an 
mtu Engine ECU.  

mtu Pre-Alarms 
Run-Up Speed 
Low 

True when a Low Runup Speed Pre-Alarm has 
been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Shutdown 
Override 

True when a Shutdown Override Pre-Alarm 
has been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Speed Demand 
Fail 

True when a Speed Demand Fail Pre-Alarm 
has been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Start Speed Low 

True when a Low Start Speed Pre-Alarm has 
been received from an mtu Engine ECU. 

 

mtu Pre-Alarms 
Test Overspeed 
Active 

True when an Overspeed Test Active Pre-
Alarm has been received from an mtu Engine 
ECU.  

Oil Pressure 
Sender Fail 

True when the Oil Pressure Sender Fail is 
configured as a pre-alarm and the activation 
delay has expired.  

Regenerate 
Active 

True when an exhaust system regeneration is 
in progress. 

 

Sender Fail 
Coolant Temp 
Sender Fail 

True when the Coolant Temp Sender Fail is 
configured as a pre-alarm and the activation 
delay has expired.  

Sender Fail 
Fuel Level Sender 
Fail 

True when the Fuel Level Sender Fail is 
configured as a pre-alarm and the activation 
delay has expired.  

Sender Fail 
Oil Pressure 
Sender Fail 

True when the Oil Pressure Sender Fail is 
configured as a pre-alarm and the activation 
delay has expired.  

Sender Fail 
Voltage Sensing 
Fail 

True when the Voltage Sensing Fail is 
configured as a pre-alarm and the activation 
delay has expired.  
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Serial Flash Read 
Fail 

When the DGC-2020ES reads data from the 
serial flash, the data is read twice and then 
compared to verify that the data matches. If it 
does not match, the read cycle is repeated. 
After the second attempt, if the data does not 
match, the DGC-2020ES annunciates a serial 
flash read failure pre-alarm. This status input 
to logic indicates that the DGC-2020ES has 
detected a serial flash read failure. 

 

Service Tool 
Forced 
Regenerate 

A manual or forced regeneration is in progress 
and was initiated from a manufacturer’s service 
tool. This indication is received from the engine 
ECU over J1939 CAN Bus as SPN 4175 
Diesel Particulate Filter Active Regeneration 
Forced Status or SPN 6934 SCR System 
Cleaning Forced Status. When the value is 2, a 
Service Tool Forced Regenerate pre-alarm is 
annunciated. 

 

Switch Forced 
Regenerate 

A manual or forced regeneration is in progress 
and was initiated from a manual regeneration 
switch. This indication is received from the 
engine ECU over J1939 CAN Bus as SPN 
4175 Diesel Particulate Filter Active 
Regeneration Forced Status or SPN 6934 SCR 
System Cleaning Forced Status. When the 
value is 1, a Switch Forced Regenerate pre-
alarm is annunciated. 

 

Torque Limit True while the engine is running in a reduced 
torque mode due to exhaust system issues 
such as Low DEF, Purge Required, Exhaust 
System Error, etc. This reflects the status of 
the exhaust system Torque Limit lamp, which 
is communicated from the Engine ECU to the 
DGC-2020ES via J1939 CAN Bus 
communications. 

 

Torque Limit 
Severe 

True while the engine is running in a severely 
reduced torque mode due to exhaust system 
issues such as Low DEF, Purge Required, 
Exhaust System Error, etc. This reflects the 
status of the exhaust system Torque Limit 
lamp, which is communicated from the Engine 
ECU to the DGC-2020ES via J1939 CAN Bus 
communications. 

 

Voltage Sensing 
Fail 

True when the Voltage Sensing Fail is 
configured as a pre-alarm and the activation 
delay has expired.  

Weak Battery True when the Weak Battery Voltage Pre-
Alarm settings have been exceeded. 

 
Senders 
Coolant Temp 
Sender Fail 

True when the Coolant Temp Sender Fail is 
configured as either a pre-alarm or alarm and 
the activation delay has expired.  

Fuel Level Sender 
Fail 

True when the Fuel Level Sender Fail is 
configured as either a pre-alarm or alarm and 
the activation delay has expired.  
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Oil Pressure 
Sender Fail 

True when the Oil Pressure Sender Fail is 
configured as either a pre-alarm or alarm and 
the activation delay has expired.  

Speed Sender 
Fail 

True when the Speed Sender Fail activation 
delay has expired. 

 
Voltage Sensing 
Fail 

True when the Voltage Sensing Fail is 
configured as either a pre-alarm or alarm and 
the activation delay has expired.  

Logic Control Relays 

The logic control relays (LCR) consist of LCR outputs and LCR inputs. The output can be used to terminate the 
“output” end of a logic network, and then use the corresponding input as an input to logic elsewhere in the logic 
scheme. When a given LCR output is true the corresponding LCR input is true. In other words, when LCR Output 
N (N being a number from 1 to 16) becomes true, then LCR Input N is true also. 
If you get a “too many logic levels” error while building a logic network, LCR outputs and inputs can be used as a 
solution to this problem. Place an LCR output on the end of the partial logic network and then use the 
corresponding LCR input to build more logic than was previously possible. 
Inputs 
Input 1-16 

See description above. 

 
Outputs 
Output 1-16 

See description above. 

 

Components 
This group contains Logic Gates, Pickup and Dropout Timers, Latches, and Comment Blocks. Table 13-2 
lists the names and descriptions of the objects in the Components group. 

Table 13-2. Components Group, Names and Descriptions 
Name Description Symbol 

Logic Gates 
AND Input Output 

0 0 0 
0 1 0 
1 0 0 
1 1 1 

 

 

NAND Input Output 
0 0 1 
0 1 1 
1 0 1 
1 1 0 

 

 

OR Input Output 
0 0 0 
0 1 1 
1 0 1 
1 1 1 

 

 

NOR Input Output 
0 0 1 
0 1 0 
1 0 0 
1 1 0 
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XOR Input Output 

0 0 0 
0 1 1 
1 0 1 
1 1 0 

 
When an XOR gate has more than two inputs, the output is true 
whenever an odd number of inputs are true. 

 

XNOR Input Output 
0 0 1 
0 1 0 
1 0 0 
1 1 1 

 
When an XNOR gate has more than two inputs, the output is true 
whenever an even number of inputs are true. The output is also true if 
no inputs are true. 

 

NOT 
(INVERTER) 

Input Output 
0 1 
1 0 

  
Pickup and Dropout Timers 
Drop Out 
Timer 

Used to set a delay in the logic. 
For more information, refer to Programming BESTlogicPlus, Pickup 
and Dropout Timers, later in this section. 

 
Pickup Up 
Timer 

Used to set a delay in the logic. 
For more information, refer to Programming BESTlogicPlus, Pickup 
and Dropout Timers, later in this section. 

 
Latches 
Reset Priority 
Latch 

When the Set input is on and the Reset input is off, the latch will go to 
the SET (ON) state. When the Reset input is on and the Set input is 
off, the latch will go to the RESET (OFF) state. If both the Set and 
Reset inputs are on at the same time, a reset priority latch will go to the 
RESET (OFF) state. 

 
Set Priority 
Latch 

When the Set input is on and the Reset input is off, the latch will go to 
the SET (ON) state. When the Reset input is on and the Set input is 
off, the latch will go to the RESET (OFF) state. If both the Set and 
Reset inputs are on at the same time, a set priority latch will go to the 
SET (ON) state. 

 
Other 
Comment 
Block 

Enter user comments. 
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Elements 
This group contains elements for the 27, 47, 50, 59, and 81. It also contains elements for Generator 
Breaker, Mains Breaker, Logic Alarm, Logic Pre-Alarm, Configurable Elements, AUTO Mode, OFF Mode, 
RUN Mode, Run with Load, Engine Run, ATS, Run Inhibit, Test Inhibit, Pre-Start Output, Start Output, 
Run Output, Cool Stop Request, Cool Down Request, External Start Delay, Start Delay Bypass, Alternate 
Frequency Override, Mains Fail Test, Load Take Over, EPS Supplying Load, mtu Speed Demand Switch, 
Reset, Alarm Silence, Lamp Test, Idle Request, Low Fuel Pre-Alarm, Diesel Particulate Filter Manual 
Regeneration, Diesel Particulate Filter Regeneration Inhibit, Emergency Stop, Speed Raise, Speed 
Lower, mtu Cylinder Cutout Disable, and Automatic Breaker Operation Inhibit from PLC. 

Table 13-3 lists the names and descriptions of the elements in the Elements group. 
Table 13-3. Elements Group, Names and Descriptions 

Name Description Symbol 
Protection 
27TRIP True when the 27-1 undervoltage is in a TRIP condition. 

Connect to another logic block input. 

 
47TRIP True when the 47 phase imbalance is in a TRIP 

condition. Connect to another logic block input. 

 
50TRIP True when the 50 overcurrent is in a TRIP condition. 

Connect to another logic block input. 

 
59TRIP True when the 59-1 overvoltage is in a TRIP condition. 

Connect to another logic block input. 

 
81TRIP True when the 81 frequency is in a TRIP condition. 

Connect to another logic block input. 

 
Other 
ALARMSILENCE The alarm will be silenced when this element is true. The 

alarm can also be silenced by pressing the Alarm Silence 
button on the front panel of the DGC-2020ES. 

 
ALTFREQOVER When this logic element is true, protection and bus 

condition detection is forced to operate at the Alternate 
Frequency instead of the Rated Frequency. 
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Name Description Symbol 
ATS When this logic element is true, and the DGC-2020ES is 

in AUTO mode, the generator will run. This can be used 
in place of the ATS programmable function if it is desired 
to generate the ATS signal as a combination of 
programmable logic rather than a simple contact input. If 
either the ATS logic element is true or the contact 
mapped to the ATS programmable function is true, and 
the DGC-2020ES is in AUTO mode, the generator will 
run. If both the ATS logic element and the ATS 
programmable function are false, and the DGC-2020ES 
is in AUTO mode, the generator will cool down and stop. 

 

AUTOMODE When this input is true, and the DGC-2020ES is in OFF 
mode, the DGC-2020ES will switch to AUTO mode. This 
is a pulsed input. It does not need to be held after the 
desired mode switch has occurred. 

 
AUTOBRKOP-
INHIBIT 

Automatic breaker operation is inhibited when the Set 
input is true. 

 
CONFELMNTX 
(X = 1 to 8) 

Configurable elements (CONFELMNT1-8) are connected 
to the logic scheme as outputs. These elements are 
configurable in BESTCOMSPlus under Programmable 
Outputs, Configurable Elements. The user can assign a 
string of up to 16 characters, configure whether the 
element should generate an alarm or pre-alarm. If used 
for alarm or pre-alarm, the user's text is what will appear 
in the alarm or pre-alarm annunciation and in the DGC-
2020ES event log. 

 

COOLSTOPREQ RUN Mode 
If the unit is in RUN mode when the Cool Stop Request is 
received, the unit will unload, open its breaker, and go 
into a cooldown cycle. While in the cooldown cycle, the 
unit will display “COOL & STOP REQ” in addition to 
displaying the cooldown timer. After the cooldown timer 
expires, the unit will go to OFF mode. The Cool Stop 
Request must be removed before the unit can be run 
again. 
If the Cool Stop Request is removed during the cooldown 
process, the unit will remain running. Furthermore, if a 
condition occurs that normally causes the unit to close its 
breaker in RUN mode, the unit will close its breaker and 
reload. 
AUTO Mode 
If the unit is in AUTO mode when the Cool Stop Request 
is received, all conditions that would normally cause the 
unit to run in AUTO mode are cleared. Since all 
conditions that cause the unit to run have been removed, 
the unit goes into a cooldown cycle. While in the 
cooldown cycle, the unit will display “COOL & STOP 
REQ” in addition to displaying the cooldown timer. After 
the cooldown timer expires, the unit will shut down, 
remaining in AUTO. The Cool Stop Request must be 
removed before the unit can be run again. 
If the Cool Stop Request is removed during the cooldown 
process and some condition that would normally cause 
the unit to run in AUTO mode is true, the unit will remain 
running. Furthermore, if a condition occurs that normally 
causes the unit to close its breaker, the unit will close its 
breaker and reload. 
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Name Description Symbol 
COOLDOWNREQ RUN Mode 

If the unit is in RUN mode when the Cool Down Request 
is received, the unit is forced to unload and open its 
breaker and then go into a cooldown cycle. While in the 
cool down cycle, the unit will display “COOLDOWN REQ” 
in addition to displaying the cooldown timer. After the 
cooldown timer expires, the unit will remain running in 
RUN mode. The Cool Down Request must be removed 
before the breaker can be closed again; this element 
blocks breaker closures. 
If the Cool Down Request is removed during the cool 
down process, the unit will remain running in RUN mode. 
Furthermore, if a condition occurs that normally causes 
the unit to close its breaker in RUN mode, the unit will 
close its breaker and reload. 
AUTO Mode 
If the unit is in AUTO mode and the Cool Down Request 
is received, the unit is forced to unload and open its 
breaker and go into a cooldown cycle. While in the 
cooldown cycle, the unit will display “COOLDOWN REQ” 
in addition to displaying the cooldown timer. After the cool 
down timer expires, the unit will remain running in AUTO 
mode, unless there are no conditions that cause the unit 
to run in AUTO mode, in which case it will shut down and 
remain in AUTO mode. The Cool Down Request must be 
removed before the breaker can be closed again; this 
element blocks breaker closures. 
If the Cool Down Request is removed during the cool 
down process and some condition that would normally 
cause the unit to run in AUTO mode is true, the unit will 
remain running in AUTO mode. Furthermore, if a 
condition occurs that normally causes the unit to close its 
breaker, the unit will close its breaker and reload. 

 

CYLCUTOUTENABLE 
(Cutout Enable 
Override) 

When true, cylinder cutout is enabled. When false, 
cylinder cutout is disabled when any of the following are 
true: 

• Synchronization is in progress. 
• The machine is operating with the generator 

breaker closed. 
• The Cylinder Cutout Disable setting is true. 
• The Cylinder Cutout Disable logic element is 

true. 

 

DPFMANREGEN Diesel Particulate Filter Regeneration is forced manually 
when the Set input is true. 

 
DPFREGENINHIBIT Diesel Particulate Filter Regeneration is inhibited when 

the Set input is true. 

 
ECU Connect 
Override 

When true, a Key On signal is applied to the ECU and 
CAN Bus data is updated any time except during the 
Disconnecting state. 
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Name Description Symbol 
ENGINERUN The Start input starts the generator. No load is applied. 

The breaker remains open. The Stop input stops the 
generator. The DGC-2020ES only responds to this logic 
element when in AUTO mode. 

 
EPSSUPPLYINGLD When true, the Set input forces a supplying load 

indication. This is useful when it is necessary for the 
supplying load indication to be true during test runs, but 
the system load is not enough to light the supplying load 
indication. 

A supplying load indication is true when the supplying 
load logic element is true and the generator is stable 
(voltage and frequency are within the limits programmed 
on the Gen Condition Detection screen under Breaker 
Management, Bus Condition Detection in the 
BESTCOMSPlus Settings Explorer). This is OR’ed with 
the traditional supplying load criteria that supplying load 
is true when the generator current is above a percentage 
of CT primary current (typically 3% minimum). 

When the supplying load indication has been driven from 
logic or from generator current levels, the DGC-2020ES 
will go through a cool down cycle when it is in AUTO 
mode and the ATS contact has been removed. 

 

ESTOP When this element is true, an Emergency Shutdown 
alarm is annunciated and the Emergency Stop LED on 
the RDP-110 is illuminated. 

 
EXTSTARTDEL If the Set input is true while the DGC-2020ES is in the 

Pre Start state, the DGC-2020ES will remain in the Pre 
Start state until the Set input is false. 
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Name Description Symbol 
GENBRK This element is used to connect the breaker open and 

close output signals from the DGC-2020ES to physical 
output contacts to open and close the generator breaker, 
and map breaker status feedback to a contact input. In 
addition, contact inputs can be mapped to allow switches 
to be implemented to manually initiate breaker open and 
close requests. 
Inputs 
Status: This input allows a contact input to be mapped 
that will provide breaker status feedback to the DGC-
2020ES. When the contact input is closed, the breaker is 
indicated to be closed. When the contact input is open, 
the breaker is indicated to be open. 
Open: This input allows a contact input to be mapped that 
can be used to initiate a manual breaker open request. 
When this input is pulsed closed while the DGC-2020ES 
is in RUN or AUTO mode, the breaker will open. 
Close: This input allows a contact input to be mapped 
that can be used to initiate a manual breaker close 
request. When this input is pulsed and the DGC-2020ES 
is in AUTO or RUN mode, and the generator is stable, a 
close request will be initiated. If bus is dead, the breaker 
will close; if the bus is not dead the generator breaker will 
not be closed. 
Outputs 
The outputs must be mapped to the contact outputs of 
the DGC-2020ES that will be used to drive the breaker. 
Open: This output is pulsed true (closes the output 
contact it is mapped to) when the DGC-2020ES is 
providing a signal to the breaker to open. It will be a pulse 
if the Breaker Output Contact Type is set to Pulse on the 
Breaker Hardware screen under Breaker Management in 
the Settings Explorer, and the length is determined by the 
Open Pulse Time. It will be a constant output if the 
Generator Breaker Hardware Contact Type is set to 
continuous. Note the pulse time must be set long enough 
for the breaker to actually open before the pulse is 
removed. 
Close: This output is pulsed true (closes the output 
contact it is mapped to) when the DGC-2020ES is 
providing a signal to the breaker to close. It will be a 
pulse if the Breaker Output Contact Type is set to Pulse 
on the Breaker Hardware screen under Breaker 
Management in the Settings Explorer, and the length is 
determined by the Open Pulse Time. It will be a constant 
output if the Generator Breaker Hardware Contact Type 
is set to continuous. Note the pulse time must be set long 
enough for the breaker to actually open before the pulse 
is removed. 

 

IDLEREQUEST When this element is true, the DGC-2020ES sends an 
idle request to the ECU on J1939 engines that are 
equipped to receive such a request. The request consists 
of an enable bit command and an idle RPM setting. At 
this time, only Volvo and Cummins are implemented. 
ECUs that accept the idle RPM setting set the engine to 
the requested RPM. ECUs that accept only the enable bit 
command, set the engine to their internal idle speed 
setting, ignoring the requested idle RPM from the DGC-
2020ES. 
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LAMPTEST The lamp test will be performed when this element is 

true. The lamp test can also be accomplished by 
simultaneously pressing the Up and Down buttons on the 
front panel of the DGC-2020ES. 

 
LOADTAKEOVER When this logic element is true, the generator is forced to 

start, assume load, and disconnect from the mains, in an 
open transition. 

 
LOGICALM When this input is true, the DGC-2020ES goes into an 

alarm condition. 

 
LOGICPALM When this input is true, the DGC-2020ES goes into a 

Pre-alarm condition. 

 
LOWFUELPALM When this element is true, a Low Fuel Pre-Alarm is 

annunciated and the Low Fuel Level LED on the RDP-
110 is illuminated. 

 
MAINSFAILTEST When this element is true, the DGC-2020ES will exercise 

its mains fail transfer function exactly as it would if the 
mains were to fail on a mains fail machine. This can be 
used as a test of the mains fail transfer capability of the 
unit without having to cause a true mains failure.  

MAINSFLTRINHIBIT The mains fail transfer function is inhibited when the Set 
input is true. 
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Name Description Symbol 
MAINSBRK This element is used to connect the breaker open and 

close output signals from the DGC-2020ES to physical 
output contacts to open and close the mains breaker and 
map breaker status feedback to a contact input. In 
addition, contact inputs can be mapped to allow switches 
to be implemented to manually initiate breaker open and 
close requests. 
This element is only available when the Mains Breaker 
Hardware in configured on the Breaker Hardware screen 
via the Breaker Management tree branch. 
Inputs 
Status: This input allows a contact input to be mapped 
that will provide breaker status feedback to the DGC-
2020ES. When the contact input is closed, the breaker is 
indicated to be closed. When the contact input is open, 
the breaker is indicated to be open. 
Open: This input allows a contact input to be mapped that 
can be used to initiate a manual breaker open request. 
When this input is pulsed closed while the DGC-2020ES 
is in RUN or AUTO mode, the breaker will open. 
Close: This input allows a contact input to be mapped 
that can be used to initiate a manual breaker close 
request. When this input is pulsed, the mains is stable, 
and both breakers are open, a close request will be 
initiated. 
Outputs 
The outputs must be mapped to the contact outputs of 
the DGC-2020ES that will be used to drive the breaker. 
Open: This output is pulsed true (closes the output 
contact it is mapped to) when the DGC-2020ES is 
providing a signal to the breaker to open. It will be a pulse 
if the Breaker Output Contact Type is set to Pulse on the 
Breaker Hardware screen under Breaker Management in 
the Settings Explorer, and the length is determined by the 
Open Pulse Time. It will be a constant output if the Mains 
Breaker Hardware Contact Type is set to continuous. 
Note the pulse time must be set long enough for the 
breaker to actually open before the pulse is removed. 
Close: This output is pulsed true (closes the output 
contact it is mapped to) when the DGC-2020ES is 
providing a signal to the breaker to close. It will be a 
pulse if the Breaker Output Contact Type is set to Pulse 
on the Breaker Hardware screen under Breaker 
Management in the Settings Explorer, and the length is 
determined by the Open Pulse Time. It will be a constant 
output if the Mains Breaker Hardware Contact Type is set 
to continuous. Note the pulse time must be set long 
enough for the breaker to actually open before the pulse 
is removed. 

 

mtuCYLCUTOUT-
DISABLE 
(mtu Cylinder Cutout 
Disable) 

When this logic element is true, Cylinder Cutout Disable 1 
and Cylinder Cutout Disable 2 are both sent to the engine 
ECU with true status. When this logic element is false, 
Cylinder Cutout Disable 1 and Cylinder Cutout Disable 2 
are sent to the engine ECU with states set by the values 
programmed for the Cylinder Cutout Disable 1 and 
Cylinder Cutout Disable 2 DGC-2020ES settings which 
are configured on the ECU Setup screen in 
BESTCOMSPlus. 
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Name Description Symbol 

mtuSPDDMDSW This logic element can be used to specify the Speed 
Demand Source parameter value that is sent to an mtu 
Engine ECU. When no input is true, the value sent to the 
engine ECU is the value specified in the Speed Demand 
Source setting in the ECU configuration setting. If an 
input on this logic element is true, the selected Speed 
Demand Source will be sent rather than the value 
specified by the Speed Demand Source setting. 
If multiple inputs are true at the same time, the input that 
is closest to the top of the logic element symbol will 
specify the Speed Demand Source parameter value that 
is sent to the ECU. 
Analog CAN: This input configures the mtu ECU to 
accept speed bias requests over J1939 CAN Bus from 
the DGC-2020ES. 
Up Down ECU: This input configures the mtu ECU to 
accept speed raise/lower commands via contact inputs 
on the ECU. 
Up Down CAN: This input configures the mtu ECU to 
accept speed raise/lower commands via communications 
over J1939 CAN Bus. 
Analog ECU: This input configures the mtu ECU to 
accept speed bias via bias voltage input connections on 
the ECU. 
Frequency: This configures the mtu ECU to accept speed 
commands via a frequency signal input on the ECU. The 
mapping of input signal frequency to machine speed is 
configured in a curve within the engine ECU. 
No CAN Demand: This input configures the mtu ECU to 
disregard all speed requests or speed raise/lower 
requests from J1939 CAN Bus. 

 

OFFMODE When this input is true, the DGC-2020ES will switch to 
OFF mode. This is a pulsed input. It does not need to be 
held after the desired mode switch has occurred. 

 
PRESTARTOUT This element is used to drive the prestart output relay 

from logic when the Prestart Output Relay configuration 
is set to “Programmable”. When the Prestart Output 
Relay configuration is set to “Programmable”, the prestart 
relay will not close unless logic is used to drive this 
element. When the Prestart Output Relay configuration is 
set to “Predefined”, the prestart relay is closed according 
to the predefined prestart functionality of the DGC-
2020ES. When the “Predefined” functionality is selected, 
the relay will not respond to this element. 

 

Rapid Start Override When true, this element sets the Start mode to Rapid 
regardless of the Start mode setting. 

 

RDPPROGALM1 When true, this element illuminates the Fuel Leak/Sender 
Failure LED on the Remote Display Panel RDP-110. 
When this element is connected in logic, it overrides all 
other commands to the LED. Otherwise, the LED 
operates as normal.  
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RDPPROGALM2 When true, this element illuminates the Sender Failure 

LED on the Remote Display Panel RDP-110. When this 
element is connected in logic, it overrides all other 
commands to the LED. Otherwise, the LED operates as 
normal.  

RDPPROGPREALM1 When true, this element illuminates the Battery 
Overvoltage LED on the Remote Display Panel RDP-110. 
When this element is connected in logic, it overrides all 
other commands to the LED. Otherwise, the LED 
operates as normal.  

RDPPROGPREALM2 When true, this element illuminates the Battery Charger 
Failure LED on the Remote Display Panel RDP-110. 
When this element is connected in logic, it overrides all 
other commands to the LED. Otherwise, the LED 
operates as normal.  

RESET Reset will be active when this element is true. Reset can 
also be accomplished by pressing the Reset button on 
the front panel of the DGC-2020ES. 

 
RUNINHIBIT When this logic element is true, the DGC-2020ES is 

prevented from starting and running the generator, 
regardless of any condition that would normally cause the 
generator to run. If this element is false and there is any 
condition in effect which will cause the generator to run, 
the DGC-2020ES will start and run the generator. 

 

RUNMODE When this input is true, and the DGC-2020ES is in OFF 
mode, the DGC-2020ES will switch to RUN mode. This is 
a pulsed input. It does not need to be held after the 
desired mode switch has occurred. 

 
RUNOUTPUT This element is used to drive the run output relay from 

logic when the Run Output Relay configuration is set to 
“Programmable”. When the Run Output Relay 
configuration is set to “Programmable”, the run relay will 
not close unless logic is used to drive this element. When 
the Run Output Relay configuration is set to “Predefined”, 
the run relay is closed according to the predefined run 
functionality of the DGC-2020ES. When the “Predefined” 
functionality is selected, the relay will not respond to this 
element. 

 

RUNWLOAD The Start input starts the generator and closes the Gen 
breaker. The Stop input stops the generator and opens 
the Gen breaker. The DGC-2020ES only responds to this 
logic element when in AUTO mode. 

 
SPEEDLOWER This element lowers the speed setting of the DGC-

2020ES by up to 2 rpm per second. After the speed has 
not been lowered for 30 seconds, the modified speed is 
saved to nonvolatile memory. 

 
SPEEDRAISE This element raises the speed setting of the DGC-

2020ES by up to 2 rpm per second. After the speed has 
not been raised for 30 seconds, the modified speed is 
saved to nonvolatile memory. 
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STARTDELBYP This element allows the Pre Start state to be skipped 

based on logic. For example, a start delay may not be 
necessary when the engine is warm. This also allows an 
external device, such as an ECU, to control the pre start 
interval.   

STARTOUTPUT This element is used to drive the start output relay from 
logic when the Start Output Relay configuration is set to 
“Programmable”. When the Start Output Relay 
configuration is set to “Programmable”, the start relay will 
not close unless logic is used to drive this element. When 
the Start Output Relay configuration is set to 
“Predefined”, the start relay is closed according to the 
predefined start functionality of the DGC-2020ES. When 
the “Predefined” functionality is selected, the relay will not 
respond to this element. 

 

TESTINHIBIT When this logic element is true, the generator exercise 
timer cannot start the generator. If the TESTINHIBIT logic 
function is false during an exercise period, or transitions 
from true to false at any time during an exercise period, 
the DGC-2020ES will start and run the generator for the 
duration of the exercise period. 

 

Logic Schemes 

A logic scheme is a group of logic variables written in equation form that defines the operation of a DGC-
2020ES Digital Genset Controller. Each logic scheme is given a unique name. This gives you the ability 
to select a specific scheme and be confident that the selected scheme is in operation. One logic scheme 
is configured for typical control applications and is the default active logic scheme. Only one logic scheme 
can be active at a given time. In most applications, preprogrammed logic schemes eliminate the need for 
custom programming. Preprogrammed logic schemes may provide more inputs, outputs, or features than 
are needed for a particular application. This is because a preprogrammed scheme is designed for a large 
number of applications with no special programming required. Unneeded logic block outputs may be left 
open to disable a function or a function block can be disabled through operating settings. 

When a custom logic scheme is required, programming time is reduced by modifying the default logic 
scheme. 

The Active Logic Scheme 
Digital Genset Controllers must have an active logic scheme in order to function. All Basler Electric DGC-
2020ES units are delivered with a default, active logic scheme pre-loaded in memory. If the function block 
configuration and output logic of the default logic scheme meets the requirements of your application, 
then only the operating settings (power system parameters and threshold settings) need to be adjusted 
before placing the DGC-2020ES in service. 

Copying and Renaming Preprogrammed Logic Schemes 
Copying a saved logic scheme to the active logic and assigning a unique name is accomplished by 
loading the saved logic scheme into BESTCOMSPlus and then typing over the logic scheme's name. 
Changes are not activated until the new settings have been saved and uploaded to the device. 

Sending and Retrieving Logic Schemes 
To retrieve settings from the DGC-2020ES, it must be connected to a computer through a 
communications port. Once the necessary connections are made, settings can be downloaded from the 
DGC-2020ES by selecting Download Settings and Logic on the Communication pull-down menu. 
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To send settings to the DGC-2020ES, it must be connected to a computer through a communications 
port. Once the necessary connections are made, settings can be uploaded to the DGC-2020ES by 
selecting Upload Settings and Logic on the Communication pull-down menu. 

 

Caution 
Always remove the DGC-2020ES from service prior to changing or 
modifying the active logic scheme. Attempting to modify a logic 
scheme while the DGC-2020ES is in service could generate 
unexpected or unwanted outputs. 

Modifying a logic scheme in BESTCOMSPlus does not automatically 
make that scheme active in the DGC-2020ES. The modified scheme 
must be uploaded into the DGC-2020ES. 

Programming BESTlogic™Plus 

Use BESTCOMSPlus to program BESTlogicPlus. Using BESTCOMSPlus is analogous to physically 
attaching wire between discrete DGC-2020ES terminals. To program BESTlogicPlus, use the Settings 
Explorer within BESTCOMSPlus to open the BESTlogicPlus Programmable Logic tree branch as shown 
in Figure 13-1. 

The drag and drop method is used to connect a variable or series of variables to the logic inputs, outputs, 
components, and elements. To draw a wire/link from port to port (triangles), click the left mouse button on 
a port, pull the wire onto another port, and release the left mouse button. A red port indicates that a 
connection to the port is required or missing. A black port indicates that a connection to the port is not 
required. Drawing wires/links from input to input or output to output is not allowed. Only one wire/link can 
be connected to any one output. If the proximity of the endpoint of the wire/link is not exact, it may attach 
to an unintended port. 

If an object or element is disabled, it will have a yellow X on it. To enable the element, navigate to the 
settings page for that element. A red X indicates that an object or element is not available per the style 
number of the DGC-2020ES. 

The view of the Main Logic, Physical Outputs, Remote Outputs, and LCR Outputs can be automatically 
arranged by clicking the right mouse button on the window and selecting Auto-Layout. 

The following must be met before BESTCOMSPlus will allow logic to be uploaded to the DGC-2020ES: 

• A minimum of two inputs and a maximum of four inputs on any multi-port (AND, OR, NAND, 
NOR, XOR, and XNOR) gate. 

• A maximum of five logic levels for any particular path. A path being an input block or an output 
side of an element block through gates to an output block or an input side of an element block. 
This is to include any OR gates on the Physical Output or Remote Output tab/pages, but not the 
matched pairs of Physical Output blocks or Remote Output blocks. 

• Only 20 gates per logic level. All output blocks and input sides of element blocks are at the 
maximum logic level of the diagram. All gates are pushed forward/upwards in logic levels and 
buffered to reach the final output block or element block if needed. A maximum of 50 gates 
allowed per diagram. 

• At all levels there can only be 64 used link/wired or endpoints. Endpoints being inputs, outputs, 
both sides of element blocks. 

Three status indicators are located in the lower right corner of the BESTlogicPlus window. These 
indicators show the Logic Save Status, Logic Diagram Status, and Logic Layer Status. Table 13-4 defines 
the colors for each indicator. 
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Table 13-4. Status Indicators 

Indicator Color Definition 

Logic Save Status 
(Left Indicator) 

  Amber Logic has changed since last save. 

  Green Logic has NOT changed since last save. 

Logic Diagram Status 
(Center Indicator) 

  Red Requirements NOT met as listed above. 

  Green Requirements met as listed above. 

Logic Layer Status 
(Right Indicator) 

  Red Requirements NOT met as listed above. 

  Green Requirements met as listed above. 

Pickup and Dropout Timers 
A pickup timer produces a true output when the elapsed time is greater than or equal to the Pickup Time 
setting after a false to true transition occurs on the Initiate input from the connected logic. Whenever the 
Initiate input status transitions to false, the output transitions to false immediately. 

A drop out timer produces a true output when the elapsed time is greater than or equal to the Dropout 
Time setting after a true to false transition occurs on the Initiate input from the connected logic. Whenever 
the Initiate input transitions to true, the output transitions to false immediately. Refer to Figure 13-2. 

To program logic timer settings, use the Settings Explorer within BESTCOMSPlus to open the 
BESTlogicPlus Programmable Logic/Logic Timers tree branch. Enter a Name label that you want to 
appear on the timer logic block. The Time Delay value range is 0 to 250 hours in 1 hour increments, 0 to 
250 minutes in 1 minute increments, or 0 to 1,800 seconds in 0.1 second increments. 

Next, open the Components tab inside the BESTlogicPlus window and drag a timer onto the program 
grid. Right click on the timer to select the timer you want to use that was previously set on the Logic 
Timers tree branch. The Logic Timer Properties Dialog Box will appear. Select the timer you want to use. 

Timing accuracy is ±15 milliseconds. 

 
Figure 13-2. Pickup and Dropout Timer Logic Blocks 

Offline Logic Simulator 

The offline logic simulator allows you to change the state of various logic elements to illustrate how that 
state travels through the system. Before running the logic simulator, you must click the Save button on 
the BESTlogicPlus toolbar to save the logic to memory. Changes to the logic (other than changing the 
state) are disabled when the simulator is enabled. Colors are selected by clicking the Options button on 
the BESTlogicPlus toolbar. By default, Logic 0 is red and Logic 1 is green. Using your mouse, double-
click on a logic element to change its state. 

An example of the offline logic simulator is shown in Figure 13-3. Output 1 is Logic 0 (red) when Virtual 
Switch 1 is Logic 0 (red) and Fixed 1 is Logic 1 (green). 
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Figure 13-3. Offline Logic Simulator Example 

BESTlogic™Plus File Management 

To manage BESTlogicPlus files, use the Settings Explorer to open the BESTlogicPlus Programmable 
Logic tree branch. Use the BESTlogicPlus Programmable Logic toolbar to manage BESTlogicPlus files. 
Refer to Figure 13-4. For information on Settings Files management, refer to the BESTCOMSPlus 
chapter. 

 
Figure 13-4. BESTlogicPlus Programmable Logic Toolbar 

Saving a BESTlogicPlus File 
After programming BESTlogicPlus settings, click on the Save button to save the settings to memory.  

Before the new BESTlogicPlus settings can be uploaded to the DGC-2020ES, you must select Save from 
the File pull-down menu located at the top of the BESTCOMSPlus main shell. This step will save both the 
BESTlogicPlus settings and the operating settings to a file. 

The user also has the option to save the BESTlogicPlus settings to a unique file that contains only 
BESTlogicPlus settings. Click on the Logic Library drop-down button and select Save Logic Library File. 
Use normal Windows® techniques to browse to the folder where you want to save the file and enter a 
filename. 

Opening a BESTlogicPlus File 
To open a saved BESTlogicPlus file, click on the Logic Library drop-down button on the BESTlogicPlus 
Programmable Logic toolbar and select Open Logic Library File. Use normal Windows techniques to 
browse to the folder where the file is located. 

Protecting a BESTlogicPlus File 
Objects in a logic diagram can be locked so that when the logic document is protected these objects 
cannot be changed. Locking and protecting is useful when sending logic files to other personnel to be 
modified. The locked object(s) cannot be changed. To view the lock status of the object(s), select Show 
Lock Status from the Protection drop-down menu. To lock object(s), use the mouse to select object(s) to 
be locked. Right click on the selected object(s) and select Lock Object(s). The gold colored padlock next 
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to the object(s) will change from an open to a locked state. To protect a logic document, select Protect 
Logic Document from the Protection drop-down button. A password is optional.  

Uploading a BESTlogicPlus File 
To upload a BESTlogicPlus file to the DGC-2020ES, you must first open the file through BESTCOMSPlus 
or create the file using BESTCOMSPlus. Then pull down the Communication menu and select Upload 
Logic. 

Downloading a BESTlogicPlus File 
To download a BESTlogicPlus file from the DGC-2020ES, you must pull down the Communication menu 
and select Download Logic. If the logic in your BESTCOMSPlus has changed, a dialog box will open 
asking you if want to save the current logic changes. You may choose Yes or No. After you have taken 
the required action to save or not save the current logic, the downloading is executed. 

Printing a BESTlogicPlus File 
To view a preview of the printout, click on the Print Preview icon located on the BESTlogicPlus 
Programmable Logic toolbar. If you wish to print to a printer, select the printer icon in the upper left corner 
of the Print Preview screen. 

You may skip the print preview and go directly to print by clicking on the Printer icon on the 
BESTlogicPlus Programmable Logic toolbar. A dialog box, Select Views to Print opens allowing you to 
check which views you would like to print. Next, the Print dialog box opens with the typical Windows 
choice to setup the properties of printer. Execute this command, as necessary, and then select Print. 

A Page Setup icon is also provided on the BESTlogicPlus Programmable Logic toolbar allowing you to 
select Paper Size, Paper Source, Orientation, and Margins. 

Clearing the On-Screen Logic Diagram 
Click on the Clear button to clear the on-screen logic diagram and start over. 

BESTlogic™Plus Examples 

Example 1 - GENBRK Logic Block Connections 
Figure 13-5 illustrates the GENBRK logic block, three input logic blocks, and two output logic blocks. 
Output 3 is active while the GENBRK is sending an “open breaker” command and Output 4 is active while 
the GENBRK is sending the “close breaker” command. 

 
Figure 13-5. Example 1 – GENBRK Logic Block Connections 

Example 2 - AND Gate Connections 
Figure 13-6 illustrates a typical AND gate connection. In this example, Output 11 will become active when 
the Low Fuel alarm AND the Low Oil Pressure alarm are true. 
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Figure 13-6. Example 2 – AND Gate Connections 

Example 3 - Multiple Logic Connections 
In this example, there are two comment boxes, which may be placed on the logic diagram. Double-click a 
comment box to modify the inside text. Output 3 becomes true when the 27TRIP is true. Output 1 
becomes true when the High Coolant Temp is true. Output 2 becomes true when the DGC-2020ES is in 
RUN mode (RUN Mode true). Refer to Figure 13-7. 

 
Figure 13-7. Example 3 – Multiple Logic Connections   
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14 • Exhaust Treatment 
Diesel Particulate Filter (DPF) 

In order to meet Tier 4 emission requirements, some engine manufacturers are applying Diesel 
Particulate Filters (DPF) to the exhaust system of the engine. A Diesel Particulate Filter traps particulate 
matter contained in diesel exhaust and prevents it from distributing into the air. The particulate matter is 
later burned off during a regeneration process. 

The DGC-2020ES communicates DPF control and status information to and from the engine ECU via 
J1939 communications in the form of various Parameter Group Numbers (PGN) and Suspect Parameter 
Numbers (SPN). These are summarized in the following paragraphs. 

Regeneration 
Regeneration is accomplished by operating the engine at elevated exhaust temperatures where the 
accumulated particulate is burned off. If, in normal operation, the engine can be loaded to a high enough 
level to achieve the elevated exhaust temperature, then regeneration can occur as a part of normal 
operation. This is known as passive regeneration. 

High exhaust temperatures can also be accomplished by methods such as providing dampers in the 
exhaust stream or heating the exhaust through the burning of fuel. This is known as active regeneration 
since it is outside of normal engine operation. 

Heavily loaded engines will seldom require active regeneration. A lightly loaded engine will likely undergo 
active regeneration when regeneration is required. 

DPF Control 
DPF control information is sent from the DGC-2020ES to the Engine ECU through PGN Number 57244 
(0xE000). A manual regeneration request is sent using SPN 3695, Diesel Particulate Filter Regeneration 
Force Switch. Regeneration can be inhibited by SPN 3695, Diesel Particulate Filter Regeneration Inhibit 
Switch. 

Manual Regeneration 

The operator can force a regeneration cycle by turning on the Manual Regeneration setting found on the 
front panel under Settings > Communication > CANBus Setup > ECU Setup > DPF Regenerate Setup. 
The parameter will remain on for a few seconds then go off. The ECU will respond to the momentary 
setting by logging the request to force a manual regeneration. A continuous request is not used because 
this can be problematic for some engine ECUs. 

Manual regeneration can also be initiated by clicking the Manual Regeneration button on the ECU Setup 
screen in BESTCOMSPlus®. BESTlogic™Plus programmable logic can also be used to initiate manual 
regeneration by setting the DPF Manual Regeneration (DPFMANREGEN) logic element true. 

Regeneration Inhibit 

The operator can inhibit regeneration by turning on the DPF Regeneration Disable setting found on the 
ECU Setup screen in BESTCOMSPlus. 

Regeneration can also be disabled by turning on the Disable Regeneration setting on the ECU Setup 
screen in BESTCOMSPlus. 

BESTlogicPlus programmable logic can also be used to inhibit regeneration by setting the DPF 
Regeneration Inhibit (DPFREGENINHIBIT) logic element true. 
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DPF Status and Pre-Alarms 
The DGC-2020ES receives DPF status information which is broadcast from the engine ECU in various 
Parameter Group Numbers (PGN) and Suspect Parameter Numbers (SPN). The DGC-2020ES displays 
this information on the front panel, and in BESTCOMSPlus, via DPF related pre-alarms. The J1939 
parameters and the resulting DGC-2020ES pre-alarms are summarized in the following paragraphs. 

• PGN 64892 (0xFD7C) Diesel Particulate Filter Control 1 

o SPN 3697, Diesel Particulate Filter Lamp Command 

DPF REGEN REQUIRED Pre-Alarm: When SPN 3697 has a 
value of 1 or 4 indicating the DPF lamp is on, the DGC-2020ES 
will annunciate a pre-alarm with text of DPF REGEN REQUIRED. 
The DPF symbol, shown to the right, will accompany the text 
when the pre-alarm appears on the DGC-2020ES front panel.  

o SPN 3698, Exhaust System High Temperature Lamp Command 

HIGH EXHAUST TEMP Pre-Alarm: When SPN 3698 has a value 
of 1 indicating the high exhaust temperature lamp is on, the DGC-
2020ES will annunciate a pre-alarm with text of HIGH EXHAUST 
TEMP. The high exhaust temperature symbol, shown to the right, 
will accompany the text when the pre-alarm appears on the DGC-
2020ES front panel.  

o SPN 3701 Aftertreatment Diesel Particulate Filter Status 

SPN 3701 indicates that regeneration is required at the lowest level, moderate level, or most 
severe level. The DGC-2020ES uses this parameter for DPF Soot Level Pre-alarms which 
are described in the following paragraphs. 

o SPN 3703 Diesel Particulate Filter Active Regeneration Inhibited Due to Inhibit Switch 

DPF REGEN INHIBITED Pre-Alarm: When SPN 3703 has a value 
of 1 indicating the DPF Regeneration is inhibited due to the inhibit 
switch being set, the DGC-2020ES will annunciate a pre-alarm 
with text of DPF REGEN INHBTD. The DPF regeneration inhibited 
symbol, shown to the right, will accompany the text when the pre-
alarm appears on the DGC-2020ES front panel.  

• DPF Soot Level Annunciation 

The DGC-2020ES annunciates DPF Soot Level pre-alarms which are described in the following 
paragraphs. 

o SOOT LEVEL HIGH Pre-Alarm 

This pre-alarm is annunciated when one of the following occurs. 

 A DTC is received with SPN 3719 (Diesel Particulate Filter Soot Load Percent) with 
FMI = 15 (Data Valid But Above Normal Operating Range Least Severe Level) 

 SPN 3701 (Aftertreatment Diesel Particulate Filter Status) is received with a value of 
001 (regeneration is needed – lowest level) 

The pre-alarm text is SOOT LVL HI.  

The DPF symbol, shown to the right, accompanies the text when the pre-alarm 
appears on the DGC-2020ES front panel.  

o SOOT LEVEL MODERATELY HIGH Pre-Alarm 

This pre-alarm is annunciated when one of the following occurs. 

 A DTC is received with SPN 3719 (Diesel Particulate Filter Soot Load Percent) with 
FMI = 16 (Data Valid But Above Normal Operating Range Moderately Severe Level)  
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 SPN 3701 (Aftertreatment Diesel Particulate Filter Status) is received with a value of 
010 (regeneration is needed – moderate level) 

The pre-alarm text is SOOT LVL MOD HI.  

The DPF warning symbol, shown to the right, accompanies the text 
when the pre-alarm appears on the DGC-2020ES front panel.  

o SOOT LEVEL EXTREMELY HIGH Pre-Alarm 

This pre-alarm is annunciated when one of the following occurs. 

 A DTC is received with SPN 3719 (Diesel Particulate Filter Soot Load Percent) with 
FMI = 0 (Data Valid But Above Normal Operating Range Most Severe Level) 

 SPN 3701 (Aftertreatment Diesel Particulate Filter Status) is received with a value of 
011 (regeneration is needed – highest level) 

The pre-alarm text is SOOT LVL EXT HI.  

The DPF stop symbol, shown to the right, accompanies the text 
when the pre-alarm appears on the DGC-2020ES front panel. If the 
DPF soot level reaches the most severe level, the engine ECU may 
shut the engine down, preventing it from running, or allow it to run, 
but at a reduced power level. The DGC-2020ES only indicates a 
pre-alarm, it does not prevent the engine from running or cause 
operation at a reduced power level. However, the operator should be 
aware that the engine ECU or after treatment system may cause 
such behavior. 

 

Exhaust After-Treatment Systems (EATS) 

In order to meet Tier 4 emission requirements, some engine manufacturers are adding Exhaust After 
Treatment Systems (EATS) which treat the engine exhaust within the exhaust system to reduce 
particulate matter and harmful contaminants prior to releasing the exhaust into the atmosphere. One such 
system uses urea-based Diesel Exhaust Fluid (DEF) catalyst which is combined with the exhaust gasses 
in the EATS to bring the emissions to acceptable levels.  

The DGC-2020ES meters EATS information from the engine ECU via J1939 CANBus and 
displays the DEF level within the DEF tank(s), and also displays several pre-alarms 
related to the EATS system. Any DEF related pre-alarms annunciated on the front panel 
display the symbol used for DEF functions which is shown to the right.  

Most systems will contain one DEF tank, while some may contain two tanks. The DGC-2020ES front 
panel displays the level of DEF in each tank under Metering > Alarms-Status > J1939 Status > DEF 
Tank1 LVL% and Metering > Alarms-Status > J1939 Status > DEF Tank2 LVL%. The tank 1 level is sent 
from the ECU via SPN 1761 in J1939 PGN 65110 - After Treatment 1 Reagent Tank 1 Information. The 
tank 2 level is sent from the ECU via SPN 4367 in J1939 PGN 64829 - After Treatment 1 Reagent Tank 2 
Information. The tank levels are expressed in units of percent. 

Pre-Alarms 
The ECU sends DEF level diagnostics to the DGC as SPNs 5245 and 5246 in PGN 65110 (the AT1TI 
PGN). SPN 5245 communicated DEF level diagnostics, whereas SPN 5246 communicates DEF 
inducement level status. 

There are several pre-alarms related to the EATS which annunciate DEF level diagnostics and DEF 
inducement level status. They are always enabled and will annunciate when received from the engine 
ECU. Each of them contains the symbol for DEF functions when annunciated on the front panel; however 
it will not be displayed in BESTCOMSPlus. The pre-alarms are summarized in the following paragraphs. 
• DEF FLUID LOW: This pre-alarm displays when SPN 5245 has a value of 1, indicating that the DEF 

tank level is low. The exact DEF levels which constitute a low DEF condition vary among manufacturers. 
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• DEF LOW SEVERE: This pre-alarm displays when SPN 5245 has a value of 4, indicating that the DEF 
tank level is severely low or empty. The exact DEF levels which constitute a severely low DEF condition 
vary among manufacturers. When this occurs and is not remedied, the engine ECU may enter a mode 
of inducement not to operate the engine where some of the conditions in the pre-alarms descriptions 
below may occur. 

• DEF WARNING: This pre-alarm displays when SPN 5246 has a value of 1. This is the lowest level of 
warning which indicates the EATS is not functioning properly or DEF quality or level is insufficient for 
proper operation. 

• DEF WARNING LVL2: This pre-alarm displays when SPN 5246 has a value of 2. This is a higher level 
of warning which indicates the EATS is not functioning properly or DEF quality or level is insufficient for 
proper operation. If the problem causing this warning is not corrected, the system will eventually enter 
the DEF inducement states. In these states, the engine power or operating speed may be derated 
depending on the engine manufacturer and engine application. 

• DEF INDUCEMENT: This pre-alarm displays when SPN 5246 has a value of 3, indicating the first level 
of inducement. The engine power or operating speed may be derated at this level of inducement 
depending on engine manufacturer and engine application. This is the lowest level of inducement and 
is caused by either the EATS not functioning properly or insufficient DEF quality or level for proper 
operation. 

• DEF PRESEVERE INDUCEMENT: This pre-alarm displays when SPN 5246 has a value of 4, indicating 
the Pre-Severe Inducement level of inducement. This indicates that the engine has entered the second 
highest level of inducement not to operate. This is caused by either the EATS not functioning properly 
or insufficient DEF quality or level for proper operation. The engine power or operating speed may be 
derated at this level of inducement depending on engine manufacturer and engine application. The 
ECU will allow the engine to run for a limited time in this condition after which the engine will enter the 
severe inducement state. 

• DEF SEVERE INDUCEMENT: This pre-alarm displays when SPN 5246 has a value of 
5, indicating the Severe Inducement level of inducement. This is caused by either the 
EATS not functioning properly or insufficient DEF quality or level for proper operation. In 
this condition, the engine may either operate with reduced power or RPM or be shut 
down depending on manufacturer or engine application. The engine will remain at this 
level of inducement until the problem causing the inducement is resolved. 

• DEF INDUCEMENT OVERRIDE: This pre-alarm displays when SPN 5246 has a value of 6, indicating 
the Temporary Override of inducement. This indicates DEF inducement is temporarily overridden. The 
engine may operate with reduced power, or for a limited time, after which time it may re-enter the 
SEVERE INDUCEMENT state. 

Exhaust System Status Annunciation 
When an exhaust system condition requires annunciation, the DGC-2020ES displays the exhaust system 
information across the bottom of the front panel screen. The parameters and symbols in the Exhaust 
System Status Display are listed below. The symbol images below are the actual bit-mapped images that 
are viewed on the front panel screen of the DGC-2020ES. 

 

DEF Tank Level – The DEF Tank Level is the level of Diesel Exhaust Fluid (DEF) in the DEF Tank. When 
the DEF Level is getting low and DEF related conditions require annunciation, the caption of the DEF 
Tank level will change from “DEF” to the DEF symbol. Details of the DEF symbol are described below. 

 

DEF Symbol – When the symbol is on solid, it indicates that DEF is low or there is an issue 
with the Selective Catalytic Reduction (SCR) system. When it is flashing, it indicates the DEF 
level is critically low or there is a critical issue with the SCR system. 

 



9469200995 14-5 

DGC-2020ES Exhaust Treatment 

 

DPF Symbol – When the DPF symbol is on solid, it indicates that the Diesel Particulate Filter 
(DPF) or exhaust system filter requires regeneration. When flashing it indicates a more 
urgent need for regeneration. Some manufacturers also show this symbol along with the 
High Exhaust Temperature Symbol when a Regeneration is in process. 

 

Regeneration Inhibited Symbol – When this symbol is visible, it indicates that Regeneration 
is Inhibited. Operation with Regeneration Inhibited is not recommended. If Regeneration is 
not allowed when required, eventually the machine may shut down and cannot be restarted 
without a service call from the engine manufacturer. However, ample warning is given 
through various pre-alarms to allow removal of the inhibit so regeneration can occur and 
prevent an unwanted exhaust related shutdown condition. 

 

Exhaust System Malfunction Symbol – When this symbol is visible, an exhaust system 
malfunction is in effect. Pre-alarms and/or Diagnostic Trouble Codes (DTC’s) will provide 
additional information. It may be necessary to contact the engine manufacturer if the pre-
alarms and DTC’s do not provide sufficient failure information. 

 

High Exhaust Temperature Symbol – This is visible when the exhaust system temperature 
has been elevated to perform a DPF Regeneration and typically indicates a DPF 
Regeneration is active. Some manufacturers also show this symbol when there is a 
mechanism to heat the exhaust stream and it is in the process of heating in preparation for a 
DPF Regeneration. 

Check Engine Symbol – This is visible when Active Diagnostic Trouble Codes (DTCs) are 
present. 

 

 

Torque Limit Symbol – This symbol is visible when operating in a Limited Torque mode due 
to exhaust system issues. When on solid, it indicates torque reduction. When flashing, it 
indicates increased torque reduction.  

 

 

Amber Warning Lamp Symbol– This symbol indicates the engine ECU is lighting the Amber 
Warning Lamp. When flashing, it indicates a higher degree of severity. 

 

 

 

Red Lamp Symbol – This symbol indicates the engine ECU is lighting the Red Warning 
Lamp. When flashing, it indicates a higher degree of severity. An engine shutdown may 
accompany this symbol. 

 

 

Wait To Start Symbol – This symbol is visible when the engine is in a state of preparation for 
starting the engine. Examples include engine pre-heating or engine pre-lubrication. 

 

•  
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Exit Conditions for DEF Severe Inducement 
• First Restart: Return to 0% torque reduction in exit condition, until proper DEF level and quality 

evaluation. If low level or poor DEF quality is detected during the next monitoring cycle, the severe 
inducement will be active after the next restart. After the second restart, a service tool is required to 
exit the severe inducement. 

• With Service Tool Clearing: Invoke 0% torque reduction with service tool clearing until proper DEF 
level and quality evaluation. If low level or poor DEF quality is detected during the next monitoring 
cycle, the severe inducement will be active after the next restart. 
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15 • Troubleshooting 
If you do not get the results that you expect from the DGC-2020ES, first check the programmable settings 
for the appropriate function. Use the following troubleshooting procedures when difficulties are 
encountered in the operation of your genset control system. 

Communications 

USB Port Does Not Operate Properly 
Step 1. Verify that the proper port of your computer is being used. For more information, refer to the 

Communication chapter. 

CAN Communication Does Not Operate Properly 
Step 1: Verify that there is a 120-ohm termination resistor on each end of the bus section of the wiring, 

and that there are not any termination resistors at any node connections that are on stubs from 
the main bus. 

Step 2: Check all CAN wiring for loose connections and verify that the CAN H and CAN L wires have 
not gotten switched somewhere on the network. 

Step 3: Verify that the cable length of the bus section of the wiring does not exceed 40 meters (131 
feet), and verify that any stubs from the main bus do not exceed 3 meters (9.8 feet) in length. 

Step 4: If the engine is equipped with a Volvo or mtu ECU, verify that the ECU Configuration setting is 
set to match the actual ECU configuration. 

Inputs and Outputs 

Programmable Inputs Do Not Operate as Expected 
Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter in the 

Installation manual. 

Step 2. Confirm that the inputs are programmed properly. 

Step 3. Ensure that the input at the DGC-2020ES is actually connected to the BATT– terminal (17). 

Programmable Outputs Do Not Operate as Expected 
Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter in the 

Installation manual. 

Step 2. Confirm that the outputs are programmed properly. 

Metering/Display 

Incorrect Display of Battery Voltage, Coolant Temperature, Oil Pressure, or Fuel Level 
Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter in the 

Installation manual. 

Step 2. Confirm that the SENDER COM terminal (2) is connected to the negative battery terminal and 
the engine-block side of the senders. Current from other devices sharing this connection can 
cause erroneous readings. 

Step 3. If the displayed battery voltage is incorrect, ensure that the proper voltage is present between 
the BATT+ terminal (18) and the SENDER COM terminal (2). 

Step 4. Verify that the correct senders are being used. 



15-2  9469200995 

Troubleshooting  DGC-2020ES 

Step 5. Use a voltmeter connected between the BATT– terminal (17) and the SENDER COM terminal 
(2) on the DGC-2020ES to verify that there is no voltage difference at any time. Any voltage 
differences may manifest themselves as erratic sender readings. Wiring should be corrected so 
that no differences exist. 

Step 6: Check the sender wiring and isolate sender wiring from any of the ac wiring in the system. The 
sender wiring should be located away from any power ac wiring from the generator and any 
ignition wiring. Separate conduits should be used for sender wiring and any ac wiring. 

Incorrect Display of Generator Voltage 
Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter in the 

Installation manual. 

Step 2. Ensure that the proper voltage is present at the DGC-2020ES voltage sensing inputs (40, 41, 
43, and 45). 

Step 3. Verify that the voltage transformer ratio and sensing configuration is correct. 

Step 4. Confirm that the voltage sensing transformers are correct and properly installed. 

Incorrect Measurement or Display of Generator Current 
Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter in the 

Installation manual. 

Step 2. Ensure that the proper current is present at the DGC-2020ES current sensing inputs 33, 34, 35, 
36, 37, and 38. 

Step 3. Verify that the current sensing transformer ratios are correct. 

Step 4. Confirm that the current sensing transformers are correct and properly installed. 

Incorrect Display of Engine RPM 
Step 1. Verify that all wiring is properly connected. Refer to the Typical Connections chapter in the 

Installation manual. 

Step 2. Verify that the flywheel teeth setting is correct. 

Step 3. Verify that the prime mover governor is operating properly. 

Step 4. Verify that the measured frequency of the voltage at the MPU input (31 and 32) is correct. 

Step 5. If the MPU is shared with the governor, verify that the polarity of the MPU input to the governor 
matches the polarity of the MPU input to the DGC-2020ES. 

DGC-2020ES Indicates Incorrect Power Factor 
Check the rotation of the machine and the labeling of the A-B-C terminals. The machine must be rotating 
in the same phase sequence as dictated by the generator phase rotation setting for correct power factor 
metering. A power factor indication of 0.5 with resistive load present is a symptom of incorrect phase 
rotation. 

LCD is Blank and all LEDs are Flashing at Approximately Two-Second Intervals 
This indicates that the DGC-2020ES does not detect that valid application firmware is installed. The unit 
is running its boot loader program, waiting to accept a firmware upload. 

Step 1. Start BESTCOMSPlus®. Use the top pull-down menu and select FILE > NEW > DGC-2020ES. 

Step 2. Select COMMUNICATIONS > UPLOAD DEVICE FILES and select the device package file that 
contains the firmware and language you want to upload. 

Step 3. Check the boxes for DGC-2020ES Firmware and DGC-2020ES Language Module. Click the 
UPLOAD button to start the upload process. 
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Ground Faults Detected in Ungrounded System Applications 

Step 1: Verify that there is no connection from the neutral connection of the generator to the system 
ground. 

Step 2: Perform insulation resistance tests on the system wiring to check for insulation integrity in the 
overall system. 

Step 3: If ground faults are detected on a DGC-2020ES in an ungrounded system application, it is 
recommended that potential transformers be employed on the voltage sensing inputs to provide 
full isolation between the DGC-2020ES and monitored voltage phases. 

Step 4: If potential transformers are in place, remove the connectors from the DGC-2020ES one at a 
time. If removal of a connector removes the ground fault, check the system wiring to that 
connector and out into the system to verify that connections are secure and all wiring insulation 
is in good condition. 

Generator Breaker and Mains Breaker 

Generator Breaker Will Not Close to a Dead Bus 
Step 1: Review the description of how the generator breaker logic element functions contained in the 

GENBRK logic element description in the BESTlogic™Plus chapter. 

Step 2: Review the section on breaker close requests in the Breaker Management chapter. 

Step 3: Navigate to the SETTINGS > BREAKER MANAGEMENT > BREAKER HARDWARE > GEN 
BREAKER screen and set DEAD BUS CL ENBL to ENABLE. 

Step 4: Verify that the Generator status is stable. The breaker will not close if the generator status is 
not stable. Check status by using the Metering Explorer in BESTCOMSPlus and verify that 
when the generator is running, the GEN STABLE status LED is lit. If necessary, modify the 
settings on the SETTINGS > BREAKER MANAGEMENT > BUS CONDITION DETECTION 
screen. 

Step 5: Verify the bus status is DEAD. Check status by using the Metering Explorer in BESTCOMSPlus 
and verify that when the generator is running, the BUS DEAD status LED is lit. If necessary, 
modify the settings on the SETTINGS > BREAKER MANAGEMENT > BUS CONDITION 
DETECTION screen. 

Step 6: Verify the connections in BESTlogicPlus Programmable Logic to the generator breaker logic 
element. The Status input must be driven by an “A” or normally open contact from the generator 
breaker. The OPEN and CLOSE command inputs on the left side of the logic block are inputs 
for open and close commands. These can be wired to physical inputs if it is desired to have 
open and close command switches. If they are wired, they must either be pulsed inputs, or 
some logic must be employed so that the open and close command inputs are never driven at 
the same time. If these are both driven at the same time, the breaker is receiving open and 
close commands simultaneously. The breaker will not change state if it is being commanded to 
open and close at the same time. 

Step 7: Verify the breaker is receiving a close command. Breaker close command sources are: 
• The DGC-2020ES itself when the automatic mains fail transfer (ATS) feature is enabled. 
• The DGC-2020ES itself when the RUN WITH LOAD logic element receives a Start pulse in 

the programmable logic. 
• The DGC-2020ES itself when started from the Exercise Timer and the Run with Load box 

is checked in the Generator Exerciser settings. 
• Manual Breaker Close Input Contacts applied to the Open and Close inputs on the left side 

of the Generator Breaker logic element in the programmable logic. 

Step 8: Verify the wiring to the breaker from the DGC-2020ES. If it seems OK, you can do a manual 
close and open by modifying the programmable logic. Map some unused outputs to the OPEN 
and CLOSE outputs from the Gen Breaker Block in the programmable logic. Map a virtual 
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switch to the logic output that would normally be the breaker open output. Map another virtual 
switch to the logic output that would normally be the breaker close output. Connect with 
BESTCOMSPlus, and exercise the virtual switches using the Control panel located in the 
Metering Explorer. Never turn open and close on at the same time. This could damage the 
breaker and/or motor operator. If everything is working as expected, restore the logic to its 
original diagram. 

Generator Breaker Does Not Open When It Should 
Step 1: Review the description of how the generator breaker logic element functions contained in the 

GENBRK logic element description in the BESTlogicPlus chapter. 

Step 2: Review the section on breaker operation requests in the Breaker Management chapter. 

Step 3: Verify the connections in BESTlogicPlus Programmable Logic to the generator breaker logic 
element. The Status input must be driven by an “A” or normally open contact from the generator 
breaker. The OPEN and CLOSE command inputs on the left side of the logic block are inputs 
for open and close commands. These can be wired to physical inputs if it is desired to have 
open and close command switches. If they are wired, they must either be pulsed inputs, or 
some logic must be employed so that the open and close command inputs are never driven at 
the same time. If these are both driven at the same time, the breaker is receiving open and 
close commands simultaneously. The breaker will not change state if it is being commanded to 
open and close at the same time. 

Step 4: Verify the breaker is receiving an open command. Breaker open command sources are: 

• The DGC-2020ES itself when the automatic transfer (ATS) feature is enabled. 

• The DGC-2020ES itself when the RUN WITH LOAD logic element receives a Stop pulse in 
the programmable logic. 

• The DGC-2020ES itself when shutting down the engine due to an active alarm. 

• The DGC-2020ES itself when ending a run session from the Exercise Timer and the Run 
with Load box is checked in the Generator Exerciser settings. 

• Manual Breaker Open Input Contacts applied to the Open and Close inputs on the left side 
of the Generator Breaker logic element in the programmable logic. 

Step 5: Verify the wiring to the breaker from the DGC-2020ES. If it seems OK, you can do a manual 
close and open by modifying the programmable logic. Map some unused outputs to the OPEN 
and CLOSE outputs from the Gen Breaker Block in the programmable logic. Map a virtual 
switch to the logic output that would normally be the breaker open output. Map another virtual 
switch to the logic output that would normally be the breaker close output. Connect with 
BESTCOMSPlus, and exercise the virtual switches using the Control panel located in the 
Metering Explorer. Never turn open and close on at the same time. This could damage the 
breaker and/or motor operator. If everything is working as expected, restore the logic to its 
original diagram. 

Mains Breaker Does Not Open When Mains Fails 
Step 1: Verify that a Mains Breaker has been configured by examining the settings on the SETTINGS > 

BREAKER MANAGEMENT > BREAKER HARDWARE screen. 

Step 2: Verify the mains breaker has been correctly included in the programmable logic. 

Step 3: Verify that the MAINS FAIL TRANSFER parameter is set to ENABLE on the SETTINGS > 
BREAKER MANAGEMENT > BREAKER HARDWARE screen. 

Step 4: Verify that a failure of the mains is detected by the DGC-2020ES. Check status using the 
Metering Explorer in BESTCOMSPlus and verify that the MAINS FAIL status LED is lit when 
the power on the DGC-2020ES bus voltage input is either out of voltage or frequency range. If 
necessary, modify the settings on the SETTINGS > BREAKER MANAGEMENT > BUS 
CONDITION DETECTION screen to achieve correct detection. 
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Step 5: Verify the wiring to the breaker from the DGC-2020ES. If it seems OK, you can do a manual 
close and open by modifying the programmable logic. Map some unused outputs to the OPEN 
and CLOSE outputs from the Gen Breaker Block in the programmable logic. Map a virtual 
switch to the logic output that would normally be the breaker close output. Map another virtual 
switch to the logic output that would normally be the breaker close output. Connect with 
BESTCOMSPlus, and exercise the virtual switches using the Control panel located in the 
Metering Explorer. Never turn open and close on at the same time. This could damage the 
breaker and/or motor operator. If everything is working as expected, restore the logic to its 
original diagram. 

Mains Breaker Does Not Close After Mains Returns 
Step 1: Verify that a Mains Breaker has been configured by examining the settings on the SETTINGS > 

BREAKER MANAGEMENT > BREAKER HARDWARE screen. 

Step 2: Verify the mains breaker has been correctly included in the programmable logic. 

Step 3: Verify that the MAINS FAIL TRANSFER parameter is set to ENABLE on the SETTINGS > 
BREAKER MANAGEMENT > BREAKER HARDWARE screen. 

Step 4: Verify that stable mains power is detected by the DGC-2020ES. Check status using the 
Metering Explorer in BESTCOMSPlus and verify that the MAINS STABLE status LED is lit 
when the power on the DGC-2020ES bus voltage input is good. If necessary, modify the 
settings on the SETTINGS > BREAKER MANAGEMENT > BUS CONDITION DETECTION 
screen to achieve correct detection. 

Step 5: Verify the wiring to the breaker from the DGC-2020ES. If it seems OK, you can do a manual 
close and open by modifying the programmable logic. Map some unused outputs to the OPEN 
and CLOSE outputs from the Gen Breaker Block in the programmable logic. Map a virtual 
switch to the logic output that would normally be the breaker open output. Map another virtual 
switch to the logic output that would normally be the breaker close output. Connect with 
BESTCOMSPlus, and exercise the virtual switches using the Control panel located in the 
Metering Explorer. Never turn open and close on at the same time. This could damage the 
breaker and/or motor operator. If everything is working as expected, restore the logic to its 
original diagram. 

Generator stays in cooling state when attempting to shut down in Auto mode after Cool 
Down Timer counts down to zero seconds or when No Load Cool Down time is set to 
zero 
If the unit is in AUTO mode and attempting a normal shutdown, it will always go through the cool down 
state. It will remain there until the cool down timer counts down to zero, and the generator breaker status 
is open. 

If the unit stays in the cool down state after the cool down timer has expired, it is likely because it has a 
generator breaker status of closed. This can be checked on the front panel under METERING > ALARMS 
STATUS > STATUS > GEN BREAKER or in BESTCOMSPlus under Metering Explorer > DGC-2020ES > 
STATUS. The generator will not leave the cooling state until it has an open generator breaker status. 

If the Generator Breaker logic element is present in logic and the Status Input is TRUE, the breaker status 
will be reported as closed even if that breaker block has a large yellow X through it indicating it is not 
configured. 

DGC-2020ES Front Panel Debug Screen 

There is one debug screen in the DGC-2020ES that can be useful for debugging I/O module related 
issues. The following debug screen is available: CEM DEBUG 

CEM DEBUG 
This screen shows the binary data that is being sent between the CEM-2020 (Contact Expansion Module) 
and the DGC-2020ES. 
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The CEM DEBUG screen is located on the front panel at SETTINGS > SYSTEM PARAMS > REMOTE 
MODULE SETUP > CEM SETUP > CEM DEBUG MENU. 

The following parameters are visible on the CEM DEBUG screen: 

• DGC TO CEM BP: DGC-2020ES to CEM-2020 Binary Points. This is the status of the CEM-2020 
output relays being transmitted from the DGC-2020ES to the CEM-2020. This is a 32-bit, bit packed 
number representing the desired states of the CEM-2020 outputs. The left most bit is the first output, 
etc. 

• CEM TO DGC BP: CEM-2020 to DGC-2020ES Binary Points. This is the status of the CEM-2020 
inputs being transmitted from the CEM-2020 to the DGC-2020ES. This is a 32-bit, bit packed number 
representing the metered states of the CEM-2020 inputs. The left most bit is the first input, etc. 
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16 • BESTCOMSPlus® Settings Loader 
Tool 
The BESTCOMSPlus® Settings Loader Tool is a software application, which allows the user to instantly 
upload settings to Basler BESTCOMSPlus-compatible products by scanning a pre-registered bar code, 
which promotes consistency, reduces potential errors, and saves time. 

Setup 

The BESTCOMSPlus Settings Loader Tool software and a bar code reader (acquired separately) must be 
installed on the same PC. 

BESTCOMSPlus Settings Loader Tool Installation 

System Recommendations 

The BESTCOMSPlus® Settings Loader Tool is bundled with BESTCOMSPlus software. BESTCOMSPlus 
software is built on the Microsoft® .NET Framework. The setup utility that installs BESTCOMSPlus on 
your PC also installs the BESTCOMSPlus Settings Loader Tool and the required version of .NET 
Framework (if not already installed). BESTCOMSPlus operates with systems using Windows® 7 SP1, 
Windows 8.1, and Windows 10 version 1607 (Anniversary Update) or later. Microsoft Internet Explorer 
5.01 or later must be installed on your PC before installing BESTCOMSPlus. System recommendations 
for the .NET Framework and BESTCOMSPlus are listed in Table 16-1. 

Table 16-1. System Recommendations for BESTCOMSPlus and the .NET Framework 

System Type Component Recommendation 
32/64 bit Processor 2.0 GHz 
32/64 bit RAM 1 GB (minimum), 2 GB (recommended) 
32 bit Hard Drive 200 MB (if .NET Framework is already installed on PC) 

4.5 GB (if .NET Framework is not already installed on PC) 
64 bit Hard Drive 200 MB (if .NET Framework is already installed on PC) 

4.5 GB (if .NET Framework is not already installed on PC) 

To install and run BESTCOMSPlus, a Windows user must have Administrator rights. 

 

Note 

Do not connect a USB cable until setup completes successfully. 
Connecting a USB cable before setup is complete may result in errors. 

Download BESTCOMSPlus 

Use the following procedure to download BESTCOMSPlus from the Basler Electric website. 

1. Navigate to https://www.basler.com/Downloads. 

2. Select DGC-2020ES from the model drop down menu. 

3. Under the Software heading, click the download link for BESTCOMSPlus. 

4. Sign in or create an account to continue with the download. 

https://www.basler.com/Downloads
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Install BESTCOMSPlus 

Run the setup file for the BESTCOMSPlus application. The setup utility installs BESTCOMSPlus, the 
.NET Framework (if not already installed), the USB driver, and the BESTCOMSPlus Settings Loader Tool 
on your PC. 

When BESTCOMSPlus installation is complete, a Basler Electric folder is added to the Windows 
programs menu. This folder is accessed by clicking the Windows Start button and then accessing the 
Basler Electric folder in the Programs menu. The Basler Electric folder contains an icon that starts the 
BESTCOMSPlus Settings Loader Tool. 

Bar Code Reader and Bar Codes 
The BESTCOMSPlus® Settings Loader Tool is compatible with bar code readers, which conform to 
UnifiedPOS specifications. Bar code readers and bar code labels are not provided and must be acquired 
separately. Refer to the bar code reader’s documentation for installation instructions.  

Any bar code compatible with your bar code reader may be used. 

BESTCOMSPlus® Settings Loader Tool Settings 

BESTCOMSPlus Settings Loader Tool settings are found on two main screens, the Loader Grid and 
Configuration screen. The Loader Grid contains management options for the product settings files and 
their associated bar codes. The Configuration screen contains product-specific options for the default 
behavior of the BESTCOMSPlus Settings Loader Tool. These settings are described in the following 
paragraphs. 

Loader Grid 
One entry, or row, in the Loader Grid contains all of the necessary data to associate a product settings file 
with a bar code. New entries can be added. Existing entries can be edited, deleted, and uploaded to a 
Basler product. 
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Figure 16-1. Loader Grid 

Scanning Bar Codes 

Place the cursor in the text field, found at the top of the Loader Grid screen, and scan a bar code. If 
successful, the digits which comprise the bar code appear in the text field. The BESTCOMSPlus Settings 
Loader Tool automatically searches for this bar code among the entries in the Loader Grid and displays 
the matching entry. Click Clear to remove the digits from the text field. 

Adding an Entry 

Click Add to create an entry. The BESTCOMSPlus® Settings Loader Tool: Add Device dialog box appears 
(Figure 16-2). 

 
Figure 16-2. Add Device Screen   
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Enter the name of the entry in the Name field. This appears in the first column of the Loader Grid. 

Select the product type from the Type drop-down menu. This appears in the second column of the Loader 
Grid. 

Enter the bar code of the entry in the UPC Barcode field by placing the cursor in the UPC Barcode field 
and scanning the bar code.  

To select the product settings file for the entry, click the browse (…) button in the Location field. Use 
standard Windows methods to navigate to the desired product settings file and click Open. Ensure that 
the selected product type in the Type field matches that of the product settings file specified in the 
Location field. 

Click OK when finished. 

Editing an Entry 

To Edit an existing entry, select the entry in the Loader Grid and click Edit. The BESTCOMSPlus Settings 
Loader Tool: Edit Device dialog box appears. The options are identical to those of the Add Device dialog. 
When the desired changes have been made, click OK. 

Deleting an Entry 

To delete an entry from the Loader Grid, select the entry and click the Delete button. A prompt appears 
providing the option to confirm or cancel the deletion. 

Uploading an Entry 

Select an entry and click Upload. A dialog appears which provides connection options for the appropriate 
type of device. Refer to the Basler product instruction manual for detailed connection information. Once a 
connection is established, the product settings associated with the entry are uploaded. 

Configuration Settings 
For configuration settings, click the Configure button in the bottom left of the Loader Grid. The product 
tabs on the left represent the compatible Basler products. Each product tab contains tabs for Settings 
Files and Connection Options. The options on these tabs are described below. 

Setting Files Options 

Use Saved Path: When enabled, the path specified in the Loader Grid entry is used when uploading the 
settings file. 

Single Folder: When enabled, this specifies a single folder which contains all settings files for the 
product. The Windows filename specified in the Location field of the Loader Grid entry is searched for in 
the Single Folder location. For example, all settings files for a product are located in “C:\files”. The 
Location field in the Loader Grid entry for a device contains “C:\documents\settings\DGC-2020ES 
Settings.bstx”. The BESTCOMSPlus Settings Loader Tool searches in “C:\files” for the file named “DGC-
2020ES Settings.bstx”. 

Append Bar-Code to Location: When enabled, the bar code is appended to the specified location when 
uploading the settings file. For example, an entry with the bar code “0002” is located in C:\files\0002 and 
an entry with the bar code “0003” is located in C:\files\0003. 

Logon: If User Name and Password are specified, you will not be prompted for credentials when 
required. 

Save After Upload: After uploading a settings file, the settings are downloaded from the connected 
device and saved to the specified location, when enabled. 

Upload Security: When enabled, the security settings stored in the settings file are uploaded to the 
device. Credentials will be requested if not already specified. 

Figure 16-3 illustrates the Setting Files tab. 
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Figure 16-3. Configuration, Settings Files Tab 

Connection Options 

Connection options consist of the three selections described below. Refer to the Basler product 
instruction manual for detailed connection information. 

Always Prompt for Connection: When enabled, a dialog appears which provides connection options for 
the appropriate type of device each time a connection attempt is made. 

Ethernet Connection: When enabled, the BESTCOMSPlus Settings Loader Tool automatically attempts 
to connect to the specified IP address before uploading settings. 

USB Connection: When enabled, the BESTCOMSPlus® Settings Loader Tool automatically attempts to 
connect to the device via USB port before uploading settings. 

Figure 16-4 illustrates the Connection Options tab. 
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Figure 16-4. Configuration, Connection Options Tab 

General Operation 

The steps listed below are provided as a general guideline for how to operate the BESTCOMSPlus 
Settings Loader Tool when the initial setup is complete and the settings files are associated with bar 
codes. 

1. Power on the device which will receive the new settings. Ensure proper communication connections 
have been made between the device and the PC running BESTCOMSPlus Settings Loader Tool. 

2. Run BESTCOMSPlus Settings Loader Tool. 

3. Place cursor in search bar. 

4. Scan bar code. 

5. Settings file is automatically highlighted and isolated in the grid. 

6. Click Upload. 

7. BESTCOMSPlus Settings Loader Tool automatically connects to device and uploads settings. Device 
connection is automatic unless “Always prompt for connection” is enabled. 
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